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WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and
workmanship for a period of one (1) year from the date of shipment. If a product proves defective during this
warranty period, Tektronix, at its option, either will repair the defective product without charge for parts and labor,
or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period and make suitable arrangements for the performance of service. Customer shall be
responsible for packaging and shipping the defective product to the service center designated by Tektronix, with
shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a
location within the country in which the Tektronix service center is located. Customer shall be responsible for
paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage
resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;
b) to repair damage resulting from improper use or connection to incompatible equipment; ¢) to repair any
damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been
modified or integrated with other products when the effect of such modification or integration increases the time
or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’
RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

To Avoid Fire or
Personal Injury

Symbols and Terms

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.
Do Not Operate in an Explosive Atmosphere.
Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

Terms in this Manual. These terms may appear in this manual:
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WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

/AN
/N

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

AN A O

CAUTION WARNING Protective Ground
Refer to Manual High Voltage (Earth) Terminal
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Preface

The WVR610A & WVR611A rasterize serial digital video and composite video
signals (depending on installed options) for display on XGA displays, providing
a new standard of display quality and flexibility.

The WVR610A & WVR611A are single RU instruments, offering both SD
component and composite inputs, as well as audio monitoring options. The
waveform rasterizers offer full support for traditional waveform display, both
overlaid and parade; vector display, both traditional and Lightning; gamut
monitoring including Arrowhead, Diamond, and Split Diamond; support for
AES, analog, and embedded audio, both level and phase relationship; as well as
gain, sweep, and magnification controls.

Key WVR610A & WVR611A features include:

B FlexVu, a multiple-tiled display enabling you to monitor several aspects of
the signal at the same time

m  Fully Digital Processing for accurate, repeatable, drift-free operation

B A friendly menu-driven user interface that requires fewer keystrokes for the
most common operations

®  Instrument Presets for quick recall of commonly used configurations
®  High-resolution XGA output for crisp, easy-to-read displays

m  The WVRG610A, with Serial Digital Interface (SDI) inputs, supports digital
applications and the WVR611A, with SDI and Composite inputs, supports
digital or hybrid applications

m  Exclusive Tektronix measurements and displays that help check performance
and solve problems faster

®  Configurable alarms and error logging
B Exclusive Session screens for content status at a glance
®  Full remote control for complete installation flexibility

B Audio Option for analog, digital AES/EBU, or both
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About this Manual

Additional Information

XVi

This manual is divided into four sections:

Getting Started explains how to start using your waveform rasterizer.
Operating Basics shows you how to operate the waveform rasterizer.
Reference explains how to perform specific tests with the waveform rasterizer.

The Appendices contain reference information such as specifications, how to use
the remote interface, an incoming inspection procedure, SNMP usage informa-
tion and other information that you might need occasionally.

The WVR610A & WVR611A contain online help to enable you to quickly get
explanations of how to use your waveform rasterizer. The online help provides
descriptions of how to perform tasks with the waveform rasterizer along with
descriptions of controls, displays, and instrument settings.

The WVR610A & WVR611A Waveform Rasterizers Service Manual is an optional
accessory that provides module-level service information, as well as a complete
performance verification procedure.
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Contacting Tektronix

Phone

Address

Web site

Sales support

Service support

Technical support

1-800-833-9200%*

Tektronix, Inc.

Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

www.tektronix.com

1-800-833-9200, select option 1*

1-800-833-9200, select option 2*

www.tektronix.com/support
1-800-833-9200, select option 3*
6:00 a.m. - 5:00 p.m. Pacific Standard Time

*  This phone number is toll free in North America. After office hours, please leave a voice mail

message.

Outside North America, contact a Tektronix sales office or distributor; see the Tektronix web
site for a list of offices.
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Getting Started

Product Description

This section contains a product description, list of accessories and installation
procedure. For instrument specifications, refer to Appendix A. An incoming
inspection procedure to verify the primary functions of the waveform rasterizer is
located in Appendix E.

The WVR610A & WVR611A use fully digital processing that ensures accurate,
stable, and repeatable measurements. The WVR610A & WVR611A provide a
powerful monitoring solution for broadcasting, production, and post-production
environments. The combination of Tektronix exclusive gamut displays, session
screens, alarms, and error logging help you speed and simplify the process of
solving problems with your content.

The WVR610A supports only standard definition (SDI) inputs, while the
WVR611A supports both standard definition and analog composite inputs. They
are ideally suited to facilities transitioning from analog to digital environments.
Both models offer audio options to allow multiple-channel audio monitoring.

The digital architecture of the WVR610A & WVRG611A delivers important
benefits to users. Digital instruments offer accuracy and stability that is
unattainable in traditional analog designs. Analog components age and drift with
fluctuations in ambient temperature, and systems based on these components
require periodic calibration. The fully digital architecture of the WVR610A &
WVR611A provides accuracy, repeatability, and stability that surpasses
traditional analog designs.

The high-quality display of the WVR610A & WVR611A is well suited to meet
the needs of production and post-production applications including camera
shading and alignment, color balancing, film-to-tape and format conversion, and
special effects work.

Sometimes you simply need to know that your signal is valid. You need to
ensure that a signal will be compatible with compliant operational equipment
such as when you combine content from many sources including live in-studio,
tape, contribution feeds, and perhaps mobile feeds. Any of these sources might
deliver content with errors that could affect the quality of your transmission. The
tiled-display of the WVR610A & WVRG611A enables you to quickly check the
integrity of the signal by displaying up to four views of the signal simultaneous-

ly.
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Options

1-2

Audio Options

Service Options

The waveform rasterizer can be ordered with options to support analog audio,
digital audio, or both analog and digital audio.

Three audio options are available:

Option AN. Two groups of three pairs of analog inputs, one group of three
pairs of analog outputs.

Option DG. Four pairs of AES/EBU inputs and four pairs of bi-directional
AES/EBU outputs selected from eight embedded pairs.

Option DA. Both analog and digital capabilities installed.

The following service options are available for the WVR610A & WVR611A:

Option R3. Extends the instrument warranty to 3 years.
Option RS5. Extends the instrument warranty to 5 years.
Option C3. Provides calibration services for 3 years.
Option C5. Provides calibration services for 5 years.
Option D3. Provides test data for 3 years.

Option DS5. Provides test data for 5 years.
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Standard Accessories

The following accessories are shipped with each waveform monitor:

Documents  The following documents are standard accessories:

B WVR610A & WVR611A Waveform Rasterizers User Manual, Tektronix part
number 071-1199-XX.

B WVR6I10A & WVR611A Waveform Rasterizers Release Notes, Tektronix part
number 061-4260-XX.

Power Cords  All WVR610A & WVR611A Waveform Rasterizers are shipped with one of the
following power cord options. Power cords for use in North America are UL
listed and CSA certified. Cords for use in areas other than North America are
approved by at least one authority acceptable in the country to which the product
is shipped.

Table 1-1: Power cord identification

Plug configuration Normal usage Option number
North America Standard
120V

> ’ i | Euro Al

| /\\l Universal

£
\!H/ % United Kingdom A2
P
ﬁ Australia A3
Switzerland A5
@
% Japan A6
ﬁﬁ China AC
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Optional Accessories

The following items are optional accessories:

B WVR610A & WVR611A Waveform Rasterizers Service Manual, Tektronix
part number 071-1243-XX.

B Analog/Audio Breakout Cable Assembly, Tektronix part number
012-1658-01.
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Installation

This section provides instructions for installing the waveform rasterizer into a
standard instrumentation rack. At installation time, save the shipping carton and
packing materials (including the anti-static bag) in case you need to ship the
instrument.

Rackmount Installation

The waveform rasterizer is shipped with the hardware for rackmounting. The
instrument fits in a standard 19-inch rack. Spacing between the front rails of the
rack must be at least 17-% inches to allow clearance for the slide-out tracks.

51.44cm
(20.251in)

43.7 mm
(1.72in)

Figure 1-1: Dimensions of the waveform rasterizer

Rack slides conveniently mount in any rack that has a front-to-rear rail spacing
between 15-'2 and 28 inches. The waveform rasterizer requires six inches of
clearance between the instrument rear panel and any rear cabinet panel for
connector space and to provide adequate air circulation.
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Installation

Mounting the Slide Tracks  Mount the rails using the enclosed hardware as shown in Figure 1-5. Figures 1-3
and 1-4 show the rear rail mounting details for both deep and shallow racks.
Figure 1-2 shows the front mounting details. Make sure that the stationary
sections are horizontally aligned, level, and parallel.

Bar nut
(Use if the front rail is not
tapped)

O

o o o/ ) o @

Figure 1-2: Front rail mount
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Bar nut

Panhead
Screws

~<—— Rear rack rail

Figure 1-3: Deep rackmount

Rear rack rail

Flush with
rear rack rail

Bar nut

Panhead screws

Figure 1-4: Shallow rackmount
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V.
ey
S N Q
<
<)
(=)
(e}
Automatic °
latches

; 10-32 PHS
screws \5@

Chassis section
(preinstalled)

mounting

NOTE: Right hand and left hand stationary Stationary section

section is designated by the RH and the LH
marked on the rails. Stop latch holes should be
towards the bottom when slides are in place.
(The right hand rail is shown.)

Flat nut bar

10-32 PHS screw

Stop latch hole
Intermediate

section

Figure 1-5: Assembly of rackmounting hardware

Installing the Instrument ~ Refer to Figure 1-6 to install the instrument into the rack.
1. Pull the slide-out track section to the fully extended position.
2. Insert the instrument chassis sections into the slide-out sections.

3. Press the stop latches and push the instrument toward the rack until the
latches snap into their holes.

4. Again press the stop latches and push the instrument fully into the rack.

5. Tighten the front-panel retaining screws.

Removing the Instrument  Refer to Figure 1-6 to remove the instrument from the rack. To completely
remove the instrument, be sure to disconnect all cabling.

1. Loosen retaining screw and pull instrument outward until the stop latches
snap into the holes.
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Rack Adjustments

Rack Slide Maintenance

Removing the Instrument

2. Press stop latches (visible in the stop-latch holes) and carefully slide the
instrument free from the tracks.

oy

Figure 1-6: Installing or removing the instrument

After installation, if not properly adjusted, the slide tracks may bind. To adjust
the tracks, slide the instrument out about 10 inches, slightly loosen the screws
holding the tracks to the front rails, and allow the tracks to seek an unbound
position. Retighten the screws and check the tracks for smooth operation by
sliding the instrument in and out of the rack several times.

Once the instrument is in place within the rack, tighten the knurled retaining
screw to fasten it securely into the rack.

The slide-out tracks do not require lubrication. The dark gray finish on the tracks
is a permanent, lubricated coating.

First, loosen the front-panel knurled retaining screw. See Figure 1-6. Grasp the
front handles and pull the instrument out until all three slide sections latch. The
instrument is firmly held in this position.

You are now ready to connect power and signal cables to the instrument.
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Connecting a Display

Connecting Power

AC Power Requirements

The WVR610A & WVRG611A supports standard analog PC monitors, either CRT
or LCD. The display resolution is 1024 X 768 (XGA). Connect the external
display to the rear-panel XGA OUTPUT connector. The XGA OUTPUT
connector is a standard 15-pin D-type connector with socket contacts.

The waveform rasterizer operates from a single-phase power source with the
neutral conductor at or near earth ground. The line conductor is fused for
over-current protection. A protective ground connection through the grounding
conductor in the power cord is essential for safe operation.

The waveform rasterizer operates from an AC line frequency of 50 or 60 Hz,
over the range of 100-240 Volts, without the need for configuration, except the
power cord. Refer to page 1-3 for the power cord options. The typical power
draw is 50 W. Refer to Appendix A: Specifications for additional information on
power and environmental requirements.

Connect the supplied power cord to the rear-panel power connector. There is no
power switch on the waveform rasterizer, so the instrument will turn on as soon
as you apply power.

WVR610A & WVR611A Waveform Rasterizers User Manual



Installation

Installing the Waveform Rasterizer in a Video System

Regenerated
serial output

Serial source

The waveform rasterizer can operate almost anywhere in the distribution system
due to its high impedance, bridging, and loop-through inputs. This section
describes two types of connections and presents information on line termination.
The following diagrams are for serial digital systems but similar connections are
common for the analog composite inputs on the WVR611A.

Most serial equipment uses a receiver that regenerates an output signal, such as
the receiver shown in Figure 1-7. Routing the incoming serial signal through one
of the waveform rasterizer loop-though inputs and connecting the output of the
serial receiver to the other loop-through input allows you to compare the
incoming signal and the regenerated output signal.

Monitor

]
JEnEe

SDIB
SDIA Loopthrough
Loopthrough

Waveform rasterizer
(rear panel)
OO N %o?}c 00 D
‘m’ [ns I ) O O0000O0

J]

Output

Serial receiver Serial video

:| output signal

? J

?L |

Figure 1-7: Monitoring the video bit stream of a serial receiver
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You can use the waveform rasterizer to check serial digital signals around a
routing switcher. It is possible to look at all the inputs to the switcher with the use
of a patch panel and the waveform rasterizer as shown in Figure 1-8.

Monitor
SDIB
SDIA Loopthrough
Loopthrough
O
Waveform rasterizer
(rear panel)
OO0 NXNO C OO0 C—D
CD a @\@\@ 0’00000
Serial video [ J J
output signal
4 Patch panel Serial router
— T
—] Q_» [—j
Serial o U " 0l
sources i U ] i
" q%— Output
—1 Q_» HI—j N
. )

Figure 1-8: Monitoring serial digital signals around a routing switcher

Line Termination

The waveform rasterizer uses passive loop-through serial and analog inputs.
Accordingly, the loop-through must be terminated externally. It is important that
this external termination meet accuracy and return loss requirements.

If the waveform rasterizer is installed to monitor an operating link, the destina-
tion receiver and the connecting cable serve as the termination. This monitoring
connection is best because it checks the performance of the entire serial path. The
return loss of the waveform rasterizer is sufficiently high that, in most cases, the
destination receiver sets the system return loss.

In cases where the waveform monitor is placed at the end of a link, a BNC
termination must be installed on one side of the loop-through connector. The
termination must be 75 € and DC coupled (good return loss extends to DC).
Return loss should exceed 25 dB from 10 kHz to 270 MHz for SDI. Return loss
should exceed 40 dB from DC to 6 MHz for composite. An appropriate
termination would be Tektronix part number 011-0163-00. It is a 75 Q 4-0.2%,
BNC, 26 dB return loss to 300 MHz, End of Line termination.
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Connecting to Monitors
and Projectors

Compatibility of BNC Center Pins. Most video equipment BNC connectors,
whether 50 or 75 €2, use a 50 €2 standard center pin. Some laboratory 75 € BNC
connectors use a smaller diameter center pin. The BNC connectors on the
waveform rasterizer are designed to work with the 50 €2 standard (large
diameter) center pins.

Do not use connectors or terminators with the smaller center pins. They could
cause intermittent connections.

Some monitors or projectors may have trouble adapting to the XGA output from
the waveform rasterizer. This is because there may not be any significant signal
in all four corners of the raster, so the monitor cannot find the edges of the active
area. To overcome this, select Status in all four tiles of the waveform rasterizer
display, and then cycle the power on the monitor to force it to re-configure. If
necessary, adjust the horizontal and vertical position and size to optimize the
image.
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Operating Basics

This chapter provides basic operating information for the WVR610A &

WVR611A Waveform Rasterizers.

Overview

The WVR610A & WVR611A use a flexible, tiled display. The waveform
rasterizer can display four tiles at one time. Each tile can display a different
measurement, effectively creating four independent instruments. See Figure 2-1.
To enable the tiles to function independently, most of the controls only affect one
tile at a time. The tile that is currently being controlled is considered the active
tile and it is indicated on the display by a light-blue outline around the tile. The
active tile is indicated on the front panel by the lit display select button on the

left side of the front panel.

Pressing 2 makes
tile 2 the active tile

Tektron/iw
WVRG11A

O FAULT

~

¢ SDI Video Standard {Aut:

ID: WVRB10_2E3138

Figure 2-1: A display with all four tiles visible

The waveform rasterizer can also display one tile at a time. If, for example, you
want to display just the Waveform tile to make a rise time measurement, you can
press the FULL button to display a tile in full-screen mode. See Figure 2-2.
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Figure 2-2: A tile in full-screen mode

The waveform rasterizer can display measurements in multiple tiles simulta-
neously. See Figures 2-3 and 2-4. For example, you can display all four Status
screens at one time. The only measurement that cannot be displayed in more than
one tile is the Audio measurement. It can be displayed in only one tile at a time.

Page 1 of 1

Input:  Analog A

Loss: e Fault

dio Output  0: pair1  1: pair 2 1 Input Missing
Channel

8)

8)

Peak (db)
High (ab)

Changed since reset:

Error Status Log Page 16 of 16

Error Status VITC/LTC

Tl:klrun'],\

Figure 2-3: A display with multiple Status screens
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525 59.94 SAT JAN 04 17:05:10

SDI Input B a B
Ref: Internal TB]\[I‘OI'I}X

Figure 2-4: A display with multiple WFM displays

Three Levels of Control
You control the waveform rasterizer on three levels:
B Frequently-changed settings
m  Tile-specific settings

B [nstrument-wide settings

Frequently changed settings. The front-panel buttons control the most commonly
changed parameters, such as which measurement appears in each tile. The knobs
are used to adjust levels and make selections.

Tile-specific settings. Pop-up menus control parameters that are specific to the tile
in which they are displayed. The pop-up menus control less frequently changed
parameters such as the waveform display mode (for example, changing the
waveform display mode from RGB to YPbPr). To display a pop-up menu, press
and hold the desired MEASURE SELECT or DISPLAY SELECT button for
about a second.

Instrument-wide settings. The parameters in the Configuration menu are
instrument-wide settings. The configuration menu controls settings that are
changed only occasionally, such as changing waveform color or setting the
network address.
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Range of Controls

Front-Panel Controls

Tile Settings

Indicates a hardware problem ——O FAULT

that requires servicing

Some controls are global and affect all tiles, while other controls only affect the
active tile. Generally speaking, if a control is configured by front-panel buttons
or by a pop-up menu, then it is tile specific. Configuration selections are usually
global. Exceptions are the Input buttons, and all audio features, both of which are
global.

The following sections describe the front panel controls of the WVR610A &
WVRG611A.

Each tile maintains its own settings independent of the other tiles, including
GAIN and SWEEP, and display type among others. For instance, when you
switch a tile to a different measurement, the GAIN and SWEEP settings will be
changed to what they were the last time the selected measurement was displayed
in the tile.

Display type is also independent for each tile. You could set Tile 1 to display the
Video Session STATUS screen and set Tile 2 to display the Error Log STATUS
screen. Suppose you then change Tile 1 to a WFM display and Tile 2 to a
GAMUT display. If you then change Tile 1 back to a STATUS display, it will
display the Video Session screen, which is what it was set to before you changed
it to the WFM display. Likewise, if you change Tile 2 back to STATUS, it will
display the Error Log screen.

 EEEEEEE DDG%D
[ e S e e [ e e e o [ o Bl e A
00lo o C}C}C}DDC}C}DOOOO

Makes the display in the
first quadrant the active tile

Makes the display in the
second quadrant the active tile

Tektl'on/ix® DISPLAY SELECT

WVRG611A

W Toggles the active tile between
B full-screen and tile mode

Makes the display in the third
quadrant the active tile

Makes the display in the fourth
quadrant the active tile

Figure 2-5: Display select buttons and fault indicator
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GOQ OO oo oo.do (] D(]S[}
OO oCcooooooo
Selects the Vector

display for the active tile

_Selects the Wa\_/efO(m —
display for the active tile

— Selects the Timing display for

the active tile
Selects the Picture Monitor ——

display for the active tile

| Selects LTC Waveform for

the active tile
Selects the Gamut — |

display for the active tile

Selects the Status Selects the Audio display for the active tile.
display for the active tile Only one Audio tile can be displayed at a time.

Figure 2-6: Measure select buttons

> O O oo e aoa o O &
D E895EEEs5839000 00
EEE GAIN I
X Sets the active tile to 1X Gain
5X Sets the active tile to 5X Gain
VAR Sets the active tile to Variable Gain.
| —

Gain is set using the GENERAL knob.

Figure 2-7: Gain buttons

NOTE. The Gain controls are not enabled for all measurements.
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R E EEEE=EE
(I S\VEEP HE\
<— Sets the active tile to the current Line rate sweep
or 2 Line sweep
<— Sets the active tile to the current Field rate sweep
or 2 Field sweep
<— Magnifies the active tile sweep rate
N/

Figure 2-8: Sweep buttons

NOTE. The Sweep controls are not enabled for all measurements.

00

98O O O

&
000
000
000
000
000
000
00

0o

000
000
Qob

M PRESETS I

— ) e
Recall and sets the
Recall and sets the __n n/ designated preset
designated preset - -
—e ) [

N HO 10 SOl —

Recalls the Factory preset

Figure 2-9: Presets buttons
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>Q OO0 ocooo o o o
h55°E888|238[85%000
_ INPUTS —
SDI COMPOSITE
| 1
Select the designated | | Selects the designated
input for display l J input for display

Figure 2-10: Input select buttons

7 s s e e[ e [ e DDGQD
o O o oo ooooallo OoKo

Halts updates to most —» <— Displays online help

displays.

r—REF
Selects either internal or external composite video —»l \ <— Displays the Configuration menu

input for the instrument synchronization reference.

Enables and disables ——|LINE SEL CURSOR~—— Displays the cursors.

the Line Select Mode

Figure 2-11: General function buttons

OO oo oooo o o o
O D OO 000 o0oooo oKolO OO
&@DD OoOoOCOoco oo oo @

‘A,
e
2

Used to navigate menus
and make selections

Figure 2-12: Arrow keys and SEL button
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Pop-Up Menus

P SE22222320 0 2 Sy
GENERAL VERTICAL HORIZONTAL

<

Use to make
selections or
adjust values

Used to change the waveform
horizontal position

Used to change the waveform
vertical position

Figure 2-13: Control knobs

Pop-up menus appear in the active tile. In general, they control only settings
specific to the active tile. For example, the pop-up menu for the Waveform
display enables you to specify the Display Mode. See Figure 2-14.

To display a pop-up menu:

®  Press and hold the desired MEASURE SELECT or DISPLAY SELECT
button for about a second.

The pop-up menu will appear, unless it is not appropriate for the current setting
of the waveform rasterizer (for example, trying to display the Gamut menu when
viewing a composite input signal).
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Display Style Overlay
Y On

Pb On

Pr On

Filter Flat

Center Waveform  Press Select

Figure 2-14: The WFM pop-up menu with display mode set to YPbPr

The selections in a pop-up menu can change depending on settings. For example,
in Figure 2-14 Y, Pb, and Pr are in the menu when the display mode is set to
YPbPr. But the menu changes when the display mode is set to RGB. See

Figure 2-15.

e e

Display Style Overlay
On

On
On

Filter Flat

Center Waveform  Press Select
RGB / ...

Figure 2-15: The WFM pop-up menu display mode set to RGB
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Configuration Menu  The Configuration menu is used to change the settings of the waveform rasterizer
that are changed only occasionally or settings that are not specific to a tile, such
as printer settings.

To display the Configuration menu:
B Press the CONFIG button.

The Configuration menu is displayed on the top or bottom half of the screen
opposite the active tile. See Figure 2-16.

SDI Input
Ex

Diamond Defaults.

TSC Defaults
ad PAL Defaults

MON JUN 23 14:16:09 ID: WVRGIH
Audio Inpi

Figure 2-16: The configuration menu

Status Bar

The Status Bar appears at the bottom of the waveform rasterizer display. The
Status Bar provides a number of text and icon elements to give you an easily
viewed guide to the status of the instrument and the monitored signal. Table 2-1
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Input format

|

525 59.94
SDI Input B
Ref: Internal

Current reference

describes the elements of the Status Bar and Table 2-2 describes the icons that
can appear in the Status Bar.

EDH / RGB Composite,
Luma, and Gamut errors
' Date and time Instrument name

SAT JAN 04 17:03:42 ID: WVRG11_2E3138

Tektronix PPP e Embedded Audio
Va2 VITC: 07:21:50:01:0 channe| status

Alarm/Error indicator VITC [ LTC readout

Figure 2-17: Elements of the status bar

Table 2-1: Status bar element descriptions

Display element

Description

Input Format

Text indicating the format of the signal on the selected input, or whether signal is missing or

unlocked.
EDH Error A one-line area that is visible if EDH errors are present.
RGB Gamut Error? A one-line area that is visible if RGB gamut errors are present.

Composite Gamut Error!

A one-line area that is visible if Composite gamut (Arrowhead) errors are present.

Luma Errors

A one-line area that is visible if Luma errors are present.

Date and Time

Readout of the date and time (set in CONFIG > Utilities).

Instrument Name

Name assigned to the waveform rasterizer in the CONFIG > Utilities menu.

Audio Channel Status

A 16-character string indicating embedded audio channel status. Each character shows the status of
a specific channel: - for not present and P for present

VITC/LTC readout

A readout showing the selected time format.

Alarm/Error Indicator

An icon visible when alarms when are occurring.

Current Reference

Text indicating the source of the current reference. Possible references are: Ext., Internal. Also
indicates format and whether the reference is missing or unlocked.

Current Input

Text indicating the selected input. Possible inputs are: SDI A, SDI B, Cmpst A, Cmpst B (depending
on installed options). Also indicates if the current input is not in Auto mode and is unlocked.

1 Because RGB and Composite Gamut messages appear on the same line in the display, if both RGB and Composite
Gamut errors are present at the same time, the message “RGB and Cmpst Gamut” will appear.
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Table 2-2: Status bar icons

Icon Description

Warning - Appears when an alarm or error has been triggered.

Alarms Muted - Appears when the alarms have been muted from the
STATUS pop-up menu.

Remote Access - Appears when the waveform rasterizer is accessed from
the network. For example, when the sending commands to the waveform
rasterizer from the remote interface.

Alarms Disabled - This text appears in the Status Bar when Alarms have

Alarms been disabled from the Configuration menu.
Diisabled

Freeze Active - Appears when the tiles have been frozen.

Waveform Display

The Waveform (WFM) display is the familiar voltage versus time display used to
view a waveform. You can view the input signal in line or field sweep. You can
choose which SDI signal elements are displayed (RGB, YRGB, or YPbPr), and
you can apply filters to the signal. You can also display an SDI input as though it
were a composite signal.
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Variable gain— V Gain: x1.43 Mag: x25.0 <f— Sweep Mag

setting

enabled

|

Waveform components Field and line select Sweep rate
displayed

Figure 2-18: Waveform display elements

Table 2- 3: Waveform display element descriptions

Display element

Description

Gain Setting

A text string indicating the gain setting. Possible readouts are V Gain: x5, and V Gain: 1.50. When
the Gain is set to a value other than 1, it will appear in a bright yellow color. The gain setting is not
displayed when it is X1.

Waveform components
displayed

A text string showing the current waveform color space components displayed. Non-displayed
components are indicated by dashes: --.

Field and Line Select

A readout displaying the currently selected field and line.

Sweep rate

A readout showing the current sweep rate in a tile.

Sweep rate, Mag

A readout showing when the Mag button is pressed; if pressed, Mag is displayed next to the sweep
rate in yellow text.

Waveform Pop-up menu

The Waveform pop-up menu enables you to choose the display style and display
mode used in the active tile (SDI inputs only), select a filter to apply to the input
signal, or center the waveform in the display.

To display the Waveform pop-up menu:

B Press and hold WFM to display the pop-up menu.
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The choices for Display Mode (only available while displaying SDI inputs) are:

B YPbPr - Displays the input as Luminance (Y) and color difference (Pb, Pr)
components.

B YRGB - Displays the input as Luminance (Y), Red (R), Green (G), and
Blue (B) components.

B RGB - Displays the input as Red (R), Green (G), and Blue (B) components.

®  SDI -> Composite - Displays the SDI input as if it has been encoded into
composite. The sync and burst in this mode are synthetic and convey no
information about signal quality.

To change the Waveform display mode (for SDI signals):
Press and hold WFM to display the pop-up menu.

Use the up/down arrow keys to select Display Mode.
Press the right-arrow key to select the submenu.

Use the up/down arrow keys to select the display mode.

Press SEL to accept the selection.

AN A

Press WFM to to remove the pop-up menu.

When viewing 525-line SDI input as a composite waveform while using line
select mode, both burst phases may appear when you would expect to see only
one. This is because the line selection in SDI Mode is an odd/even selection,
while composite signals are normally viewed with a one-of-four or one-of-eight
line selection.

The Waveform pop-up menu Display Style setting (SDI inputs only) enables you
to choose how the signal components are displayed in the active tile:

B Parade style has all the components shown one beside the other like cars in
a parade.

B Overlay style has all the components drawn at the same location so that they
appear one on top of the other.

To change the Waveform display style:

1. Press and hold WFM to display the pop-up menu.
2. Use the arrow buttons to select Display Style.

3. Press SEL to toggle between Parade and Overlay.

The Waveform pop-up menu Filter selection allows you to select filters to be
applied to the video. This is useful to isolate a specific characteristic of the input.
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Vector Display

For example, to measure amplitude you may want to use a Luma or Low pass
filter to remove the high frequency components.

Different display modes have different filters available. For SDI displays, such as
RGB mode, Flat and Low Pass are available. For Composite displays, the filter
selections are Flat, Luma, Chroma, and Flat + Luma. The Flat + Luma mode
shows two waveforms in parade configuration.

The function of each filter is as follows:
®  Flat - Display with the full available bandwidth.
B  Luma or Low Pass - Display only the low-frequency portion of the signal.

B Chroma - Display only the portion of the signal with frequencies near the
color sub-carrier. For Composite inputs only.

®  Flat + Luma - A combination of a Flat and a Luma waveform from a
Composite input.

To apply a filter to the Waveform display:
1. Press WFM to display the pop-up menu.

2. Select Filter and press the right-arrow key to change the menu focus to the
submenu.

3. Select the desired filter. Only filters appropriate for the selected input are
displayed.

4. Press WFM to remove the menu.

The Center Waveform function is used to cancel any horizontal or vertical
position adjustments and restore the trace to the default position. For a tile in
WFM mode, this puts the baseline at the zero graticule.

To center the waveform:
1. Press WFM to display the pop-up menu.
2. Select Center Waveform and press SEL to center the waveform.

3. Press WFM to remove the menu.

The Vector display provides two display types: Vector and the Tektronix
proprietary Lightning display (SDI signals only). The Vector display shows a
plot of the R-Y signal on one axis and the B-Y signal on the other. It is useful for
looking at hue and saturation of the colors, but does not show luminance
information. The Lightning display shows the same color signals as in vector,
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but they are plotted versus luminance. One color difference signal in the top half
and the other in the bottom. Lightning is useful for checking chroma and luma
gain, and for checking chroma to luma delay via the timing marks that show
errors in the green to magenta transition on a color bar signal.

Display type Bar target setting

Figure 2-19: Vector display elements

Table 2- 4: Vector/Lightning display element descriptions

Display element Description

Line Pressing the LINE button sets the horizontal gain to 1X.

Field Pressing the FIELD button sets the horizontal gain to 5X.

Mag Pressing the MAG buttons enables you to adjust the horizontal gain using the GENERAL knob.
Display type The selected display, either Lightning or Vector.

Bar target setting The bar target setting, either 75% or 100%.

Phase Appears in Composite Vector display only.

Vector Pop-up Menu  The Vector pop-up menu enables you to specify the display type (SDI inputs
only), to set the bar targets, and to center the waveform in the display.

To display the Vector pop-up menu:
B Press and hold VECT to display the pop-up menu.
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To specity the display type (SDI inputs only):
Press and hold VECT to display the pop-up menu.
Use the up/down arrow keys to select Display Type.

Press SEL to select either Vector or Lightning.

W b=

Press VECT to remove the pop-up menu.

The Vector display shows a plot of the R-Y signal on one axis and the B-Y
signal on the other. This display is useful for looking at hue and saturation of the
colors, but does not show luminance information.

The Lightning display shows the same color signals as in vector, but they are
plotted versus luminance. One color difference signal in the top half and the
other in the bottom. Lightning is useful for checking chroma and luma gain, and
for checking chroma to luma delay via the timing marks that show errors in the
green to magenta transition on a color bar signal.

The Bar Targets setting allows you to select which scaling should be used in the
active tile for either the Vector or Lighting displays.

To specify the bar target scaling:

1. Press and hold VECT to display the pop-up menu.
2. Use the up/down arrow keys to select Bar Targets.
3. Press SEL to select either 75% or 100%.

4. Press VECT to to remove the pop-up menu.

The Center Waveform function is used to cancel any horizontal or vertical
position adjustments and restore the trace to the default position. For a Lightning
display type, this function sets the trace back to the center of the tile. For a
Vector display type, this function shifts the trace to locate the selected color at
the center of the display.

To center the waveform:

1. Press VECT to display the pop-up menu.

2. Use the up/down arrow keys to select Center Waveform.
3. For a Lightning display, press SEL to center the waveform.

4. For a Vector display, press the right-arrow key to select the color you want to
locate at the center of the display.

5. Press WFM to remove the menu.
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Measure Display

Pressing the MEAS button displays a Tektronix proprietary display that greatly
simplifies measuring the timing difference between two signals as the timing is
corrected. Using the Tektronix Timing display enables you to easily compare and
correct the timing between two digital signals.

Input signal indicator

/ (circle)

Inpat Timing Relative fo Refereng

Offsct:

advanced

Horizontal Ottset:

1740 us advanced

Relative to:

Rear Panel

~

Reference indicator

Circle will he in the center when inpnt

(crossh air) timing matches the Reference.

FRI JUL 18 15:57:44
Teklrun/ix

Figure 2-20: Timing display

Table 2- 5: Timing display element descriptions

Display element Description

Input signal indicator A circle representing timing of input signal relative to the reference.

Reference indicator A crosshair indicator representing the reference signal.

Vertical Offset The timing difference between the reference and input signal.

Horizontal Offset The timing difference between the reference and input signal.

Relative to Indicates the chosen zero point for the timing display. The default is Rear Panel. In this mode, the
offset is zero when the input and reference are at the same timing at the rear panel of the waveform
rasterizer. The other setting is Saved Offset. In this mode, you can save the timing from one signal,
and then display the timing relative to that saved offset.

Measure Pop-up Menu  The Measure pop-up menu enables you to save a timing setting for comparison
with another signal and specity the zero point of the timing display.

To display the Measure pop-up menu:

®  Press and hold MEAS to display the pop-up menu.
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The Save Offset pop-up menu entry allows you to save the timing of the current
input as an offset to the timing display. This saved timing then becomes the zero
point for the timing display. This applies to both the cross-hair target in the
middle of the display and the numeric readouts. Save Offset allows you to
measure the timing between inputs or to match multiple signals.

To save the timing of the current input:
1. Press MEAS to display the pop-up menu.
Use the up/down arrow keys to select Save Offset.

Press SEL to save the timing of the current input.

Eal A

Press MEAS to remove the menu.

NOTE. You cannot save the timing offset if either the input or reference is missing
or unlocked. You also cannot save a reference when in internal mode. Saving an
offset in these conditions would lead to misleading results so it is not allowed by
the instrument. A warning message will appear on the screen if you attempt to
save the offset when it is not allowed.

The Relative To: pop-up menu entry allows you to select one of two definitions
for the zero timing offset in the timing display. This selection changes both the
numeric readouts and the target in the middle of the timing display.

The choices are Rear Panel which means the timing offset will be shown as zero
when the two signals are timed down at the rear of the waveform rasterizer, and
Saved Offset which means that the timing will be shown as zero offset when the
input signal matches the timing of the signal that was present when the offset
was saved.

To change the Relative to setting:

1. Press MEAS to display the pop-up menu.

2. Use the up/down arrow keys to select Relative To.
3. Press SEL to select Rear Panel or Saved Offset.
4

Press MEAS to remove the menu.
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Picture Display

2-20

Picture Pop-up Menu

The Picture display lets you see the picture generated by the video signal. You
can choose to display the picture with or without a Picture Frame. See

Figure 2-21. The Picture Frame function allows you to display or hide elements
of the video signal outside the active video. With Picture Frame switched On,
only the active video portion of the signal is displayed. With Picture Frame
switched Off, elements of the signal outside the active video are visible. When
the picture frame is off, you can see user data, embedded audio and elements in
the vertical interval.

0061678 Bl |
1121304 %616 1 [

ID: WVR610_2E3138

Figure 2-21: Picture display

NOTE. In tile mode, 525 line pictures are cropped by 12 lines. Six at the top and
six at the bottom. This is done as part of the aspect ratio correction. In full-
screen mode there is no cropping.

Pictures are decimated horizontally or vertically to achieve the correct 4 x 3
aspect ratio on a square pixel computer monitor. This decimation may cause
some artifacts. This behavior may be evident on a sweep signal on 525 mode.

The Picture pop-up menu enables you to display or hide elements of the video
signal outside the active video. With Picture Frame switched On, only the
active video portion of the signal is displayed. With Picture Frame switched Off,
elements of the signal outside the active video are visible. When the picture
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Audio Display

frame is off, you can see user data, embedded audio, and elements in the vertical
interval.

To switch the Picture Frame On or Off:
1. Press and hold PICT to display the pop-up menu.
2. Press SEL to select On or Off as desired.

3. Press PICT to remove the pop-up menu.

NOTE. You can see signal elements outside the active video only when the PICT
display is set to FULL. You will not be able to see sync signal elements on
Composite signals.

The Audio display provides level meters and a phase display for monitoring
audio signals. The Audio display always shows the level meters and correlation
meters. When you choose to display the phase plot (also known as Lissajous),
the left portion of the Audio tile displays the level meters and the right portion
the Phase display. See Figure 2-22.
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Level meters Phase diaplay
A A

Meter ballistics
readout -

Peak level indicator ——

Test level indicator —1—

Level meter <
scale and units

Level meter labels
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Audio Input: Embedded --f—

Audio source

in phase

Selected phase pair

— Axes for phase
display

Correlation meter
for selected pair

Phase correlation meters In-bar warning

messages

Figure 2-22: Audio display with phase display

Table 2- 6: Audio display element descriptions

Display element

Description

Level meters

Indicate the amplitude of selected audio channels.

Phase display

Plot of one channel versus the other in a pair.

Audio source

The selected audio input.

Level meter labels

Identifies the signal in each meter bar.

Level meter ballistics readouts

Displays the selected dynamic response characteristic.

Axes for phase display

Shows the orientation of the two audio signals.

Phase correlation meters

Displays phase correlation between the two channels of each appropriate pair. Located under the
bars for the same channels. Duplicated under the Phase display. Has configurable response time.

Test level and Peak Program
Level Indicators

Diamond-shaped markers between the level bars that indicate the configurable limits set up for the
display. Above the Test level the bar displays in a yellow color. Above the Peak level the bar displays
in a Red color. Test level is also known as Reference level or Line-up level.

Level Meter Scale and units

By default, the zero dB mark is at digital full scale, and units are in dB relative to full scale (dBFS).
You may also set the 0 dB mark to either the Peak Program level or the Test level.

2-22
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Above-bar Warning  The WVR610A & WVR611A display warning messages above the level meter
Messages  bars. The warning messages that can appear above the bars are shown below.

CLIP. The number of consecutive samples is at or exceeds the # Samples for Clip
setting.

OVER. The signal has been at or above the specified Over Level for a time
exceeding the Duration for Over setting.

In-bar Warning Messages = The WVR610A & WVR611A display warning messages within the level meter
bars. The warning messages that can appear are shown below in order of priority.

UNLOCKED. The instrument is not locked to an incoming signal on the indicated
input channel. Data cannot be decoded and all data and other errors are ignored.
This means that if an AES input is selected, nothing recognizable is present on

the input, or if embedded audio is selected, the VIDEO input is unrecognizable.

AES PARITY. The incoming subframe does not have even parity as specified by
the digital audio standards. The data sample is unreliable and is ignored. The
level meters and Lissajous display treat the sample as a zero sample.

AES CRC ERROR. The CRC code in the AES channel status packet is incorrect.
Sometimes the CRC code is set to zero, indicating that the signal is missing;
when this is the case, this message is not displayed.

MUTE. The number of consecutive all-zero samples is at or exceed the # Samples
for Mute setting.

SILENCE. The signal has been at or below the specified Silence Level for a time
exceeding the Duration for Silence setting.

DISABLED. Disabled can appear for three reasons:

B Analog audio is selected as the bar source, this causes bars 7 and 8 to say
DISABLED since there are only 6 analog inputs.

B Embedded audio is selected as the bar source when Composite video is
selected as the video input. Since there is no embedded audio in composite,
all of the bars will say DISABLED.

m  If the currently selected audio source’s Bar to Input Map does not have all of
the bars mapped to inputs, any bars that are unmapped will say DISABLED.
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Audio Pop-up Menu

AES V BIT. Indicates that the Validity bit is set high for one or more data samples.
In the AES/EBU standard, a set validity bit indicates that the sample is not
suitable for conversion to audio. By default, the level meter bars and Lissajous
display treat the affected samples as zero samples.

The Audio pop-up menu enables you to select the audio input source and specity
whether or not the signal phase is displayed. If the signal phase is displayed, you
can also specify the style of the phase display and which pair of inputs is shown

in the phase display.

To display the Audio pop-up menu:
B Press and hold AUDIO to display the pop-up menu.

Audio Input. This entry in the Audio pop-up menu enables you to select the
source for the Audio display. The number of available sources depends on which
audio option is installed.

Choosing any given input will make that audio the monitored signal regardless
of which video input is active.

Alternatively, choose Follows video to enable the mapping that allows changing
the audio source as the video input selection is changed.

To specity the Audio input source:

1. Press AUDIO to display the pop-up menu.

2. Use the up/down arrow keys to select Audio Input.
3. Press SEL to change the focus to the submenu.
4

Use the up/down arrow keys to select the desired audio input source. (The
choices available depend on which audio option is installed.)

5. Press AUDIO to remove the menu.

NOTE. Use the CONFIG menu to select the mapping of input to bar, the meter
type, and the Follows video mapping of audio to video.

Phase Display. This setting in the AUDIO pop-up menu allows a 2-channel phase
display to be added to the audio tile. A phase display is also called a “Lissajous”
display.

To turn the Phase Display on or off:

1. Press AUDIO to display the pop-up menu.
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2. Use the up/down arrow keys to select Phase Display.
3. Press SEL to toggle the setting on or off.

4. Press AUDIO to remove the pop-up menu.

Phase Style. This entry in the AUDIO pop-up menu allows you to choose the
axis style of the phase display.

There are two axis styles in the phase display:

®m  Lissajous Snd (Sound) Stage has axes rotated at a 45 degrees.
B X-Y has axes that are horizontal and vertical.

To change the axis style used in the Phase display:

1. Press AUDIO to display the pop-up menu.

2. Use the up/down arrow keys to select Phase Style.

3. Press SEL to select the preferred axis style.
4

Press AUDIO to remove the pop-up menu.

Phase Pair. This entry in the AUDIO pop-up menu allows you to choose which
pair of inputs are displayed in the phase display.

You can not select channels from separate pairs since the relative timing cannot
be ensured.

To choose the pair of inputs displayed in the Phase display:
Press AUDIO to display the pop-up menu.

Use the up/down arrow keys to select Phase Pair.

Use the right-arrow key to select the submenu.

Use the up/down arrow keys to select which pair to display.

Press SEL to accept the selection.

AN U S o

Press AUDIO to remove the pop-up menu.
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Other Display

The Other display is used to display an LTC waveform when one is present. This
enables you to check the LTC amplitude, noise and the timecode is locked to the
video. The display has two vertical scales, one in Volts and the other in dBu.

-<—— \Vertical scale in dBu

Vertical scale ——»
Time code displayed ——

THU JUL{ 11:36:35

NTSC 59.94
Cmpst Input A
Ref: Internal

Horizontal scale

Figure 2-23: Other display elements

Table 2-7: Other display element descriptions

Display element Description

Vertical scale Text indicating vertical scale

Time code displayed Indicates that the LTC is being displayed
Horizontal scale Text indicating the horizontal scale

Vertical scale in dBu Alternate graticule with vertical scale in dBu

OTHER Pop-up Menu  The Other pop-up menu provides access to the Center Waveform function. The
Center Waveform function is used to cancel any horizontal or vertical position
adjustments and restore the trace to the default position.

To center the waveform:
1. Press OTHER to display the pop-up menu.

2. Press SEL to center the waveform.
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Gamut Display

Low threshold —>§

3. Press OTHER to remove the menu.

The Gamut display provides three proprietary Tektronix displays to enable you
to easily and quickly check the gamut of an SDI signal. You can choose from the
Arrowhead, Diamond, and Split Diamond displays. The Arrowhead display
provides NTSC and PAL composite gamut information directly from the SDI
signal. The Diamond and Split Diamond display provide a reliable method of
detecting invalid colors.

|

Gamut display type Threshold indicators

Figure 2-24: Gamut display elements

Table 2- 8: Waveform display element descriptions

Display element

Description

High threshold Text showing the currently specified high threshold (Diamond High or Arrowhead Max).
Low threshold Text showing the currently specified low threshold (Diamond Low).
Gamut display type The selected Gamut display type: Diamond, Split Diamond, or Arrowhead.

Threshold indicators

Blue dashed lines indicating the threshold settings.
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GAMUT Pop-up Menu  The GAMUT pop-up menu allows you to select the type of gamut display shown
in the active tile.

To change the display type in the GAMUT display:

1. Press GAMUT to display the pop-up menu.

2. Press SEL to change the menu focus to the submenu.

3. Use the up/down arrow key to select the desired display type.

4. Press GAMUT to remove the menu.

The three types of displays available in the GAMUT pop-up menu are:

B Diamond shows Gamut violations of the SDI input if translated to RGB
color space.

®m  Split Diamond offsets the two halves of the Diamond to allow you to better
see negative RGB Gamut errors.

B Arrowhead shows Gamut violations of the SDI input if it were translated to
the Composite domain.
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Status Display

STATUS Pop-up Menu

The Status display provides several views of signal status. Status displays are
text displays that show signal status in a variety of ways. You can view current
alarms and errors (those occurring now and within the last few seconds), a
history of errors and alarms (up to 10,000 entries), video error statistics or audio
error statistics. You can display a different Status display type in all four tiles at
once. See Figure 2-25.

Error Status Log Page 3 of 3 Alarm Status Page 1 of 1

Error Status /] i I Status Additional Information

Missing
¢ Ref Input Sonrce (Cmpst A/B)

123456—

Timecode V Missi Disabled
Timecode V i Disabled
Timecode Lt + Disabled
Timecode Ltc Invalid Disabled

Error Status Log Page 3 of 3

Error Status VITC/LTC

Bzl lkadlis 7 Ref Input Source ({Cmpst A/B)}
EDH: RGB Gamut:
FF Error Seconds: 0 Error fields:
FF Status: % Error field
AP Error Seconds:
AP Status: Cmpst Gamut:
Error fields: 0

EDH Error Fiel 0 % Error fields: 0.0000 %

0.0000 %

Changed since reset:

THU JUN 19 16:54:49 ID: WVR6E10A_ 192021

SDI Input B Audio Input: Analog A
Ref: Internal 7

Figure 2-25: A STATUS display in all four tiles

For detailed information on the elements of the various Status displays, see
Configuring Alarms and Viewing Status on page 3-37.

The STATUS pop-up menu enables you to mute alarms, to select the type of
display that appears in the status screen, and to set options related to the selected
display type.

To set the display type for the STATUS screen:
1. Press STATUS to display the pop-up menu.
2. Press SEL to change the menu focus to the submenu.

3. Use the up/down arrow key to select the desired display type.

WVR610A & WVR611A Waveform Rasterizers User Manual 2-29



Operating Basics

Navigating Menus

2-30

4. Press STATUS to remove the menu.

Additional settings available in the STATUS pop-up menu depend on the
selected display type:

B Error Log - When Error Log is selected, the pop-up menu enables you to
control the error logging settings. See page 3-67 for more information.

m  Alarm Status - When Alarm Status is selected, the only other selection
available is Mute Alarms.

m  Video/Audio Session - When either Video Session or Audio Session is
selected, you can also control the session settings. See pages 3-49 and 3-58,
respectively for more information on the Video Session and Audio Session
displays.

Both the pop-up menus and the Configuration menu contain multiple panes of
information. To change settings in a menu, you must navigate or traverse to the
desired pane of the menu. See Figure 2-26.

Active item is highlighted
by a white bar

AES A

AES B SDI B

Analog A Cmpst A

Analog B Cmpst B 00

Embedded A Embedded
Embedded B

Video to Audio Map

SDI Input

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Displays

Attenuate Audio Output 0dB

Alarms

Gamut Thresholds
Display Settings
LTC / VITC
Readouts
Graticules
Network Settings
Utilities

Active pane is highlighted
by a blue line

Figure 2-26: Panes in a menu

Only one pane of the menu is active at a time, this pane is indicated by a blue
highlight ring. In Figure 2-26, the highlight appears around the middle pane.
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To change a setting, you must highlight the desired setting. To move the
highlight between panes in a menu, use the arrow keys or the SEL button.

To navigate in a menu:

1. Use the up/down-arrow keys or the GENERAL knob to select the desired
item within a pane.

2. Press the right-arrow key to access the next pane. Repeat if necessary.

3. Use the right-arrow key or the SEL button to change the value of the
selection.

4. If the knob icon appears next to a selection, you use the GENERAL knob to
change that selection. See Figure 2-27. You can also use the up and
down-arrow keys, but the knob is usually faster.

Knob icon appears when
GENERAL knob is
enabled to change a value

Ballistics YU /...
101 gt Peak Held Segment Off
Set OdE Mark to: 0OdBu /...
Peak Program Level —8 dBu
Test Level —-18 dBu
Meter Scaling Normal /...
Set Meter Type to: dBu /...
Silence Level —70 dBu
Duration for Silence 5 Seconds
Over Level -5 dBu
Dwuration for Over 1 Seconds
Error Hold Time 2 Seconds

Composite Input
External Ref.

Digital Audio Displays
Audio Inputs /Qutputs
Alarms

Gamut Thresholds
Display Settings

LTC / VITC

Readouts

Graticules

Network Settings
Utilities

Correlation Meter Speed 10
Lissajous AGC Off

Figure 2-27: Knob icon

5. Press the left-arrow key to move the highlight back to a previous pane.

6. Press any other button to exit the menu.

Setting the Active Tile

Normally, there are four displays on the screen. Each display or quadrant is
called a tile. The tiles are numbered 1, 2, 3, and 4, corresponding to the
numbered Display Select front-panel buttons. See Figure 2-28.
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Figure 2-28: Tile positions in the display

One of the four tiles is defined as the active tile. The active tile is indicated by
the 1it Display Select button on the front panel and by the light blue highlight
around the tile in the display (see Figure 2-29). Most changes to the instrument
state affect the active tile. For example, changing a Vector display to an Audio
display changes only the active tile.

f Input Souxce (Crmpst
f Video Standard (

Input Source (none}
Input Source (Embedded A)

{ SDI Video Standard (Auto 525 59.94)

WED JAN 22

Tektroni

Highlight indicates active tile

Figure 2-29: Identifying the active tile
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To change the active tile:

B Press the numbered Display Select button of the tile you wish to make the
active tile. See Figure 2-30.

Tektronix- DISPLAY SELECT

wman [
[5@ )

Figure 2-30: Press a numbered button to set the active tile

Displaying a Tile in Full-screen Mode

The waveform rasterizer can display four tiles at once or just one tile. When just
one tile is displayed, it occupies the full screen. See Figure 2-31.

To display a tile in full-screen mode:

1. If necessary, press the numbered Display Select button for the tile you want
displayed in full-screen mode to make it the active tile.

2. Press the FULL button.

When the display is in full-screen mode, press FULL again to return to Tile
mode.
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20 21 22 23 74

WED JAN 22 3:
Tektronix

Figure 2-31: Full-screen mode

While in the full-screen mode, if you press another DISPLAY SELECT button,
the waveform rasterizer will display the contents of the selected tile in full-screen
mode.

Selecting a Measurement for the Active Tile
To select a measurement for the Active tile:

B Press the button for the measurement you want displayed in the active tile.

A VEASURE SELECT IR
WFM VECT MEAS

PICT

AUDIO OTHER

STATUS

Hold for menu  =————

GAMUT

Figure 2- 32: Measure select buttons

Most measurement selections can be displayed multiple times. For example, you
can display a Waveform measurement in two tiles, one with 1X gain and one
with 5X gain. Or you can display multiple STATUS screens all at the same time.
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The exception is the AUDIO measurement; only one instance of the AUDIO tile
can be displayed at a time.

Using the FREEZE Feature

FREEZE Pop-up Menu

Pushing the FREEZE button captures the current image for traces (waveform,
gamut, and vector), picture, status and audio measurements if selected. Freeze is
useful for comparing sources or for capturing transient events. Press FREEZE to
capture a display you wish to keep or show to someone else. In this application,
the Frozen Only display mode may be best. For comparing sources, the Frozen
+ Live display mode is useful. To use this feature, select one source, press
FREEZE to capture an image, then select the second source and compare.

Not all displays react identically to freeze. WFM displays capture a trace. For
text displays, such as Status, pressing FREEZE halts updates to the display. This
allows you to view the different status displays without numbers or status
readouts changing. The waveform rasterizer continues to log error status in the
background while the display is frozen.

FREEZE works in both tile and full-screen modes, but frozen images do not
change from tile to full or full to tile. That is, if you freeze a trace in tile mode,
the frozen image will not be shown if you go to full-screen mode. The frozen
image will still be available if you go back to tile mode. Likewise, if you freeze a
Waveform image in a tile and then switch the tile to another measurement such
as Vector, the frozen waveform image will be hidden. If you then change the tile
back to Waveform, the frozen image will reappear.

For waveform displays, the frozen image is shown in a different color to
distinguish it from the live image.

The FREEZE pop-up menu allows you to delete frozen images and select how
frozen images are displayed.

There can be only one frozen image in each tile. So you must delete any frozen
image before you can capture another.

To delete an image:
1. Push FREEZE to display the pop-up menu.

2. Because Delete Frozen Image is automatically selected, just press SEL to
delete the frozen image.

The pop-up menu is automatically removed from the display when the frozen
image is deleted.

If FREEZE is configured for Active Tile mode, this will only delete the image in
that tile. If FREEZE is in global mode, then the image in all tiles will be deleted.

WVR610A & WVR611A Waveform Rasterizers User Manual 2-35



Operating Basics

2-36

NOTE. Cursors track the live trace, so they may not be correctly registered on a
frozen trace. If you change parameters such as position, sweep rate, or gain,
then the cursors may not be accurate relative to a frozen trace.

The Display Mode sub-menu displays three choices:

®  Live Only

®  Frozen Only

®  Live + Frozen

The Live Only mode allows you to keep a frozen image, but not display it.
The Frozen Only mode makes it easier to see artifacts in the frozen trace.

The Live + Frozen mode is useful for comparisons and matching. Note that the
STATUS and AUDIO displays do not support this mode.

The FREEZE Display Mode setting is specific to each tile.
To change the FREEZE Display Mode:
1. Press the FREEZE button to display the FREEZE pop-up menu.

2. Use the navigation keys to select the desired mode, then press SEL to set the
desired mode.

FREEZE can be configured to act on only the active tile or on all tiles. To
change the FREEZE from Active Tile to All Tiles, you must go to the Display
Settings Configuration menu.
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Using Online Help

The WVR610A & WVR611A online help is a quick reference to instrument
operation. The online help is context sensitive, and the topic displayed depends
on what is displayed in the active tile when the online help is selected.

See Figure 2-33.

Contents Topic help

Ilelp Confents Using Online llelp

Help Index

te help. The HELF button is

pics inside a

Topic selector

Figure 2-33: The three sections of the online help

The online help contains three panes: Contents, Topic Selector, and Topic Help.
The Contents pane displays the major help topics available, including an index.
The choices in the Contents pane are always the same.

The choices in the Topic Selector pane change depending on the major topic
chosen in the Contents pane. The choices in the Topic Selector are subtopics
related to the major help topic selected in Contents. When Index is selected in
Contents, the Topic Selector pane lists all the index entries.

The Topic Help pane displays the help for the subtopic selected in the Topic
Selector or for a button pressed while help is displayed. The Topic Help section
can also contain links to other topics within help. See Figure 2-33.

The online help is context sensitive. For example, if you press a button when the
online help is displayed, the online help will display the Topic Help for the
button you press. Additionally, if you have a pop-up menu displayed and select a
setting in the pop-up menu and press HELP, the online help displays the topic
help for the item selected in the pop-up menu.
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Using Cursors

2-38

To display the online help:

Press HELP on the right side of the front panel.

To navigate the online help:

Press the right-arrow key to move the selection highlight to the next pane.

Use the GENERAL knob and the up / down arrow keys to select a topic you
wish to display.

Press SEL to display a selected topic.

To follow a link within topic help, highlight the link using the GENERAL
knob or the up / down arrow keys, then press SEL.

Press the left-arrow key to go back to the previous link.

To exit the online help:

Press HELP.

Cursors enable you to measure time or voltage on a waveform. Cursors appear
only in a tile set to Waveform mode. If the active tile is not in Waveform mode,
then an error message is displayed.

To display Cursors:

Press CURSOR. See Figure 2-34.

To remove Cursors:

Press CURSOR again.
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Active cursor readout appears in
yellow with knob icon

Voltl: 100.0 IRE

Active cursor

Inactive cursor

MON JUL 21 12:33:53 ID: WYRG10A 192021
Tektronix Audio Input: Not selected
-/

Figure 2- 34: The Cursor display

The active cursor is shown as a solid yellow line and the accompanying readout
is also displayed in yellow with the knob icon adjacent to it.

Inactive cursors are shown as blue dashed lines.

If you use other functions, such as Line Select, while cursors are active, the knob
will be assigned to those other functions. Press CURSOR to transfer the knob
control back to cursors.

You can display independent cursors in all four tiles at the same time, although
you will only be able to change the cursors in the active tile.

NOTE. Cursors track the live trace, so they may not be correctly registered on a
frozen trace.
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Cursor Pop-up menu The Cursor pop-up menu enables you to center the cursors and select the style of
cursors displayed.

The three styles of cursors available are:

B Voltage - Voltage cursors display the voltage level at each cursor and the
voltage difference between the two cursors.

B Time - Time cursors display the position of each cursor relative to the start
of the sweep and the difference between the two cursors.

B Voltage + Time - Displays both the Voltage and Time cursors.

To display the Cursor pop-up menu:

B Press and hold the CURSOR button.

To select the type of cursor displayed:

1. Press and hold CURSOR to display the Cursor pop-up menu.

2. Select Cursor Style and press SEL to change the focus to the submenu.

3. Select the desired cursor type using the up/down arrow keys.

To change the active cursor when both Voltage and Time cursors are displayed:

B For voltage cursors, press either of the up/down arrow keys to change the
active cursor.

®m  For time cursors, press either of the left/right arrow keys to change the active
CUISOr.

To change the active cursor when only Voltage or Time cursors are displayed:
B Press any arrow key to change the active cursor.
To move the active cursor to the center of the screen:

®  Press and hold the SEL button.
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Rear Panel Connections

Power connector

AES A inputs AES B inputsfoutputs Analog audio 1/O
A A

4

CO00O0000

e S . e OTOTOTOTOTOIIOIONO!

O10101000000000O0 «C——=0000

="

10/100 Remote XGA SDIA SDIB Ref Composite A Composite B
Base T output  loopthrough loopthrough  loopthrough loopthrough  loopthrough
ethernet

Figure 2- 35: Rear-panel connectors

Power Connector

Video Input Connectors
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The waveform rasterizer is designed to operate from a single-phase power source
with one current-carrying conductor at or near earth-ground (the neutral
conductor). Only the line conductor is fused for over-current protection. The fuse
is internal. Systems that have both current-carrying conductors live with respect
to ground (such as phase-to-phase in multiphase systems) are not recommended
as power sources. The power source frequency is 50 or 60 Hz. The operating
voltage range is continuous from 100 to 240 VAC.

There are two SDI and two Composite (WVR611A only) loop-through connec-
tors on the rear panel.

SDI A Loop-through. A passive loop-through component serial digital input,
compensated for 75 .

SDI B Loop-through. A passive loop-through component serial digital input,
compensated for 75 Q.

Composite A Loop-through. A passive loop-through composite analog input,
compensated for 75 Q. (WVR611A only)

Composite B Loop-through. A passive loop-through composite analog input,
compensated for 75 €. (WVR611A only)

Ref Loop-through. A passive loop-through synchronization input, compensated
for 75 €. The input signal can be analog black burst or analog composite video.
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AES A/B Connectors

Analog Input/Output
Connector

The BNC connectors labeled AES A /AES B support AES audio inputs (based
on the audio option installed). The AES B connectors can be configured to
output embedded audio from the Configuration menu. See Table 2-9.

Table 2-9: AES Connectors

Connector Input Joutput Channel supported

AESA1-2In Input AES channels 1 and 2
AES A 3-41In Input AES channels 3 and 4
AES A5-61In Input AES channels 5 and 6
AESA7-81In Input AES channels 7 and 8

AES B 1-21/0 Input / Output AES channels 1 and 2, or when configured from the
Configuration menu, AES output of embedded audio
channels

AESB 3-41/0 Input / Output AES channels 3 and 4, or when configured from the
Configuration menu, AES output of embedded audio
channels

AES B 5-6 1/0 Input / Output AES channels 5 and 6, or when configured from the
Configuration menu, AES output of embedded audio
channels

AESB 7-81/0 Input / Output AES channels 7 and 8, or when configured from the
Configuration menu, AES output of embedded audio
channels

The Analog I/O connector is used to input and output analog signals. The
Analog I/O connector is a 37-pin, D-subminiature connector. Table 2-10 lists the
function of each pin in the connector.

20 37
Q[oooooooooooooooooo O
1

0000000000000 OO0OOO0

19

Figure 2- 36: Analog I/O connector pin diagram

CAUTION. Use care when connecting the Analog Audio Output. Refer to

Table A-25 in Specifications, to ensure Audio Load and Output Power meet
specifications. Exceeding Analog Audio Output Power may result in damage to
the instrument.
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Table 2- 10: Analog I/O connector pin-out

Pin Pin name Description

1 ANALOG_INPUT_LPO_A Balanced differential analog audio input: Left, positive, Pair 0, Line A

2 ANALOG_INPUT_LPO B Balanced differential analog audio input: Left, positive, Pair 0, Line B

3 ANALOG_INPUT_RPO_A Balanced differential analog audio input: Right, positive, Pair 0, Line A
4 ANALOG_INPUT_RPO_B Balanced differential analog audio input: Right, positive, Pair 0, Line B
5 ANALOG_INPUT LP1_A Balanced differential analog audio input: Left, positive, Pair 1, Line A

6 ANALOG_INPUT LP1 B Balanced differential analog audio input: Left, positive, Pair 1, Line B

7 ANALOG_INPUT _RP1_A Balanced differential analog audio input: Right, positive, Pair 1, Line A
8 ANALOG_INPUT_RP1_B Balanced differential analog audio input: Right, positive, Pair 1, Line B
9 ANALOG INPUT LP2 A Balanced differential analog audio input: Left, positive, Pair 2, Line A
10 ANALOG_INPUT LP2 B Balanced differential analog audio input: Left, positive, Pair 2, Line B
1 ANALOG_INPUT_RP2_A Balanced differential analog audio input: Right, positive, Pair 2, Line A
12 ANALOG_INPUT_RP2_B Balanced differential analog audio input: Right, positive, Pair 2, Line B
13 GND

14 ANA OUT LNO Balanced differential analog audio output: Left, negative, Pair 0

15 ANA OUT _RNO Balanced differential analog audio output: Right, negative, Pair 0

16 ANA OUT LN1 Balanced differential analog audio output: Left, negative, Pair 1

17 ANA_OUT_RN1 Balanced differential analog audio output: Right, negative, Pair 1

18 ANA OUT LN2 Balanced differential analog audio output: Left, negative, Pair 2

19 ANA OUT RN2 Balanced differential analog audio output: Right, negative, Pair 2

20 ANALOG_INPUT_LNO_A Balanced differential analog audio input: Left, negative, Pair 0, Line A
21 ANALOG_INPUT_LNO B Balanced differential analog audio input: Left, negative, Pair 0, Line B
22 ANALOG_INPUT_RNO_A Balanced differential analog audio input: Right, negative, Pair 0, Line A
23 ANALOG_INPUT RNO B Balanced differential analog audio input: Right, negative, Pair 0, Line B
24 ANALOG_INPUT_LN1_A Balanced differential analog audio input: Left, negative, Pair 1, Line A
25 ANALOG_INPUT_LN1_B Balanced differential analog audio input: Left, negative, Pair 1, Line B
26 ANALOG_INPUT_RN1_A Balanced differential analog audio input: Right, negative, Pair 1, Line A
27 ANALOG _INPUT RN1 B Balanced differential analog audio input: Right, negative, Pair 1, Line B
28 ANALOG _INPUT LN2 A Balanced differential analog audio input: Left, negative, Pair 2, Line A
29 ANALOG_INPUT LN2 B Balanced differential analog audio input: Left, negative, Pair 2, Line B
30 ANALOG_INPUT_RN2_A Balanced differential analog audio input: Right, negative, Pair 2, Line A
31 ANALOG_INPUT_RN2 B Balanced differential analog audio input: Right, negative, Pair 2, Line B
32 ANA OUT _LPO Balanced differential analog audio output: Left, positive, Pair 0

33 ANA OUT RPO Balanced differential analog audio output: Right, positive, Pair 0

34 ANA OUT LP1 Balanced differential analog audio output: Left, positive, Pair 1

35 ANA_OUT_RP1 Balanced differential analog audio output: Right, positive, Pair 1
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Table 2- 10: Analog I/O connector pin-out (Cont.)

Pin

Pin name

Description

36

ANA_OUT LP2

Balanced differential analog audio output: Left, positive, Pair 2

37

ANA_OUT_RP2

Balanced differential analog audio output: Right, positive, Pair 2

2-44

The previous table identifies the Analog input/output connectors by left/right
pairs. The waveform rasterizer interface and the optional audio breakout cable
identify the signals as a series of numbers from 1 to 6. Table 2-11 maps the
left/right pairs to the analog input number used in the interface and on the
breakout cable.

Table 2- 11: Channel pair to analog input mapping

Pair label Analog Input
Lo 1

RO

L1

L2

2
3
R1 4
5
6

R2

Connecting Signals. When connecting audio signals to the Analog Input
connectors, you can use either balanced or unbalanced signals. If you connect
unbalanced signals to the inputs, you do not have to ground the unused lead
(grounding the unused lead can reduce noise).

When connecting the Analog Output connectors, you can connect them as
balanced or unbalanced. However, if you connect the balanced outputs to an
unbalanced input, you must ground the unused lead. You can ground either lead.

NOTE. Note that grounding the unused lead does not attenuate the output but it
does halve the clipping level. Therefore, you must attenuate the output by at least
6 dB to avoid clipping. The output signal level in unbalanced mode is double the
signal level in balanced mode.

Units that have both analog and digital capability can have AES or embedded
inputs converted to analog and then routed to the six balanced outputs.
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XGA Output Connector  This is the display output. The display resolution is 1024 x 768, in 16 colors.
The output is compatible with standard analog PC monitors, either CRT or
LCD-based. The REMOTE connector is a 15-pin D-type connector with socket
contacts. See Figure 2-37.

Q

10

5 1

00 0 0 O
ooooo@
ooooo\/

A

[}

15 1
XGA OUTPUT

Figure 2-37: XGA output connector pin diagram

Table 2-12: XGA connector pin-out

Pin

Description

Notes

—_

Red Video

Green Video

Blue Video

Not connected

Ground

Red Ground

Green Ground

Blue Ground

Ol N | |l DN

+5V

For monitor EEPROM

—_
o

Not Connected

—_
p—y

Not Connected

—_
N

ID Bit

Supports 12C polling

—_
w

Horizontal Sync

—_
E=N

Vertical Sync

—_
(8]

ID Clock

WVR610A & WVR611A Waveform Rasterizers User Manual

2-45



Operating Basics

2-46

Ground Closure

The REMOTE connector interface uses ground closures for remote control and
indicating to external equipment when alarms have occurred. The input of LTC
is through the REMOTE connector. The REMOTE connector is a 15-pin D-type
connector with socket contacts. See Figure 2-38 and Table 2-13.

8 1

o o0 o o0 O O 0 O
o o0 o o0 0 O O

15 REMOTE 9

Figure 2-38: REMOTE connector pin diagram

Table 2-13: REMOTE connector pin-out

Pin | Description Direction | Notes

1 Reserved for future use --

2 GND

3 Reserved for future use --

4 Reserved for future use --

5 Preset 1 IN Recall Preset 1

6 GND

7 +Time Code IN LTC (longitudinal time code) input.

8 -Time Code IN

9 Output ouTt This line goes to ground when asserted. It
is asserted when an alarm occurs, if
enabled.

10 Reserved for future use --

1 Reserved for future use --

12 Reserved for future use --

13 Preset 2 IN Recall front-panel presets. Asserting one of
the Preset signals causes the associated

14 | Preset3 IN front-panel preset to be applied to the
waveform rasterizer. Assert a pin by

15 | Preset4 IN connecting it to ground.
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Ethernet Connector  The waveform rasterizer provides a 10/100 BaseT Ethernet interface. The
Ethernet connector is a standard RJ-45 connector. See Figure 2-39.

Yellow LED ——=(0) @ <——- Green LED

Figure 2- 39: RJ-45 Ethernet connector

The connector includes two LEDs for indicating status. See Table 2-14.

Table 2-14: Ethernet connector LEDs

LED color Meaning
Green Connection is active
Yellow ON =100 Mb transmission rate

OFF =10 Mb transmission rate

Table 2-15 provides a pin-out for the RJ-45 connector.

Table 2- 15: Ethernet connector pin-out

Pin Pin name Description

1 TX D1+ Transceive Data+

2 TX_D1- Transceive Data-

3 RX_D2+ Receive Data+

4 BI_D3+ Bi-directional Data+
5 BI_D3- Bi-directional Data-
6 RX_D2- Receive Data-

7 Bl_D4+ Bi-directional Data+
8 BI_D4- Bi-directional Data-
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Changing Instrument Settings

SDI Input Settings

Input Format

Strip EAV/SAV/ANC

Use the Configuration menu to adjust instrument settings that are not specific to
a tile. The Configuration menu settings are instrument settings that you will
generally set when you first install the waveform rasterizer, and then change only
occasionally afterward.

The SDI Input settings specity how SDI inputs are displayed. See Table 2-16.
To change the SDI Input settings:

1. Press CONFIG to display the Configuration menu.

2. Select SDI Input to display the submenu.

3. Press the right-arrow key to change the menu focus to the SDI Input
submenu.

4. Select the desired setting and change the setting as needed.
5. After changing the setting, press CONFIG to remove the Configuration

menu.

Table 2-16: SDI input settings

Setting Choices / Range
Input Format Auto / 525 | 625
Strip EAV/SAV/ANC On/ Off

Chroma Offset / Align
NTSC Setup 0% / 7.5%

Specifies the format of the input signal. Auto allows the input to automatically
detect the input format, or it can be configured to run only in 525 or 625 line
mode. The manual mode (525 or 625) may be useful for signals with errors.

Determines whether the EAV and SAV timing references or the ancillary data,
such as audio, are visible in the Waveform display. Since these data values are
not band limited, they usually ring when displayed through the video waveform
filters.
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Chroma

NTSC Setup

Determines the vertical position of the color difference signals. If you select
Align, the chroma zero levels are aligned with the luminance zero level. The
color difference signals will extend below luma, but Gain will expand around the
zero levels. If you select Offset a 350 mV positive offset is added to the PbPr
channels. This does not affect the transcoded RGB display or the picture monitor
output signal.

Specifies how the SDI->Composite and Arrowhead display will be setup.

Composite Input Settings

Input Format

2-50

The Composite Input settings specity how composite inputs are displayed. See
Table 2-17.

To change the Composite Input settings:

1. Press CONFIG to display the Configuration menu.

Select Composite Input.

Use the navigation keys to change the menu focus to the submenu.

Select the desired setting and change the setting as needed.

U

After changing the setting, press CONFIG to remove the Configuration
menu.

Table 2-17: Composite input settings

Setting Choices | Range
Input Format Auto / NTSC / PAL
Sync AFC Speed Fast / Slow

DC Restore Fast / Slow /Off
NTSC Setup On/ Off

PAL Vector Normal / V+

Specifies the format of the input composite signal. In Auto, the waveform
rasterizer automatically detects the correct format. This setting is useful when
you occasionally changes the input format. If you always monitor the same
signal format, you can specify NTSC or PAL.
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Sync AFC Speed  The Sync AFC Speed sets the ability of the loop to follow changes in the
external reference signal. “Fast” can track signals with more line rate variation.
“Slow” has lower jitter.

DC Restore  Applies a voltage to the signal to keep one point on the waveform at a fixed DC
level. This makes taking measurements easier when the DC level of the

waveform shifts due to changes in signal content. Setting choices are Fast, Slow,
and Off.

m Select Off when you wish to see the DC offset in the signal. Off cancels the
operation of the DC Restore circuitry.

B Select Slow when you wish to remove DC offset from the signal but you still
want to see hum.

B Select Fast when you want to remove the effects of hum and offset from the
signal.

NTSC Setup  The NTSC Setup setting optimizes the operation of the WVR610A &
WVR611A for NTSC signals with and without set up. For example, this setting
changes the scaling of the vector bar targets.

PAL Vector  When V+ is chosen, the phase reference of the -V lines is inverted, then shown
as an overlay on the +V lines to provide a comparison display.

External Reference Setting

The External Reference setting specifies the allowed formats of the signal on the
EXT REF IN connector. See Table 2-18.

To change the External Reference settings:
1. Press CONFIG to display the Configuration menu.

2. Use the GENERAL knob or the up/down arrow keys to select External
Ref.

3. Use the navigation keys to change the menu focus to the External Ref
submenu.

4. Select the Lock to Standard setting and change the setting as needed.

5. After changing the setting, press CONFIG to remove the Configuration
menu.
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Table 2- 18: External reference settings

Setting Choices
Lock to Standard Auto / NTSC / PAL
Sync AFC Speed Fast / Slow

Lock to Standard  Sets the external reference format. In Auto, the waveform rasterizer automatical-
ly detects the correct format. This setting is useful when you occasionally change
the input format for the external reference signal. If you always use the same
external reference signal format, you can specify NTSC or PAL.

Sync AFC Speed  The Sync AFC Speed sets the ability of the loop to follow changes in the
external reference signal. “Fast” can track signals with more line rate variation.
“Slow” has lower jitter.

NOTE. When using an SDI input with an external reference, an input signal
time-base variation outside the specified range may be shown as a reference
unlock on the status bar and error logs.

Analog Audio Displays Settings

The Audio Display submenu provides access to parameters that control meter
ballistics, various meter characteristics such as Peak Hold Time, the number of
consecutive samples required to trigger various alarms, and other settings.
Table 2-19 lists the settings for audio displays.

To change the audio display settings:
1. Press CONFIG to display the Configuration menu.

2. Select Analog Audio Displays. Use the right-key to change to menu focus
to the Analog Audio Displays submenu.

3. Select the desired setting and change the setting as desired.

4. After changing the setting, press CONFIG to remove the Configuration
menu.
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Table 2-19: Analog Audio display settings

Setting Values

Ballistics True Peak / PPM Type 1/ PPM Type 2/ VU
Default: True Peak

Peak Hold Time Range: 0 to 10 seconds
Default: 2 seconds

Peak Hold Segment On [ Off
Default: On

Set 0dB Mark To: Top of Scale / Peak Program Level | Test Level
Default: Test Level

Peak Program Level 240 -6 dBu
Default: 10 dBu

Test Level 2410 -6 dBu

Default: 0 dBu

Meter Scaling

Normal (Default)
Custom Height: 10 to 90 dB (Default: 70 dB)
Custom Offset: -20 to 0 dB (Default: 0 dB)

Graticule Step Size: 3 to 10 dB (Default:
10 dB)

Set Meter Type to: dBu / DIN (IEC Type 1) / VU | Nordic (IEC
Type lIb) / IEEE PPM
Silence Level Range: -16 to -46 dBu

Default: -26 dBu

Duration for Silence

Range: 0 to 60 seconds

Default: 10 seconds

Over Level

Range: 24 to -6 dBu
Default: 10 dBu

Duration for Over

Range: 0 to 30 seconds

Default: 1 second

Error Hold Time

Range: 0 to 30 seconds

Default: 2 seconds

WVR610A & WVR611A Waveform Rasterizers User Manual

2-53



Changing Instrument Settings

Table 2-19: Analog Audio display settings (Cont.)

Setting Values

Correlation Meter Speed Range: 110 30
Default: 8

Lissajous AGC On / Off
Default: On

Ballistics  Specifies the response characteristics of the level meters. Choices are True Peak,
PPM (Peak Program Meter) Type 1 and Type 2, and VU.

B True Peak - Show actual signal peaks regardless of their duration. Rise
times are essentially instantaneous. Fall time is like PPM Type 2, and
requires 2.8 seconds to fall 20 dB. The in-bar peak indicator will persist at
the peak level for the “Peak Hold Time”. When True Peak ballistics are
selected, the display designation is True Peak Ballistics.

®  PPM Type 1- Response equivalent to IEC Type I (essentially the same as
DIN 45406 and Nordic N-9). The PPM Type 1 has a slightly faster attack
time and a faster return time than Type 2, requiring 1.7 seconds to fall 20 dB
as opposed to 2.8 seconds for Type II. When PPM Type 1 ballistics are
selected, the display designation is PPM Type 1 Ballistics.

®  PPM Type 2-Response equivalent to IEC Type II (the same as defined in
IEEE Std 152-1991). The PPM Type 2 has a slightly slower attack time and
a slower return time than Type 1, requiring 2.8 seconds to fall 20 dB as
opposed to 1.7 seconds for Type 1. When PPM Type 2 ballistics are selected,
the display designation is PPM Type 2 Ballistics.

B VU - A VU meter as defined by IEEE Std. 152-1991, but with an extended
dB-linear scale. The meter bars will also contain true peak indicators when
VU is selected. The display designation of this setting is VU Ballistics.

Peak Hold Time  Specifies the number of seconds that the True Peak Indicator remains at the most
recent peak level.

Peak Hold Segment  Switches the Peak Hold Indicator on or off.

Set0dB Mark To  Numbers the meter scale relative to Top of Scale or to one of the two user-adjust-
able levels. When the zero mark is set to either Peak Program or Test level, the
scale units are dBr, relative to the O dB level; units above the selected O dB mark
are positive, while units below it are negative.
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Peak Program Level  Sets the maximum desired level for monitored programs. The meter bars change
to red above the Peak Program Level.

Test Level  Sets as the test or “line up” level for your system. The meter bars change to
yellow between the Test and Peak Program Levels.

Meter Scaling  Sets the scaling for the level meters. Meter scaling can be set to Normal or
customized by setting up to three parameters: Custom Height, Custom Offset and
Graticule Size. At the Normal setting, the meter scale is set to a 70 dB range,
with the actual values at the top and bottom of the meter depending on the
setting for Set 0dB Mark to:. When you select one of the custom parameters, all
are enabled. When using Custom Height, the range of the meters can be set from
10 - 90 dB. When using Custom Offset, you are setting the location of a
“window” on the bar, where the size of the window is set by the Custom Height
setting. The Custom Offset setting, in effect, moves the window up and down the
range of the level meter. The Graticule Size setting specifies the difference in dB
between graticule tic marks. The difference between tic marks can be set from
3 dB to 10 dB, except for VU which is set at 3 dB.

Set Meter Type to: Sets parameters defining meter characteristics to conform with audio meter types
standardized in the industry. The characteristics of each meter type are shown in
Table 2-20.

Table 2-20: Characteristics of meter types

Scale |Scale |Scale

Meter Type Ballistic 0 dB Mark | Test PPL Height | Offset | Step
dBu PPM Type Il | Test 0 dBu 10dBu |70dB |0dB 10 dB
DIN PPM Type | | PPL -3dBu |6dBu |55dB |13dB |5dB
(IEC Type 1) (-9dBr) | (0dBr)
VU VU Test 0 dBu 0dBu |24dB [21dB |1dB
Nordic PPM Type Il | Test 0 dBu 6dBu |54dB [12dB |6dB
(IEC Type lIb)
IEEE PPM PPM Type Il | PPL 0 dBu 8dBu |32dB |8dB 4dB

(-8 dBr) | (0dBr)

Silence Level  Sets the audio level below which the signal is considered silent. This value is
used to trigger an on-screen indicator and alarms.

Duration for Silence  Specifies how long the audio level must be below the Silence Level before an
alarm is triggered. Setting the duration to “0” seconds disables the alarm.
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Over Level Specifies the audio level above which the signal is considered “over”. This
setting is used to trigger on-screen indicators and alarms.

Duration for Over  Specifies how long the audio level must be above the Over Level before an alarm
will be triggered.

Error Hold Time  Specifies the length of time the in-bar error messages are displayed after the error
has been removed.

Correlation Meter Speed  Determines how quickly the meter reacts to changes in phase relationship. The
meter reading is actually an average of correlation over time and this setting
determines how many samples are used to calculate the average. Lower settings
result in a faster meter response. Experiment to find the setting that best fits your
needs. The default setting is 8, which is 1.5 seconds.

Lissajous AGC ~ When On, allows the Lissajous or Phase display to change gain and keep the
display well scaled. When Off, puts the display in fixed gain mode with the Peak
Program level at the perimeter of the active area.

NOTE. The audio pop-up menu allows selection of input and allows the optional
phase display to be added to the audio tile.

Digital Audio Displays Settings

The Digital Audio Display submenu provides access to parameters that control
meter ballistics, various meter characteristics such as Peak Hold Time, the
number of consecutive samples required to trigger various alarms, and other
settings. Table 2-19 lists the settings for audio displays.

To change the audio display settings:
1. Press CONFIG to display the Configuration menu.

2. Select Digital Audio Displays. Use the right-key to change to menu focus to
the Digital Audio Displays submenu.

3. Select the desired setting and change the setting as desired.

4. After changing the setting, press CONFIG to remove the Configuration
menu.

2-56 WVR610A & WVR611A Waveform Rasterizers User Manual



Changing Instrument Settings

Table 2-21: Digital Audio display settings

Setting Values

Ballistics True Peak / PPM Type 1/ PPM Type 2/ VU
Default: True Peak

Peak Hold Time Range: 0 to 10 seconds
Default: 2 seconds

Peak Hold Segment On [ Off
Default: On

Set 0dB Mark To: Top of Scale / Peak Program Level | Test Level
Default: Peak Program Level

Peak Program Level 0to -30 dBFS
Default: -8 dB

Test Level 0to -30 dBFS

Default: -18 dB

Meter Scaling

Normal (Default)
Custom Height: 10 to 90 dB (Default: 70 dB)
Custom Offset: -20 to 0 dB (Default: 0 dB)

Graticule Step Size: 3 to 10 dB (Default:
10 dB)

# Samples for Clip

Range: 0 to 100
Default: 1

# Sample for Mute Range: 0to 100
Default: 10 consecutive
Silence Level Range: -70 to -40 dBFS

Default: -60 dB

Duration for Silence

Range: 0 to 60 seconds

Default: 10 seconds

Over Level

Range: -20 to 0 dBFS
Default: -8 dB

Duration for Over

Range: 0 to 30 seconds

Default: 1 second

Error Hold Time

Range: 0 to 30 seconds

Default: 2 seconds
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Table 2-21: Digital Audio display settings (Cont.)

Setting Values

Correlation Meter Speed Range: 110 30
Default: 8

Lissajous AGC On / Off
Default: On

Ballistics  Specifies the response characteristics of the level meters. Choices are True Peak,
PPM (Peak Program Meter) Type 1 and Type 2, and VU.

B True Peak - Show actual signal peaks regardless of their duration. Rise
times are essentially instantaneous. Fall time is like PPM Type 2, and
requires 2.8 seconds to fall 20 dB. The in-bar peak indicator will persist at
the peak level for the “Peak Hold Time”. When True Peak ballistics are
selected, the display designation is True Peak Ballistics.

®  PPM Type 1- Response equivalent to IEC Type I (essentially the same as
DIN 45406 and Nordic N-9). The PPM Type 1 has a slightly faster attack
time and a faster return time than Type 2, requiring 1.7 seconds to fall 20 dB
as opposed to 2.8 seconds for Type II. When PPM Type 1 ballistics are
selected, the display designation is PPM Type 1 Ballistics.

®  PPM Type 2-Response equivalent to IEC Type II (the same as defined in
IEEE Std 152-1991). The PPM Type 2 has a slightly slower attack time and
a slower return time than Type 1, requiring 2.8 seconds to fall 20 dB as
opposed to 1.7 seconds for Type 1. When PPM Type 2 ballistics are selected,
the display designation is PPM Type 2 Ballistics.

B VU - A VU meter as defined by IEEE Std. 152-1991, but with an extended
dB-linear scale. The meter bars will also contain true peak indicators when
VU is selected. The display designation of this setting is VU Ballistics.

Peak Hold Time  Specifies the number of seconds that the True Peak Indicator remains at the most
recent peak level.

Peak Hold Segment  Switches the Peak Hold Indicator on or off.

Set0dB Mark To  Numbers the meter scale relative to Top of Scale or to one of the two user-adjust-
able levels. When the zero mark is set to either Peak Program or Test level, the
scale units are dBr, relative to the O dB level; units above the selected O dB mark
are positive, while units below it are negative.
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Peak Program Level

Test Level

Meter Scaling

# Samples for Clip

# Samples for Mute

Silence Level

Duration for Silence

Over Level

Duration for Over

Error Hold Time

Sets the maximum desired level for monitored programs relative to digital full
scale. The meter bars change to red above the Peak Program Level.

Sets as the test or “line up” level for your system relative to digital full scale.
The meter bars change to yellow between the Test and Peak Program Levels.

Sets the scaling for the level meters. Meter scaling can be set to Normal or
customized by setting up to three parameters: Custom Height, Custom Offset,
and Graticule Size. At the Normal setting, the meter scale is set to a 70 dB range,
with the actual values at the top and bottom of the meter depending on the
setting for Set 0dB Mark to:. When you select one of the custom settings, all are
enabled. When using Custom Height, the range of the meters can be set from

10 - 90 dB. When using Custom Offset, you are setting the location of a
“window” on the bar, where the size of the window is set by the Custom Height
setting. The Custom Offset setting, in effect, moves the window up and down the
range of the level meter. The Graticule Size setting specifies the difference in dB
between graticule tic marks. The difference between tic marks can be set from
3to 10 dB.

Specifies the number of consecutive Full Scale samples that must occur for a clip
indication to appear. Setting the number of samples to “0”” disables the alarm.

Specifies the number of consecutive “0” samples that must occur for a mute
indication to appear. Setting the number of samples to “0” disables the alarm.

Sets the audio level below which the signal is considered silent. This value is
used to trigger an on-screen indicator and alarms.

Specifies how long the audio level must be below the Silence Level before an
alarm is triggered. Setting the duration to “0” seconds disables the alarm.

Specifies the audio level above which the signal is considered “over”. This
setting is used to trigger on-screen indicators and alarms.

Specifies how long the audio level must be above the Over Level before an alarm
will be triggered.

Specifies the length of time the in-bar error messages are displayed after the error
has been removed.

WVR610A & WVR611A Waveform Rasterizers User Manual 2-59



Changing Instrument Settings

Ignore Validity Bit

Correlation Meter Speed

Lissajous AGC

Audio Inputs/Outputs

2-60

Determines how the waveform rasterizer reacts to a high (value 1) validity bit in
the input data. In AES3-1992 digital audio, a high validity bit indicates that the
sample word is not suitable for conversion to audio. When this setting is set to
the factory default of Off, the waveform rasterizer will ignore any sample
accompanied by a high validity bit, display a “V BIT” flag on the meter display
and report invalid samples on the session report. When set to On, invalid sample
reporting will be turned Off, and the waveform rasterizer will treat all samples as
valid.

Determines how quickly the meter reacts to changes in phase relationship. The
meter reading is actually an average of correlation over time and this setting
determines how many samples are used to calculate the average. Lower settings
result in a faster meter response. Experiment to find the setting that best fits your
needs. The default setting is 8, which is 1.5 seconds.

When On, allows the Lissajous or Phase display to change gain and keep the
display well scaled. When Off, puts the display in fixed gain mode with the Peak
Program level at the perimeter of the active area.

NOTE. The audio pop-up menu allows selection of input and allows the optional
phase display to be added to the audio tile.

There are three CONFIG submenus for audio: Analog Audio Displays, Digital
Audio Displays, and Audio Inputs / Outputs. Audio Inputs/Outputs controls
which audio input is active. Audio inputs and outputs must be configured before
they can be used. Analog Audio Displays and Digital Audio Displays control
general audio configuration settings for parameters such as meter ballistics. See
Analog Audio Displays Settings on page 2-52 and Digital Audio Displays
Settings on page 2-56.

Control of which audio input is active is located in the AUDIO pop-up menu.

To set up audio inputs/outputs, first each input group should be configured. Then
if desired, a “Video to Audio Map” can be defined so that as you change video
inputs the audio source you want will be selected automatically. Finally, any
desired “Analog Audio Out Mapping” can be configured.

For units with digital audio capability, there are four AES pair inputs in the “A”
bank and four in the “B” bank. Four pairs of audio signals can also be extracted
(de-embedded) from the active serial video input. The “B” input bank can be
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configured as an output for the extracted audio. When in this mode the B input
bank is not available as an input source.

For units with analog audio capability, there are six balanced inputs in the “A”
bank and six in the “B” bank. There are also six balanced outputs.

Units that have both analog and digital capability can convert AES or embedded

inputs to analog and route to the six balanced outputs.

Audio Inputs/Outputs  Table 2-22 lists the configuration options for the audio inputs and outputs.

Parameters

Table 2-22: Audio Inputs and Outputs

Input First choice Second choice
AES A Bar Format Pairs [ Surround
Input to Bar Map
Analog Out Map
AES B Config Port As Input / Output
Bar Format Pairs [ Surround
Input to Bar Map
Analog Out Map
Analog A Bar Format Pairs [ Surround
Input to Bar Map
Analog Out Map
Analog B Bar Format Pairs [ Surround
Input to Bar Map
Analog Out Map
Embedded A Bar Format Pairs [ Surround
Input to Bar Map
Analog Out Map
Embedded B Bar Format Pairs [ Surround
Input to Bar Map
Analog Out Map
Video to Audio Mapping SDIA AES A /AES B/ Analog A /
Analog B / Embedded / None
SDIB AES A /AES B | Analog A |
Analog B / Embedded / None
Cmpst A AES A /AES B | Analog A /
Analog B / None
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Table 2-22: Audio Inputs and Outputs (Cont.)

Input First choice Second choice
Cmpst B AES A [AES B [ Analog A/
Analog B / None
Attenuate Audio Output Press SEL to change

AES A/B, Analog A/B,  These selections enable you to specify the parameters that affect the audio inputs.
Embedded A/B

Bar Format. Specifies the format used for the bars (level meters) in the Audio
display. When Pairs is selected, the bars are labeled with numbers, 1-8. When
Surround is selected, the bars are labeled with surround channel designators: L
(left), C (center), R (right), Ls (left-surround), Rs (right-surround), Ife (low-fre-
quency effects), Lo (Left total for stereo equivalent), and Ro (Right total for
stereo equivalent). Note that the Lo and Ro channels are inputs, they are not
derived from the other channels. See Figure 2-40.

Input to Bar Map. Enables you to map the AES pair inputs to the desired level bar
in the Audio tile. Press SEL to display the input to bar mapping window. See
Figure 2-40. Use the checkboxes (press the arrow-keys to move the selection
and press SEL to mark a checkbox) to specity which audio input source is
displayed in which bar in the Audio window. Note that the labels for the bars
change depending on the Bar Format setting. See Figure 2-40.

Input, Allow AES F; £ £ Input, Allow AES
Bar Alarm AQ £ A2 A3 Bar Alarm A0

X X

1
2
3
4
5
5]
7

<.}
B o (o] [e] oe] (] [e]| ] [2e
B <] (][] [ [oe] [oe]|[¢] [

Bar labels when Bar Format is set to Pairs Bar labels when Bar Format is set to Surround

Figure 2-40: Mapping inputs to bars
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Analog Out Map. Enables you to route audio inputs to the analog audio outputs by
specifying which level meter bar is mapped to which analog output. See
Figure 2-41.

Cutput | Analog Analog Analog
Bar Cutput 0| Output 1 Cutpuat 2

L
R
Ls
Rs
C
Lfe
Lo
Ro

X

Figure 2-41: Analog out map

Video to Audio Mapping  Associates each of the video inputs with any one of the available audio inputs.
For example, if you are select the SDI A video input, you can choose to associate
the AES A audio input with it.

Configuring Audio Inputs  To set up an audio input:
1. Press CONFIG to display the Configuration menu.
2. Select Audio Inputs/Outputs to display the submenu.

3. Select the input to be configured. See Figure 2-42.

i | Bar Format _____pSZill
AES B Pairs Bar to Input Map  Press SEL
Analog A Pairs Analog Out Map Press SEL
Analog B Pairs

Embedded A Pairs

Embedded B Pairs

Video to Audio Map SDIA /...

Attenuate Audio Output 0dB

SDI Input

Composite Input
External Ref,

Analog Audio Displays
Digital Audio Displays

Alarms

Gamut Thresholds
Display Settings
LTC / VITC
Readouts
Graticules
Network Settings
Utilities

Figure 2-42: Configuring audio inputs

WVR610A & WVR611A Waveform Rasterizers User Manual 2-63



Changing Instrument Settings

4. For the selected input, select from Surround for 5.1 or 7.1 type display or
Pairs for a stereo, plus SAP and discrete channels type installation.

S. For that input select Input Bar Map and specify which input pair should be
displayed in each bar pair. See Figure 2-43.

Input Allow AES
B Alarm | AO

X

LR I IRE S IRE JUE IR )

Figure 2-43: Bar to input mapping
6. In the input bar map selector box, you can also select which inputs will be
capable of generating alarms.

7. Finally, select the Output Map to specify which input be routed to each
analog output. See Figure 2-44.

Output| Analog | Analog  Analog
Bar Cutput 0 Outputl = Output 2

Figure 2-44: Mapping analog output

8. Repeat for other audio inputs as needed for your application.

Configure Video to Audio  To set up the mapping for Audio follows Video Mode:
Mapping . . .
1. Press CONFIG to display the Configuration menu.
2. Select Video to Audio Map to display the submenu.

3. Select a video input, then select the audio input that you want to be active
when this video input is active. See Figure 2-45.
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AES A Pairs SDI A Embedded /... |
AES B Pairs SDI B AES A /.

Analog A Pairs Cmpst A  Analog A aa
Analog B Pairs Cmpst B AnalogB /...

SDI Input

Composite Input
External Ref.

Analog Audio Displays
Digital Audioc Displays

Embedded A Pairs Embedded
Embedded B Paira

Atte e / io O
Alarms Attenuate Audio Output 0 dE

Gamut Thresholds
Display Settings
LTC / VITC
Readouts
Graticules
Network Settings
Utilities

Figure 2- 45: Video to audio mapping

4. Repeat for the other video inputs as needed for your application.

Attenuate Audio Output  The Attenuate Audio Output function enables you to attenuate the audio output
signal from 0-120 dB. This function is useful if you are connecting unbalanced
audio outputs to balanced inputs or you need to adjust the signal level (volume)
of the output signal.

CAUTION. Output Attenuation is necessary when the input audio is abnormally

A high (that is, greater than -10 dBFS on average or the RMS level exceeds
+14dBu). Exceeding these levels for lengthy periods could result in damage to
the instrument. Please refer to Specifications, Table A-25 on page A-20 for
further details.

Setting Up AESB  The AES B connectors can be configured as inputs or outputs. When configured
Connectors as Outputs  as outputs, the only signal that can be the source to output is the audio that has
been de-embedded from the SDI input. The de-embedding is always done from
the active input, so if you switch SDI inputs, the audio source will change, and if
select a composite input, then the AES B outputs will go silent.

The AES B outputs follow the currently active de-embedded channels as
displayed in the audio level bars. So if bar pairs 1,2 and 3,4 are the only ones
active, then AES B connectors 1,2 and 3,4 will be the only pairs active as well.

Only one BNC may source the audio from a given de-embedded channel. If the
same de-embedded channel is displayed on multiple bar pairs, then only the
BNC corresponding to the lowest numbered bar pair will be active.

To set up the AES B connectors as outputs:

1. Press CONFIG to display the Configuration menu.
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Select Audio Inputs/Outputs.
Select AES B from the submenu.

Select Config Port As:.

2.
3.
4.
5.

SDI Input

Press SEL to select Output. See Figure 2-46.

AES A Pairs | Config Port as: P Output

Analog A Pairs
Analog B Pairs
Embedded A Pairs
Embedded B Pairs
Video to Audio Map SDIA /...
Attenuate Audio Output 0dB

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Displays

Alarms

Gamut Thresholds
Display Settings
LTC f VITC
Readouts
Graticules
Network Settings
Utilities

Figure 2-46: Configuring AES B as an output

6. Press CONFIG to remove the Configuration menu.

NOTE. If AES B will be used as an output, do not bother to set it up as an input
and do not select it in the Audio follows Video mode.

If AES B is used to output de-embedded audio, the first BNC will have the signal
displayed in the first pair of bars. The second BNC will have the signal
displayed in the second set of bars and so on. This mapping is not configurable.

Gamut Thresholds Menu

2-66

The Gamut Thresholds menu enables you to specify the signal levels at which
errors and alarms are triggered. See Table 2-23.

To change the Gamut Threshold settings:
1. Press CONFIG until the menu appears.

2. Use the GENERAL knob or the up/down arrow keys to select Gamut
Thresholds.

3. Use the navigation keys to change the menu focus to the Gamut Thresholds
submenu.
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4. Select the desired setting and change the setting as needed.

5. After changing the setting, press CONFIG to remove the Configuration

menu.

Table 2-23: Gamut thresholds

Setting Choices / Range

Diamond High Range: 630 mV - 756 mV
Default: 721 mV

Diamond Low Range: -50 mV - +35 mV

Default: -21 mV

Diamond Area

Range: 0 - 10%
Default: 1%

Reset Diamond Defaults

Press SEL to reset

Arrowhead NTSC Min Range: -50 - -10 IRE
Default: -24 IRE

Arrowhead NTSC Max Range: 90 - 135 IRE
Default: 120 IRE

Arrowhead PAL Min Range: -400 mV - -100 mV
Default: -230 mV

Arrowhead PAL Max Range: 630 mV - 950 mV

Default: 930 mV

Arrowhead Area

Range: 0 - 10%
Default: 1%

Reset Arrowhead NTSC Defaults

Press SEL to reset

Reset Arrowhead PAL Defaults

Press SEL to reset

Luma Min

Range: -6 - +5%
Default: -3%

Luma Max Range: 90 - 108%
Default: 103%
Luma Area Range: 0 - 10%

Default: 1%

Reset Luma Defaults

Press SEL to reset

Reset to EBU-R103 Defaults

Press SEL to reset
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Diamond High

Diamond Low

Diamond Area

Reset Diamond Defaults

Arrowhead NTSC Min

Arrowhead NTSC Max

Arrowhead PAL Min

Arrowhead PAL Max

Arrowhead Area

Reset Arrowhead
NTSC Defaults

Reset Arrowhead
PAL Defaults

Luma Min

Luma Max

Luma Area

2-68

Sets the level above which RGB components are considered too large and out of
gamut.

Specifies that signals below this level on a Diamond display will trigger an
error/alarm.

Specifies the percentage of the total image pixels (up to 10%) that can be outside
the current gamut limits, yet not be reported as a gamut error.

Resets the gamut thresholds for Diamond displays to the factory default.

Specifies that signals below this level on an Arrowhead NTSC display will
trigger an error or alarm.

Specifies that signals above this level on an Arrowhead NTSC display will
trigger an error or alarm.

Specifies that signals below this level on an Arrowhead PAL display will trigger
an error or alarm.

Specifies that signals above this level on an Arrowhead PAL display will trigger
an error or alarm.

Specifies the percentage of the total image pixels (up to 10%) that can be outside
the current gamut limits, yet not be reported as a gamut error.

Resets level to factory default for Arrowhead NTSC display.

Resets level to factory default for Arrowhead PAL display.

Specifies that signals below this level on an Arrowhead display will trigger an
error or alarm.

Specifies that signals above this level on an Arrowhead display will trigger an
error or alarm.

Specifies the percentage of the total image pixels (up to 10%) that can be outside
the current Luma limits, yet not be reported as a Luma error.
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Reset Luma Defaults

Reset to EBU-R103
Defaults

Display Settings Menu

Resets level to factory default.

Resets the Gamut and Luma Limit thresholds to the values recommended in the

EBU R103-2000 specification.

Table 2-24: EBU-R103 recommended limits for Gamut and Luma

Threshold Recommended setting
Diamond High 735 mV (105%)
Diamond Low -35mV (-5%)

Diamond Area 1%

Luma Min -1%

Luma Max 103%

Luma Area 1%

The Display Settings menu allows you to specify various display colors,
intensities, and modes for the VGA display. See Table 2-25.

To change the Display Settings:

1. Press CONFIG to display the Configuration menu.

2. Use the GENERAL knob or the up/down arrow keys to select Display

Settings.

3. Use the right-arrow key to change the menu focus to the submenu.

4. Select the desired setting and change the setting as needed.

5. After changing the setting, press CONFIG to remove the Configuration

menu.

Table 2- 25: Display settings

Setting Choices / Range
Readout Intensity 0 - 100%
Default: 50%
Readout Color Gold / Blue / Red
Waveform Intensity -50 - +50
Default: 0
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Readout Intensity

Readout Color

Waveform Intensity

Waveform Color

Graticule Intensity

Graticule Color

Picture Brightness

Picture Refresh Mode

Table 2- 25: Display settings (Cont.)

Setting Choices / Range

Waveform Color White [ Green

Graticule Intensity 0 - 100%
Default: 50%

Graticule Color Gold / Blue / Red

Picture Brightness 20 - 100%

Picture Refresh Mode Interlace / CRT / LCD

VGA Output 0-1.0v/0-0.7v

Picture Brightup on RGB Gamut Error On / Off

Picture Brightup on Cmpst Gamut Error On / Off

Picture Brightup on Luma Gamut Error On / Off

Panel Backlight On / Off

Panel Backlight Intensity 1-10

Sets the display intensity of on-screen readouts.

Sets the color of the on-screen readouts.

Sets the display intensity of the waveform. You can set this to higher values to
better see low incidence signals, but it may saturate more frequent signals.

Sets the color of the waveform. When set to green, you can see a wider range of
signals since high incidence signals will be displayed in white while most signals
will be displayed in green.

Sets the display intensity of the graticule.

Sets the color of the graticule.

Sets the brightness of the picture display.

The Picture Refresh Mode allows you to optimize the picture mode display for
different types of monitors and applications. The three possible values for this
configuration item are:
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Interlace. Interlace mode runs the picture very close to how it would run on a
standard video monitor. Each field is displayed for that field’s normal time. This
is useful if you want to see the picture with a minimum of processing.

CRT. CRT mode holds the previous field at reduced intensity to make the picture
be more uniform and brighter. While this introduces minor motion artifacts it
greatly reduces flicker.

LCD. LCD mode holds all of the previous field along with the current field. This
introduces some motion artifacts but is necessary to prevent problems on most
LCD monitors and projectors. This mode also increases the brightness signifi-
cantly.

The default mode is CRT. If you change to other modes, you may need to adjust
the Picture Brightness configuration parameter to optimize the image.

VGA Output  Sets the voltage output level for the VGA display.

Picture Brightup on RGB  Specifies whether or not the picture display shows a cross-hatch pattern on areas
Gamut Error  of the picture where RGB gamut errors occur.

Picture Brightup on  Specifies whether or not the picture display shows a cross-hatch pattern on areas
Cmpst Gamut Error  of the picture where composite gamut errors occur.

Picture Brightup on Specifies whether or not the picture display shows a cross-hatch pattern on areas
Luma Gamut Error  of the picture where luma gamut errors occur.

NOTE. The gamut bright-ups on the picture may be difficult to see on signals
with luminance in the mid range. An example of such a case is the cyan bar in a
75% color bar signal. This does not happen often at normal gamut threshold
values. The gamut errors reported on screen and in the log will not be affected
and will report errors in all signals accurately.

Panel Backlight  The Panel Backlight setting enables you to illuminate the front-panel buttons that
are not selected (the illumination setting for selected buttons cannot be changed).
There are two controls for the front-panel backlight. One control turns the
backlight on and off (Panel Backlight) and the other control sets the intensity or
brightness of the backlight (Panel Backlight Intensity).
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Panel Backlight Intensity

Freeze Affects

LTC / VITC Menu

Readouts Menu

2-72

Sets the intensity of the front-panel button backlight. This feature is especially
useful in low-light situations so you can see buttons that are not selected.

Specifies the scope of the Freeze operation. If All Tiles is selected, pressing
FREEZE captures an image in all the tiles simultaneously. If Active Tile is
selected, pressing FREEZE captures an image only in the active tile.

The LTC / VITC menu enables you to specify which time code is used for
logging and whether or not it is displayed in the Status Bar. See Table 2-26.

Table 2-26: LTC / VITC settings

Setting Description Choices [ Range

Display if Present Specifies which time code is | VITC / LTC / Off
used for logging and displayed
in the Status bar readout

The Readouts menu enables you to turn various display readouts on or off. See
Table 2-27.

To change the Readouts settings:

1. Press and hold the CONFIG button until the menu appears.

Use the GENERAL knob or the up/down arrow keys to select Readouts.
Use the navigation keys to change the menu focus to the Readouts submenu.

Select the desired setting and change the setting as needed.

A

After changing the setting, press CONFIG to remove the Configuration
menu.

Table 2-27: Readouts settings

Setting Choices / Range
Waveform On/ Off
Vector On/ Off
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Waveform

Vector
Picture

Gamut

Graticules Menu

SDI Vector 1/Q Axis

Cmpst Waveform
Graticule Units

Picture Line Select Cursor
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Table 2-27: Readouts settings (Cont.)

Setting Choices /| Range
Picture On/ Off
Gamut On/ Off

Specifies whether or not the graticules and text are visible in the Waveform
display.

Specifies whether or not text readouts appear in the Vector display.

Specifies whether or not text readouts appear in the Picture display.

Specifies whether or not graticules and text readouts appear in the Gamut
display.

The Graticules submenu enables you to specify the graticule display style
associated with different displays based on the input signal. See Table 2-28.

Table 2-28: Graticule settings

Setting Choices / Range
SDI Vector 1/Q Axis On / Off

Cmpst Waveform Graticule Units Auto / mV
Picture Line Select Cursor On /[ Off

Field Sweep Line Select Cursor On/ Off

Turns the display of the I/Q axis in the Vector display on or off for SDI input
signals.

Sets the Waveform display graticule units for Composite input signals.

Displays a cursor in the PICTURE display that tracks the selected line when any
tile has LINE SEL mode turned on. This feature enables you to see which line in
the picture is displayed in the tile in LINE SEL mode.
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Field Sweep Line Select

Cursor

Displays a cursor in a field or 2-field WFM display that tracks the selected line
in another display which has LINE SEL mode turned on. Thus enabling you to
see which line in the field is displayed in the tile in LINE SEL mode.

Network Settings Menu

2-74

IP Config Mode

This menu allows you to set IP addresses and change what methods of network

control are active.

Table 2-29: Network settings

Setting Choices / Range

IP Config Mode Manual / DHCP

IP Address XXX XXX XXX XXX

Subnet Mask XXX XXX XXX XXX

Gateway Address XXX XXX XXX XXX

View MAC Address XXEXXEXXEXXEXXEXX

Instrument Name 15-character alphanumeric string
SNMP Enable Off / On

SNMP Public Community 15-character alphanumeric string
SNMP Private Community 15-character alphanumeric string
SNMP Trap Enable Off / On

SNMP Trap Address 1 XXX XXX XXX XXX

SNMP Trap Address 2 XXX XXX XXX. XXX

SNMP Trap Address 3 XXX XXX. XXX. XXX

SNMP Trap Address 4 XXX XXX XXX XXX

Web Enable Off / On

Web Password

15-character alphanumeric string

Specifies how the WVR610A & WVR611A network address is determined.
Network addresses can be assigned either automatically or manually. If your
network uses DHCP (Dynamic Host Configuration Protocol) to assign addresses,
then the address will be assigned dynamically to the WVR610A & WVR611A.
If your network does not use DHCP, you will have to manually enter the address
for the WVR610A & WVR611A. To get an address, talk to your LAN adminis-

trator.

To set the IP Config Mode:

1. Press CONFIG to display the Configuration menu.
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AN Y

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Select IP Config Mode.
Press SEL to set the mode to Manual or DHCP as required.
If the IP Config Mode is set to Manual, set the I[P Address.

Press CONFIG to remove the Configuration menu.

IP Address  The IP (Internet Protocol) address is the network address of the WVR610A &
WVRG611A. If you plan to use your WVR610A & WVR611A on a network (for
example, for using the web interface), you may need to set this address depend-
ing on how your network assigns addresses. If your network does not use
automatic address allocation (DHCP), you will need to set this address. To get an
address, talk to your LAN administrator.

To set the IP Address:

1.
2.

SDI Input

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Displays
Audie Inputs/Outputs
Alarms

Gamut Thresholds
Display Settings

LTC / VITC

Readouts

Graticules

Press CONFIG to display the Configuration menu.

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Verity the IP Config Mode is set to Manual.

Select IP Address and press the right-arrow key to change the menu focus to
the submenu. See Figure 2-47.

IP Config Mode Manual

{IP Address 128181220189 )|
Subnet Mask .2 0
Gateway Address
View MAC Address
Instrument Name Tek WVRG11A
SNMP Enable Off
SNMP Public Community SNMP Tektronix
SNMP Private Community  SNMP Tektrenix
SNMP Trap Enable Off
SNMP Trap Address 1 000.000.000.001
SNMP Trap Address 2 000.000.000.002
SNMP Trap Address 3 000.000.000.003
SNMP Trap Address 4 000.000.000.004
Web Enable Off

Utilities

Figure 2-47: Setting IP address

S.

Use the left/right arrow keys to move the highlight to each box in the
address. Use the up/down arrow keys to change the number in each box as
required.
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6. Work your way through each box in the address, setting the number as
required.

7. To accept your changes, move the highlight to the Accept box and press
SEL.

8. If you wish to cancel the changes you have made, move the highlight to the
Cancel box and press SEL.

Subnet Mask  The Subnet Mask is part of the network address of the WVR610A & WVR611A.
If you plan to use your WVR610A & WVR611A on a network (for example, for
using the web interface), you may need to set this parameter depending on how
your network assigns addresses. If your network does not use automatic address
allocation (DHCP), you will need to set this parameter. To get the correct subnet
mask, talk to your LAN administrator.

To set the Subnet Mask:
1. Press CONFIG to display the Configuration menu.

2. Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

3. Verity the IP Config Mode is set to Manual.

4. Select Subnet Mask and press the right-arrow key to change the menu focus
to the submenu.

S. To change the Subnet Mask, select the Change box using the left/right arrow
keys. Once Change is selected, use the up/down arrow keys to scroll
through the list of available masks. See Figure 2-48.

IP Config Mode Manual / DHCP

£ e 2 22|
SDI Input IP Address 128.181.220.189

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Diaplays
Audio Inputs/Outputs
Alarms

Gamut Thresholds
Display Settings

LTC / VITC

Readouts

Graticules

Gateway Address

View MAC Addreas

Instrument Name

SNMP Enable Off / On

SNMP Public Community SNMP Tektronix
SNMP Private Community SNMP Tektronix
SNMP Trap Enable Off / On

SNMP Trap Address 1 000.000.000.001

SNMP Trap Address 2 000.000.000.002
SNMP Trap Address 3 000.000.000.003

- w | SNMP Trap Address 4 000.000.000.004
T Web Enable Off / On

Utilities

Figure 2-48: Setting subnet mask

6. After you have selected the correct Subnet Mask, use the right-arrow key to
select Accept. Once Accept is highlighted, press SEL to accept the change.
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7. If you decide not the change the Subnet Mask, move the highlight to the
Cancel box and press SEL.

Gateway Address  The Gateway Address is the network address of a node that serves as an entrance
to another network. To find out what the Gateway address is for your network,
talk to your LAN administrator.

To set the Gateway Address:
1. Press CONFIG to display the Configuration menu.

2. Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

3. Select Gateway Address and press the right-arrow key to change the menu
focus to the submenu.

4. Use the left/right arrow keys to move the highlight to each box in the
address. Use the up/down arrow keys to change the number in each box as
required.

5. Work your way through each box in the address, setting the number as
required.

6. To accept your changes, move the highlight to the Accept box and press
SEL.

7. If you wish to cancel the changes you have made, move the highlight to the
Cancel box and press SEL.

View MAC Address  The View MAC Address parameter allows you to see the MAC (Media Access
Control) address assigned to the instrument. This is a unique address used to
identify the instrument.

To view the MAC address:
1. Press CONFIG to display the Configuration menu.

2. Select Network Settings and press the right-arrow to change the menu focus
to the submenu.

3. Read the MAC address at the right of View MAC Address.

Instrument Name  The WVR610A & WVRG611A allows you to name the instrument for identifica-
tion across a network. The instrument name is a 15-character string made up of
alphanumeric text. The available characters are 0-9, a-z, A-Z, -, _, and blank.

To change the instrument name:
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SNMP Enable
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External Ref.

Analog Audio Displays
Digital Audic Displays
Audio Inputs/Cutputs

Alarms

Gamut Thresholds
Display Settings
LTC / VITC
Readouts
Graticules

Press CONFIG to display the Configuration menu.

Select Utilities and press the right-arrow key to change the menu focus to the
submenu.

Select Instrument Name and press the right-arrow key to change the menu
focus to the submenu.

Use the left/right arrow keys to move the highlight to each box. Use the
up/down arrow keys to change the character in each box as required. Press
SEL to toggle between uppercase and lowercase characters.

IP Config Mode
1P Address

Manual
128.181.220.189

SDI Input -

Subnet Mask

Composite Input S| | | -

Gateway Address

View MAC Address 06:05:04:03:02:01
| Instrument Name ________Tck WVRGLIA )]

SNMP Enable Off

SNMP Public Community SNMP Tektronix

SNMP Private Community SNMP Tektronix

SNMP Trap Enable Off

SNMF Trap Address 1 000.000.000.001

SNMP Trap Address 2 000.000.000.002

SNMP Trap Address 3 000.000.000.003

SNMP Trap Address 4 000.000.000.004

Web Enable Off

lower

Utilities

Figure 2-49: Setting the instrument name

To accept the name you have entered, move the highlight to the Accept box
and press SEL.

If you wish to cancel the changes you have made, move the highlight to the
Cancel box and press SEL.

This setting enables you to allow or deny remote control access to the waveform
rasterizer over a network. You can still access the waveform rasterizer using the
Web Interface when SNMP Enable is Off, but you will not be able to view or
change instrument settings using SNMP management software.

To set the SNMP Enable mode:

1.
2.

Press CONFIG to display the Configuration menu.

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Select SNMP Enable.

Press SEL to change the setting.
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SNMP Public Community

5. After changing the setting, press CONFIG to remove the Configuration
menu.

This setting specifies the string that SNMP commands must include to have
read-only access. The default public community string is “public”. If you enter a
new string, the waveform rasterizer will strip any leading or trailing spaces in the
string: for example, “ my stuff ” will become “my stuff”. The public community
string cannot be blank. If you input a blank string, the instrument will set it to
the default string.

To set the SNMP Public Community string:
1. Press CONFIG to display the Configuration menu.

2. Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

3. Select SNMP Public Community and press the right-arrow key to change
the menu focus to the submenu.

4. Use the left/right arrow keys to move the highlight to each box. Use the
up/down arrow keys to change the character in each box as required. Press
SEL to toggle between uppercase and lowercase characters.

IP Config Mode Manual
IP Address 128.181.220.189 .
Subnet Mask 255.255.128.000 SINIMP| [T e|k|t]|r]o|n]i]x
Gateway Address 128, 0
View MAC Address 06:05:04:03:02:01
Instrument Name Tek WVRB11A /lower
Audio Inputs/Cutputs ELINY el (eris
oy i | SNMP Public Community __SNMP Tektronix }|
y 5 SNMP Private Community SNMP Tektironix
Gamut Thresholds ~ i
Display Settings SNMP Trap Enable Off
LTC / VITC SNMP Trap Address 1 000.000.000.001
Readz)uts i SNMP Trap Address 2 000.000.000.002
Graticules SNMP Trap Address 3 000.000.000.003
SNMP Trap Address 4 000.000.000.004
Web Enable Off

SDI Input

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Displays

Utilities

Figure 2-50: Setting the SNMP public community string
5. To accept the name you have entered, move the highlight to the Accept box
and press SEL.

6. If you wish to cancel the changes you have made, move the highlight to the
Cancel box and press SEL.

7. After changing the setting, press CONFIG to remove the Configuration
menu.
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SNMP Private Community
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This setting specifies the string that SNMP commands must include to have
read/write access. The default private community string is “private”. If you enter
a new string, the waveform rasterizer will strip any leading or trailing spaces in

the string: for example, ¢

<

my stuff ” will become “my stuff”. The private

community string cannot be blank. If you input a blank string, the instrument
will set it to the default string.

To set the SNMP Private Community string:

1.
2.

SDI Input

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Displays
Audio Inputs /Outputs
Alarms

Gamut Thresholds
Display Settings

LTC / VITC

Readouts

Graticules

Press CONFIG to display the Configuration menu.

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Select SNMP Private Community and press the right-arrow key to change
the menu focus to the submenu.

Use the left/right arrow keys to move the highlight to each box. Use the
up/down arrow keys to change the character in each box as required. Press
SEL to toggle between uppercase and lowercase characters.

IP Config Mode
IP Addreas
Subnet Mask
Gateway Address
View MAC Address
Instrument Name
SNMP Enable Off
SNMP Public Community SNMP Tektronix

| SNMP Private Community _SNMP Tekironix P
SNMP Trap Enable Off
SNMP Trap Address 1
SNMP Trap Address 2 000.000.000.002
SNMP Trap Address 3 000.000.000.003
SNMP Trap Address 4 000.000.000.004
Web Enable Off

Manual
128.181.220.189

[s][N|[M[P

T|e|k|t]r]o]n]illx

/lower

000.000.000.001

Utilities

Figure 2-51: Setting the SNMP private community string

To accept the name you have entered, move the highlight to the Accept box
and press SEL.

If you wish to cancel the changes you have made, move the highlight to the
Cancel box and press SEL.

After changing the setting, press CONFIG to remove the Configuration
menu.
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SNMP Trap Enable

This setting allows you to turn on or off the capability of the waveform rasterizer

to generate SNMP traps.

To set the SNMP Trap Enable mode:

1.
2.

SNMP Trap Address 1-4

Press CONFIG to display the Configuration menu.

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Select SNMP Trap Enable.
Press SEL to change the setting.

After changing the setting, press CONFIG to remove the Configuration
menu.

This setting allows you to set IP addresses to which SNMP traps are sent.

To set the SNMP Trap Addresses:

1.
2.

SDI Input

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Displays
Audio Inputs/Outputs
Alarms

Gamut Thresholds
Display Settings

LTC / VITC

Readouts

Graticules

Press CONFIG to display the Configuration menu.

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Select the desired SNMP Trap Address (1 through 4) and press the
right-arrow key to change the menu focus to the submenu.

Use the left/right arrow keys to move the highlight to each box. Use the
up/down arrow keys to change the number in each box as required. See
Figure 2-52.

IP Config Mode

IP Address

Subnet Mask
Gateway Address
View MAC Address
Instrument Name

Manual
128.181.220.189
255.255.128.000
128.181.111.270
06:05:04:03:02:01
Tek WVRGI1A

SNMP Enable Off
SNMP Public Community

SNMP Tektronix

SNMP Private Community SNMP Tektronix
SNMP Trap Enable Off

| SNMP Trap Address 1 _____128181.220.001 )]
SNMP Trap Address 2 000.000.000.002
SNMP Trap Address 3 000.000.000.003
SNMP Trap Address 4 000.000.000.004
Web Enable Off

Utilities

Figure 2-52: Setting the SNMP trap address

5.
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To accept the address you have entered, move the highlight to the Accept
box and press SEL.
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6.

7.

If you wish to cancel the changes you have made, move the highlight to the
Cancel box and press SEL.

After setting the address, press CONFIG to remove the Configuration menu.

NOTE. To disable a trap address, set the first three digits of the trap address to 0.

Web Enable  This setting allows you to allow or deny web browser access to the waveform
rasterizer.

To set the Web Enable setting:

1.
2.

Utilities Menu

Press CONFIG to display the Configuration menu.

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Select Web Enable.
Press SEL to change the setting.

After changing the setting, press CONFIG to remove the Configuration
menu.

The Utilities submenu provides settings for several non-measurement related
waveform rasterizer parameters. See Table 2-30.

To change the Utilities settings:

1.

SO
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Press and hold the CONFIG button until the menu appears.

Use the GENERAL knob or the up/down arrow keys to select Utility.
Use the navigation keys to change the menu focus to the Utility submenu.
Select the desired setting and change the setting as needed.

After changing the setting, press CONFIG to remove the Configuration
menu.
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Table 2- 30: Utilities settings

Setting Choices /| Range

View HW / SW Version View Only

Set Clock Time : Date

CPU Color Palette View Only

System Upgrade Press SEL

Calibration Press SEL to Start

Run Power Up Diags Press SEL

Run Advanced Diags Press SEL

View Diagnostic Log Press SEL

Diag Log Mode Circular / Stop when full

View HW/SW Version

subsystems.

This settings lists the version number for several hardware and software

To view the list of hardware and software versions:

1. Press CONFIG to display the Configuration menu.

2. Select Utilities and press the right-arrow to change the menu focus to the

submenu.

3. Select View HW/SW Version. The version numbers will appear in the
submenu listing to the right. See Figure 2-53.

SDI Input

Composite Input
External Ref.

Analog Audio Displays

Digital Audio Displays
Audio Inputs/Outputs

Alarms

Gamut Thresholds
Display Settings
LTC / VITC
Readouts
Graticules
Network Settings

| View HW/SW Version __ Tektronix WVRGLL ________ )’
Set Clock Thu Jun 26 14:54:56
CPU Color Palette Check  Press SEL
System Upgrade Press SEL
Press SEL to Start
Press SEL
Press SEL
Press SEL
Circular
Analog, AES, & Embedded /...
SDI + Cmpst

Run Power Up Diags

View Diagnostic Log
Diag Log Mode
Audio Options
Video Option

Figure 2-53: Viewing hw/sw version numbers

Set Clock

To set the clock:

This setting allows you to set the real-time clock in the waveform rasterizer.

1. Press CONFIG to display the Configuration menu.
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CPU Color Palette Check

2-84

2. Select Utilities and press the right-arrow key to change the menu focus to the
submenu.

3. Select Set Clock and press the right-arrow key to change the menu focus to
the submenu.

4. Use the left/right arrow keys to move the highlight to each box in the time
and date fields. Use the up/down arrow keys to change the value in each box
as required.

View HW /SW Version Tektronix WVRG11
[ Set Clock ______________Thu Jun 26145739}
CPU Color Palette Check  Press SEL : HE JUN |[26 | [2003
System Upgrade Press SEL
Press SEL to Start
Run Power Up Diags Press SEL
Press SEL

SDI Input

Composite Input
External Ref.

Analog Audio Displays
Digital Audio Displays
Audio Inputs/Outputs
Alarms

Gamut Thresholds
Display Settings

LTC / VITC

Readouts

Graticules

Network Settings

View Diagnostic Log Press SEL

Diag Log Mode Circular

Audio Options Analog, AES, & Embedded / ...
Video Option SDI + Cmpst

Figure 2-54: Setting the internal clock

5. Work your way through each box in the time and date fields, setting the
value as required.

6. To accept your changes, move the highlight to the Accept box and press
SEL.

7. If you wish to cancel the changes you have made, move the highlight to the
Cancel box and press SEL.

This setting in the Config menu enables a service technician to easily verify that
the display color circuitry is operating correctly.

To display the CPU Color Palette:
1. Press CONFIG to display the Config menu.

2. Select Utilities and press the right-arrow key to change the menu focus to the
submenu.

3. Select CPU Color Palette Check.
4. Press SEL to display the color palette. See Figure 2-55.

5. Press CONFIG to remove the Config menu.
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View HW/SW Version Tektronix WVRE11 e

Set Clock Thu Jun 26 15:00:08
Color 02
SDI Input CPU Color Palette Check pRSTeRil Tt

Composite Input System Upgrade Press SEL . Color04
External Ref. -

x X Press SEL to Start Color 05
Analog Audio Displays Run Power Up Diags Press SEL Color 06
Digital Audio Displays =

; - Pt Press SEL Color 07
Sl oo pul AU ET LS View Diagnostic Log Press SEL Color 08

Alarms Diag Log Mode Circular [ Color 09 |

g.amlut,??::."h"lds Audio Options Analog, AES, & Embedded / . .. Color 10
isplay Settings Video Option SDI + Cmpst Color 11
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Figure 2-55: CPU color palette

System Upgrade  The System Upgrade selection is used to upgrade the system software of the
WVR610A & WVR611A. The upgrade is performed access an Ethernet network
using a PC to transfer the new software to the WVR610A & WVRG611A. For the
procedure to upgrade the system firmware, refer to Upgrading the Waveform
Rasterizer Firmware on page D-1.

Calibration  This menu selection is used during the Performance Verification and adjustment
process. You must use the correct, properly calibrated equipment to achieve
specified performance characteristics. Refer to the Composite Analog Vertical
Measurement Accuracy (WVR611A only), Composite Analog Frequency
Response (WVR611A only), Composite Analog Input DC Offset Restore Off
(WVRG611A only), and Analog Audio Level Meter Accuracy Over Frequency
(Options AN and DA only) procedures in Performance Verification for the
adjustment procedures.

Run Power Up Diags  The waveform rasterizer provides diagnostic routines that you can run if you
believe your instrument is not behaving correctly. You can run two levels of
diagnostics. The Power Up Diags are the diagnostic routines that are run when
power is applied to the waveform rasterizer. The Advanced Diags is a more
thorough set of diagnostics that you can run if the waveform rasterizer passes the
Power Up Diags but you believe there is still a problem with the waveform
rasterizer.

To run the power-up diagnostics:
1. Press CONFIG to display the Configuration menu.

2. Select Utilities and press the right-arrow to change the menu focus to the
submenu.

3. Select Run Power Up Diags. Press SEL to display the Power-up Diagnos-
tics screen.
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4. To run the diagnostics, use the right-arrow key to select Run Diagnostics.
Press SEL to start. See Figure 2-56.

NOTE. False alarm error entries may be recorded in the log file while running
diagnostics. Examine the log time stamps to see which errors are not significant,
or clear the log files after running diagnostics.

Additional Information

S L : ID: WVRG10A 19
Tektronix Audio Input:

ut
Ref: Internal

Figure 2-56: Power-up diagnostics passed

S. To exit the Power-up Diagnostics screen, use the right-arrow key to select
Exit and press SEL.

If your waveform rasterizer does not pass the power-up diagnostics, see the
WVR610A & WVR611A Waveform Rasterizers Service Manual for information
on troubleshooting. If you wish to return the waveform rasterizer to Tektronix for
servicing, see page xvii for information on how to contact Tektronix.

Run Advanced Diags  If your waveform rasterizer passes the power-up diagnostics but you still feel it
may not be operating propetly, you can run the Advanced Diagnostics. Note that
the waveform rasterizer must be rebooted to run the Advanced Diagnostics.

To run the Advanced Diagnostics:

1. Press CONFIG to display the Configuration menu.
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2. Select Utilities and press the right-arrow to change the menu focus to the
submenu.

3. Select Run Advanced Diags. Press SEL to begin the Advanced Diagnos-
tics. This displays the screen show in Figure 2-57.

Advanced Diagnostics

Running the Advanced Diagnostics requires the instrument to be rebooted.

If you decide to continue, the instrument will reboot and run the diagnostics.

B Cancel Continue

Figure 2-57: Advanced diagnostics dialog box

4. To continue with the Advanced Diagnostics, use the right-arrow key to select
Continue and press SEL.

After the Advanced Diagnostics have been completed, you will see a screen that
lists a series of tests and other values. The display will indicate that the tests
either Passed or Failed.

NOTE. False alarm error entries may be recorded in the log file while running
diagnostics. Examine the log time stamps to see which errors are not significant,
or clear the log files after running diagnostics.

If the waveform rasterizer does not pass the Advanced Diagnostics, see the
WVR610A & WVR611A Waveform Rasterizers Service Manual for information
on troubleshooting. If you wish to return the waveform rasterizer to Tektronix for
servicing, see page xvii for information on how to contact Tektronix.

Viewing the Diagnostic  You can display the results of previous diagnostics runs if they have been saved.
Lo
9 To display the diagnostic log:
1. Press CONFIG to display the Configuration menu.

2. Select Utilities and press the right-arrow to change the menu focus to the
submenu.

3. Select View Diagnostic Log. Press SEL to display the log. This displays a
screen similar to Figure 2-58.
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Status Diagnostic Additional Information

WEFM_| .
WFM_FPGA_COMM
AUDIO_SELF_TEST

WED JAN 22
Tektronix

.94
SDI Input A
Ref: Internal

Figure 2-58: Diagnostics log

The Diagnostic Log can contain many pages of information depending on how
long it has been since the log was erased and how many times diagnostics have
been run.

To view different pages in the Diagnostic Log:

m  Use the right-arrow key to select the page you wish to view. Press SEL to
view the selected page.

You can view the first page, last page, previous page or the next page. The
number of pages in the diagnostics log is shown at the top-right corner of the
diagnostics log screen.

Table 2-31 describes the contents of the columns that appear in the diagnostics
log.
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Table 2- 31: Diagnostic log contents

Column heading Description
Status Either Pass or Fail.
Diagnostic The name of the diagnostic routine.

Timestamps also appear in this column to
denote when the instrument boots or when
diagnostic messages occur. The timestamp
appears before the associated events.

Additional Information Details about the diagnostic routine; entries

are:
NPass - Number of passes

NTotal - Number of times the routine was run

To erase all the entries in the Diagnostic Log:

1.

2.

Use the right-arrow key to select Erase at the bottom of the diagnostics log
screen.

Press SEL to erase the contents of the diagnostics log.

Setting the Diag Log Mode  The Diagnostics Log can contain only a limited number of entries. You can
specify how the waveform rasterizer deals with a full diagnostics log by setting
the Diag Log Mode in the Config menu. The choices for Diag Log Mode are:

Circular - When set to Circular, the diagnostics log starts overwriting the
oldest entries in the log once it is full. In Circular mode, the diagnostics log
will add entries indefinitely.

Stop when full - When set to Stop when full, the waveform rasterizer stops
adding entries to the diagnostics log when it is full.

To set the Diag Log mode:

1.

U S

Press CONFIG to display the CONFIG menu.

Select Utilities from the menu.

Press the right-arrow key to change the menu focus to the submenu.
Press Diag Log Mode from the submenu.

Press SEL to change the setting between Circular and Stop when full.

Press CONFIG to remove the menu.
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Displaying and Monitoring Video

Monitoring a Waveform

Monitoring a waveform can mean looking at voltage versus time with the
Waveform mode or it can mean looking at one of the x-y displays such as Vector
or Diamond. Monitoring a waveform can also mean to set-up alarms to trigger if
the signal exceeds certain thresholds.

To monitor a waveform with a waveform display:

1. Press a button from the MEASURE SELECT area to put the desired
measurement into the active tile. See Figure 3-1.

2. Examine the display to see if the signal exceeds any of the limits appropriate
for the given application.

SAT JAN 04 17:42:23

Tektro x

Figure 3-1: Waveform mode

WVR610A & WVR611A Waveform Rasterizers User Manual 3-1



Displaying and Monitoring Video

Checking Black Level

To monitor a waveform using alarms:

1. Configure the alarms to report if one of the available tests exceeds it limits.
(For details on configuring alarms, see Configuring Alarms and Viewing
Status on page 3-37.)

2. Configure the alarm threshold to the limits appropriate for the given
application.

Black level is the voltage at the low end of the active video range that corre-
sponds to “black” signals.

If the black level is set too high, then blacks will appear gray and washed out. If
the black level is set too low, then some low-luminance details of the image may
be lost or “crushed.” It is also important for all the components to match or the
black images will appear to have a false color. See Shading a Camera on

page 3-10.

For most video formats, the black level is at 0 volts. For NTSC, there is a
7.5 IRE setup that defines the black level. Note that for composite signals it is
acceptable for chroma components to go below black.

To check black level:
1. Put a waveform display in at least one tile.

2. [If the input signal is a composite signal, then apply a luma filter (WFM >
Filter > Luma).

3. Press and hold WFM to bring up the pop-up menu, then select Center
WFM to place the signal with zero voltage on the center graticule.

4. Press the 5X gain button if the offset is small.

5. Check the display to see if black signals are at the correct level or use
CURSORS to measure any error.

NOTE. It is possible to monitor gain on live material, but it is better to use a
known signal such as a camera alignment chart or the color bars on a tape
leader to set the gain.
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Checking Gain

The gain of a video channel sets the maximum signal voltage during active video
time. For the luminance component of the video, this is called the white level.

If the gain is set too high, then the signal might be clipped or over-drive the
subsequent stage. If the gain is set too low, then the image may appear dark and
dynamic range can be lost.

It is also important for all the components to match or the images will appear to
have a false color. See Shading a Camera on page 3-10.

To check gain:
1. Select waveform mode for the active tile.
2. If the signal is composite, then apply a luma filter (WFM > Filter > Luma).

3. Press and hold the WFM button to bring up the pop-up menu, then select
Center WFM to place the signal with zero voltage on the center graticule.

4. Compare the signal to the maximum allowed voltage. This is 700 mV for
most signals and 100 IRE for NTSC. You may want to use Cursors to
measure any error.

5. [If the error is small, you may want to move the white level down to the zero
voltage graticule then press the 5x gain button to expand the signal.

NOTE. It is possible to monitor gain on live material, but it is better to use a
known signal such as a camera alignment chart or the color bars on a tape
leader to set the gain.

Selecting a Line for Viewing

In Line Select mode, you can select one line of the video signal to display and
measure. You can use Line Select to isolate the characteristics of one portion of
the image.

Line Select modifies many of the displays in the WVR610A & WVR611A. For
example, in the Waveform display, instead of seeing a waveform that is
representative of the entire video frame, the waveform displayed will be the
video signal of a single line. The same is true of the Vector, Lightning, and
Gamut displays. Line Select stays active as you change between measurement
modes. This enables you to select a line in Picture mode, and then go to
Waveform, Vector, Diamond, or other modes and view the same line.
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525 59.94
SDI Input B
Ref: Internal

To display a specific line in a field:

1. Select the tile where you wish to display the signal.
2. Press WFM to select the Waveform display.

3. Press LINE SEL to enable line select mode.
4

Use the left-right arrow keys to select the field: F1, F2, F3, up to F8
(depending on the video standard), or All. See Figure 3-2.

5. Use the GENERAL knob or the up-down arrow keys to select the line you
wish to display.

NOTE. The line select can only be active in one tile at a time. You can change the
measurement in that tile and stay in line select. You can also see the line that is
currently selected in the picture mode or in a frame-rate waveform in another
tile (if Picture Line Select Cursor or Field Sweep Line Select Cursor is enabled).

Field indicator

SAT JAN 04 17:44:3) ID: WVRG11_2F3138
Tektronix|

Line number readout

Figure 3-2: Selecting a line for display

How Line Number is
Displayed

3-4

The line number display consists of two elements: the field indicator and the line
number. The line number can be displayed two ways depending on the field
selected for display. The field indicator can take the values F1 (field 1), F2 (field
2), F3 (field 3) F4 (field 4), and All.

NOTE. While in external reference mode, the line select function counts lines
relative to the external reference signal. This allows use of the line select
function for evaluating timing between input and reference.

For NTSC signals, when F1 is selected, the line number varies from L 1 (Line 1)
to L 262. When F2 is selected, the line number display varies from 1 (263) to
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263 (525). The number in parentheses following the line number is the line
number within the frame. Thus, 1 (263) indicates you have selected the first line
in field 2, which is the 263rd line in the frame. If F4 is selected, the line number
varies from 1 (787) to 263 (1050).

For PAL signals, when F1 is selected, the line number varies from L 1 (Line 1)
to L 313.5. When F2 is selected, the line number display varies from 313.5 to
625. The number in parentheses following the line number is the line number
within the frame. Thus, 1 (263) indicates you have selected the first line in field
2, which is the 263rd line in the frame. If F4 is selected, the line number varies
from 1 (788) to 263 (1200).

Measuring Rise Times

Rise time is usually measured from 10% to 90% amplitude of a positive going
transition. To measure rise time you need a test signal to have a known stimulus
to the system under test. The signal can be full field or inserted as a VITS.

Measuring rise time is an important way to check the performance of sources and
signal degradation by cabling. To measure rise times:

1. Select the active tile and set it to Waveform mode by pressing WFM. Press
LINE to set the display to a one line sweep.

2. Press VAR and then adjust Vertical Gain to set the rising edge to be
measured so it is ten divisions tall.

3. Use the horizontal position knob to place the rising edge in the center of the
screen.

4. Press MAG to expand the horizontal scale to 200 ns/div.

5. Use the VERTICAL knob to position the trace so the bottom of the
waveform is one major division below the reference line. (The 10% level of
the transition should be on the reference line.)

6. Use the HORIZONTAL knob to position the trace so that the rising edge of
the trace passes through a major division mark on the reference line.

7. Reposition the trace vertically so the top of the transition is one major
division above the reference line. (The 90% level of the transition is now on
the reference line.) Do not change the horizontal position.

8. Measure the rise time from the 10% starting point located in Step 5 to the
90% point where the rising edge now crosses the reference line.

If you set the trace to ten divisions tall, you can use Cursors to measure the time
between the 10% and 90% levels on the trace. See Figure 3-3.
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Timel: 8.01 ]IS\\\

N

V Gain: x1.43 Mag: x15.0

525 59.94 SUN JUL 27 15:55:51 ID: WVR6E10A_192021
SDI Input A Audio Input: Not selected
Ref: Internal ’

Figure 3-3: Measuring rise time with cursors

If it is not convenient to expand the transition vertically to ten major units, you
can make a good approximation of rise time by estimating the 10% and 90%
levels when positioning the top and bottom of the waveform near the reference
line. (With a 5-division transition, for example, position the waveform bottom at
one-half division below the reference line, which puts the 10% point on the
reference line; then position the waveform top at one-half division above the
reference line, which puts the 90% point on the reference line.)

Ensuring Regulatory Compliance

3-6

Each composite video standard has parameters which all broadcasts must meet.
To measure all of these parameters is a large job that may be more suited to an
automated measurement set such as a Tektronix VM700T, however a reasonable
subset can be checked with a waveform rasterizer.

For regulatory purposes, these values are measured on the output of a demodula-
tor that is driven from the off-air signal. These measurements can also be used
inside the facility to check internal signal fidelity. These measurements can be
performed on live signals, however they are easier to perform on a VITS, if one
is present.
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The exact limits for each parameter is specified by the individual standard,
example values used here should not be mistaken as correct for all situations.

Parameters that are often checked for compliance:

Luma Amplitude

Peak Amplitude

Sync Amplitude

Burst Amplitude

Black Level / Setup

Proportion of sync to luma amplitude
Sync Width

Blanking Width

To check Luma Amplitude:

1.
2.
3.

Press WFM to set the active tile to Waveform mode.
Choose a one or two line sweep.

Press and hold the WFM button to display the pop-up menu. Select
Filter > Luma to apply the Luma filter.

Compare the maximum level to the specification, that is 100 IRE for NTSC
and 700 mv for PAL.

To check Peak Amplitude:

1.
2.
3.

Press WFM to set the active tile to Waveform mode.
Choose a one or two line sweep.

Press and hold the WFM button to display the pop-up menu. Select
Filter > Flat to apply the Flat filter.

Compare the maximum level to the specification, that is 120 IRE for NTSC
and 934 mv for PAL.

To check Sync Amplitude:

1.
2.
3.

Press WFM to set the active tile to Waveform mode.
Choose a one or two line sweep.

Press and hold the WFM button to display the pop-up menu. Select
Filter > Flat to apply the Flat filter.
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3-8

4. Compare the level to the specification, that is 40 IRE for NTSC and 300 mv
for PAL.

To check Burst Amplitude:

1. Press WFM to set the active tile to Waveform mode.

2. Choose a two line sweep.

3. Press and hold the WFM button to display the pop-up menu. Select
Filter > Flat to apply the Flat filter or Filter > Chroma to apply the
Chroma filter.

4. Compare the level to the specification, that is 40 IRE for NTSC and 300 mv

for PAL.

To check Black Level and Setup:

1.
2.
3.

Press WFM to set the active tile to Waveform mode.
Choose a one or two line sweep.

Press and hold the WFM button to display the pop-up menu. Select
Filter > Luma to apply the Luma filter.

For PAL or NTSC without setup, verify that the minimum level during
active video is 0 V.

For NTSC with setup, veritfy the minimum level during active video is
7.5 IRE.

Check proportion of Sync to Luma Amplitude:

1.
2.
3.

Press WFM to set the active tile to Waveform mode.
Choose a one or two line sweep.

Press and hold the WFM button to display the pop-up menu. Select
Filter > Flat to apply the Flat filter.

Use variable gain and vertical position and adjust the waveform to span from
the sync tip graticule line to the max luma graticule line.

If the blanking is not close to the zero or set-up graticule line, then the ratio
or proportion is incorrect.

To check Sync Width:

1.
2.

Press WFM to set the active tile to Waveform mode.

Choose a two line sweep.
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Matching Sources

3. Press and hold the WFM button to display the pop-up menu. Select
Filter > Flat to apply the Flat filter.

4. Use vertical position and adjust the waveform so the 50% point of sync is on
the center graticule.

5. Use the graticule to measure the sync width.

To check Blanking Width:

1. Press WFM to set the active tile to Waveform mode.
2. Choose a two line sweep.

3. Press and hold the WFM button to display the pop-up menu. Select
Filter > Flat to apply the Flat filter.

4. Use vertical position and adjust the waveform so the 50% point of the active
video transition is on the center graticule.

5. Use the graticule to measure the blanking width.

To Match Sources means to adjust the components of the sources so that a
picture from each will look the same. For example, if you have two cameras
pointed at the same scene, then you probably want them to look the same as you
switch between them.

There are several waveform rasterizer display modes that can be used to match

sSources:

Vector mode. This mode is good for matching hue and saturation but it does not
show luminance, so it is not a complete solution.

RGB waveform mode. This mode is easy to understand but not good for gamma
or if controls maintain constant luminance.

Composite waveform mode. This mode is good for looking at luminance and
saturation, but it does not show hue, so it is not a complete solution.

Diamond mode. A proprietary Tektronix display mode that shows luminance and
color information well. Diamond mode is especially good for gamma.

Picture mode. The ultimate authority as to what looks right, but hard to know
what you need to adjust to match the sources.
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Shading a Camera

For all the modes, the procedure is about the same:
1. Display the first signal.

2. Note the location of the waveform features on the screen or use FREEZE to
capture a reference trace.

3. Switch to the second source.
4. Adjust the second source until it matches the first.

5. Switch back and forth between the two sources to verify they have the same
signal.

NOTE. You can use several of the suggested measurements in different tiles at the
same time. This will help you understand when one is more useful than the other.
For example, if vector and composite waveform are used at the same time, then
the complete luma and chroma space can be seen.

You can use the FREEZE function to assist comparing sources. Apply one input,
Press Freeze to capture an image, then apply the second source. Freeze Supports
several display modes that are useful for comparing sources.

You can use the CURSOR function to assist comparing sources. Turn on cursors
and use them as markers or to measure the differences.

Shading or balancing a camera means to adjust it to have equal red, green and
blue output in a given lighting situation.

The WVR610A & WVR611A support multiple ways of shading a camera. Three
of these methods are discussed below. For analog inputs, only one of these is
available. For all methods, a monochrome target such as a chip chart is assumed
to be in front of the camera.

B Subcarrier nulling on a composite representation
B Setting blanking and peak level on an RGB representation
B Setting a straight line through the origin and peaks on the Diamond display

The Subcarrier Nulling method is the only one of these three methods that can
be used to balance a composite camera, although it can also be used for digital
component cameras by selecting a composite representation of the digital signal
in the Waveform pop-up menu.
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Timing a Studio

Since the target is monochrome, there should be no subcarrier on the active part
of the waveform. So this method entails changing the camera controls to
eliminate any chroma.

The RGB method is very straight forward. Simply adjust the offset and gain for
each color so the video signal runs from 0 and 700 mV. The difficulty is getting
the gamma and knee points matched.

The third method uses the Tektronix proprietary Diamond display. This display
mode is available by selecting Gamut - Gamut display type. In this display,
the chip chart should show as a vertical line through the origin and the top and
bottom of the diamond. If not, then change the gain and offset controls on the
individual colors to bring it in. If the line is not straight, then adjust the gamma
controls.

NOTE. Depending on how the camera head or color corrector controls work, one
or another of these methods may be much easier. For controls that maintain a
constant luminance, the diamond method is usually easiest.

You can use more than one method at a time, displaying each method in different
tiles. This will help you understand when one is more useful than the other.

Timing a studio involves adjusting the references going to different sources so
that their output feeds have the same timing when they arrive a common point,
such as a production switcher. For digital systems the timing typically only
needs to be close, because most switchers have some tolerance to timing errors.
For analog composite systems, the timing may need to be matched within a
small part of a subcarrier cycle to prevent hue shifts when switching between
Sources.

The WVR610A & WVR611A support multiple methods and techniques of
timing a studio. All of these methods require an external reference to the
waveform rasterizers.

The methods and techniques are:

B Comparing horizontal and vertical timing with Waveform Displays
®m  Using Vector for fine timing on composite signals

®  Using SCH modes to check color framing

m  Using FREEZE to store a reference to assist the above methods

®m  Using the new Tektronix Timing display
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The traditional method of comparing horizontal and vertical timing is made
easier by the flexible tiles of the WVR610A & WVR611A.

Using the Traditional = The traditional method of comparing Horizontal and Vertical timing is made
Method easier by the flexible tiles and FREEZE function of the waveform rasterizer.

To time a studio using the traditional method:

1. Press EXT to select External Reference mode.

Apply the first input to the active channel of the waveform rasterizer.
Put one tile in line mode, choose an appropriate waveform mode.

Use the HORIZONTAL knob to center the sync edge or the SAV pulse.

Press MAG to increase the timing resolution.

AN o

Press FIELD to put a second tile in field mode, choose an appropriate
waveform mode.

=

Use the HORIZONTAL knob to center the vertical interval.
8. Press MAG to increase the timing resolution.

9. Press FREEZE save the waveform as a baseline.

10. Apply an input that needs to match timing with the first input.

11. Adjust the timing offset of the black generator to match the timing to the
saved baseline.

12. Repeat steps 10 and 11 for any other required signals.

NOTE. Use the Cursors as markers or to measure timing differences between
sources.

In this procedure, other tiles can be used to set fine timing and check color frame
alignment on composite signals. Alternatively, the other two tiles could be used
for line and field rate displays without mag active to show the location of
significantly mis-timed signals.

Using the Timing Display = The WVR610A & WVR611A Timing display is significantly easier to use than
the traditional method. The Timing measurement draws a cross in the middle of
its display rectangle. The cross represents the timing of the reference signal. The
input signal is plotted as a circle. When the two signals occur at the same time,
the cross and the circle will be aligned. There are also numeric readouts of delay
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in terms of lines of vertical delay and microseconds of horizontal delay. These
allow precise measurement of the timing offset between the two signals.

To use the Timing display to time a studio:

1. Press EXT to select External Reference mode.

2. Apply the first input to the active channel of the waveform rasterizer.
3. Press MEAS to select the Timing display.
4

Adjust the timing offset of the black generator to match the timing to the
external Reference.

Repeat step 4 for any other required signals.

NOTE. As you adjust timing, the circle representing the input timing may jump
occasionally. This because the color frame detection circuit can be temporarily
disrupted as the signal shifts. The jump is often a multiple of the field time. The
circle will settle back to the correct location in a second or so.

About the Timing Display ~ The rectangle in the Timing display represents one frame for SDI inputs or color
frame for composite inputs. The cross-hair in the center is zero offset, and the
circle represents the timing of the input signal. Lines of advance or delay are
shown as vertical displacement, while timing errors of less than a line are shown
as horizontal displacement. If the input is at the same time as the reference, then
the circle will be centered on the cross hair.

The timing offset is also shown numerically as lines and microseconds of
advance or delay in the Vertical Offset and Horizontal Offset boxes.

The Relative to: box indicates the chosen zero point for the timing display. The
default is Rear Panel. In this mode, the offset is zero when the input and
reference are at the same timing at the rear panel of the waveform rasterizer. The
other choice is Saved Offset. In this mode, you can save the timing from one
signal, and then display the timing relative to that saved offset.

Press and hold MEAS to bring up the timing pop-up menu and access the
Relative to: and Saved Offset functions.

To time down the inputs to a router:

1. Select one input as the master and route it and a reference to the waveform
rasterizer.

2. Save the timing offset for the master input (MEAS > Save Offset > Press
Select) and select Relative to: Saved Offset mode from the pop-up menu.
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3. Now select other inputs to the router to be connected to the waveform
rasterizer. For each input the relative timing will be displayed.

4. Adjust the timing offset at the master sync source to time down the inputs to
the router to match the master.

NOTE. You cannot save the timing offset if either the input or reference is missing
or unlocked. You also cannot save a reference when in internal mode. Saving an
offset in these conditions would lead to misleading results so it is not allowed by
the instrument. A warning message will appear on the screen if you attempt to
save the offset when it is not allowed.

Background for the Timing Display. The resolution of the timing display is one

27 MHz clock cycle or 37 ns. To get the greater accuracy needed for a composite
signal, first use the timing display to get close, then use a vector display for the
final burst phase alignment. Since these two displays can be present simulta-
neously in separate tiles, this process can still be easy and quick.

For composite signals, the definition of “time aligned” is straight forward, but
for an SDI input relative to a composite reference the situation is more complex.
For the timing display the definition of “zero offset” on an SDI input assumes
the SDI signal will be converted to composite. The converted composite signal is
then compared to the composite reference. For the conversion, a half-band filter
with a 33 clock-cycle delay and an analog reconstruction filter are assumed. This
conversion introduces a delay of about 3 us.

This timing relationship between input and reference is also compatible with
waveform mode. That is, if you have zero timing on the Timing display and
change from internal to external reference, the displayed waveform will not shift
position.

In the Relative to: Rear Panel mode, this 3 us conversion delay is removed
from the measured offset before the display is generated. In the Relative to:
Saved Offset mode it has no effect.
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Investigating a Flaw in a Picture

If you want to see the video signal that produces one portion of an image, then
use the line select function. Line select restricts the active tile so it displays only
one line of the video image. When you use line select, the selected line will also
be highlighted on the picture display. This makes it easy to zero in on any part of
the signal.

To use line select to investigate a portion of a picture:

1.
2.

Press PICT to select picture mode for one tile.

Select Waveform, Vector, or a Gamut display in a second tile.
Press LINE SEL.

The active tile set in step 2 will now be in line select mode.

Press CURSOR to display the Picture Cursor Line pop-up menu. Press SEL
to select On in the pop-up menu.

Use the GENERAL knob to put the highlight cursor on the area of interest
in the picture. See Figure 3-4.

Examine the tile, set up in step 2, to see the signal that creates the selected
line of the picture.

NOTE. Only one tile may be in line select at a time.
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Checking VITS

Picture line
cursor

Ref: Internal

WED JAN 22 19:36:48

Tektronix
Vi

A

Figure 3- 4: Investigating a line in a picture

To display a VITS (Vertical Interval Test Signal), you need to know into which
field and line the signal was inserted. Once you know what line the signal was
inserted into, you can display the line using LINE SEL.

To display the VITS on a specific line:

1.

2
3.
4

Select the tile where you wish to display the signal.
Press WFM to select the Waveform display.
Press LINE (to the right of the INPUT buttons) to enable line select mode.

Use the left-right arrow keys to select the desired field. See Figure 3-2 on
page 3-4.

Use the GENERAL knob or the up-down arrow keys to select the line you
wish to display.
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Verifying Closed-captioning Presence

You can verity the presence of closed captioning by viewing line 21 of field 1
(and usually field 2) .

To display line 21 in field 1:

1.

U

put
Ref: Internal

Select the tile where you wish to display the signal.
Press WFM to select the Waveform display.

Press LINE SEL to enable line select mode.

Use the left-right arrow keys to select field F1.

Use the GENERAL knob or the up-down arrow keys to select line 21. See
Figure 3-5.

Examine the signal for the presence of the closed-captioning signal.

SAT JAN 04 17:44:32

Tektr(m/ix

Figure 3-5: Verifying closed captioning presence
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Checking Gamut

3-18

Diamond Display

Signals that are legal and valid in one signal representation may not be valid in
another representation. Specifically, signals which are legal in the Digital YCbCr
representation may not be legal if transcoded to RGB or encoded to NTSC/
PAL. Any signal that fails this test is considered out of gamut.

The WVR610A & WVR611A support multiple displays and alarms to allow
detecting out of gamut signals. The flexible tile display allows you to simulta-
neously view several of the gamut measurements to learn which is most
appropriate for a given application.

The displays are:
B Diamond for checking that SDI signals conform to legal RGB gamut space

B Split Diamond separates the upper and lower diamonds to show excursions
below black, otherwise it is identical to the Diamond display

B Arrowhead for checking if an SDI signal is legal for composite color space

®  Composite Waveform modes for checking both SDI and composite signals
for legality in composite color space

Diamond, Split Diamond, and Arrowhead have adjustable thresholds. If the
signal goes outside the area defined by the thresholds, the signal is out of gamut.
If these limits are exceeded then the waveform rasterizer can generate alarms if
configured to do so.

For composite waveforms, the legal limit is simply the maximum level allowed
for the combination of luma and chroma. This limit depends on application. For
example, a recording on a tape may be able to handle a larger signal than if
driving into a transmitter.

The Diamond display is very effective at showing the relationship between the
R, G, and B signal video signals. The waveform monitor converts the Y, Py, and
P; components recovered from the serial signal to R, G, and B to form the
Diamond display. Figure 3-6 shows how the Diamond plot is developed.

Ultimately all color video signals are coded as RGB for display on a picture
monitor. To predictably display all three components, they must lie between peak
white, 700 mV, and black, 0 V. Picture monitors handle excursions outside the
standard range (gamut) in different ways.
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Green

X-Y plot Diamond plot

Figure 3-6: Construction of the Diamond display

Checking RGB Gamut. For a signal to be in gamut, all signal vectors must lie
within the G-B and G-R diamonds. Conversely, if a vector extends outside the
diamond, it is out of gamut. The direction of an excursion out of gamut indicates
which signal is excessive. Errors in green amplitude affect both diamonds
equally, while blue amplitude errors affect only the top diamond and red errors
affect only the bottom diamond. See Figure 3-7.
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525 59.94 SAT JAN 04 18:05:05
SDI I t B T — e -
T Tektronix

Ref: Internal

Figure 3-7: Diamond display showing out of gamut signal

You can set an alarm to indicate when the signal exceeds the RGB gamut. For
information on setting the gamut alarm, refer to Configuring Alarms and
Viewing Status on page 3-37.

The intensity of a vector indicates its duration. A momentary out-of-gamut
condition appears as a faint trace. Long duration violations show as a bright
trace. Figure 3-8 gives some sample out-of-gamut signals on the Diamond
display.

As with the lightning display, bending of the transitions indicates timing delays.
When a color bar signal is applied, the vertical axis becomes an indicator of
delay errors.
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- > B
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Example A: Example B:
R - Ok R - Ok
G > 700 mV G - Ok
B - Ok B> 700 mV

Figure 3-8: Out-of-gamut signals on a Diamond display

G ‘\ _’ B
S AN
Example C:
R - Ok
G - Ok, 350 mV
B<0OmV

On the Diamond Display, monochrome signals appear as vertical lines.
Nonlinear component processing, such as from a gamma corrector that alters
white balance, can cause deviations along the vertical axis.

Arrowhead Gamut  The Arrowhead gamut display plots luminance (Y) against chrominance (C) to
check if the composite signal adheres to standard gamut. Figure 3-9 shows
NTSC and PAL Arrowhead displays (75% Color bars) and indicates the values
of the graticule lines. The arrow-head shape of the graticule results from
overlaying the standard limits for luminance and luminance plus peak chromi-

nance.
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Figure 3-9: NTSC and PAL Arrowhead gamut displays
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Signals exceeding the luminance amplitude gamut extend above the top
horizontal limit (top electronic graticule line). Signals exceeding the luminance
plus peak chrominance amplitude gamut extend beyond the upper and lower
diagonal limits. The bottom horizontal line shows the minimum allowed
luminance level of 7.5 IRE for NTSC and 0 mV for PAL. See Figure 3-9.
Figure 3-10 shows an Arrowhead display.

525 59.94 WED JAN Z
SDI Input A Tek[l’()rl/]x

Ref: Internal

Figure 3-10: Arrowhead display

Checking Composite Gamut. The Arrowhead display provides an automated
check on adherence to composite gamut standards with the Alarm feature
discussed in Configuring Alarms and Viewing Status on page 3-37. To perform
an automated gamut check, enable alarm reporting in CONFIG > ALARMS >
SDI INPUTS > Composite Gamut. When enabled, the alarm alerts you
whenever the signal exceeds the limit.

Another useful Arrowhead function is a measure of how well the active video
signal is using the dynamic range of video channel. A properly adjusted signal
should be centered in the arrowhead graticule and have transitions that approach
all the limits.

Checking Luma Gamut. Adjustable Luminance limits are also displayed on the
Arrowhead display. Since luma plots on the vertical axis, simple horizontal
thresholds define a maximum and a minimum luma level.
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The thresholds are defined in terms of percent of full scale. Thus, they apply to
both the incoming SDI and the arrowhead representation of the SDI input as a
composite signal. By defining these levels in percent, they automatically account
for the presence or absence of setup.

The range for the Upper limit is 90% to 108%.
The range to the Lower Limit is -6% to +5%

The thresholds are affected by the user choice of set-up or no set-up for the
Arrowhead display.

Luma limit thresholds can be configured for identifying luma exceeding
threshold limits. The adjustable thresholds are indicated by the dark blue
horizontal graticule lines on the display.

Checking Frequency Response

3-24

Checking Frequency Response ensures that your video signal has the same gain
at all frequencies. To perform this test you need a signal with a known frequency
distribution, this typically means a test signal, either full field or set up as a
VITS.

There are four basic signals you can use to test frequency response:
®  Sweep

®  Multi-burst

B Multi-pulse

B Pulse and Bar

Sweep is a signal that starts at a low frequency and smoothly increases to a high
frequency. Apply the sweep signal to the system under test then use Waveform
mode to look at the envelope of the signal. It should be flat at the top and
bottom. If the envelope is smaller at some frequencies, then it indicates a roll-off
in frequency response. You may want to use Cursors to measure any response
error.

Multi-burst is similar to sweep except it has packets of discrete frequencies.
Typical signals can have packets of 0.5, 1, 2, 3, 4 and 5 MHz. Use the same
procedure as for sweep to evaluate the attenuation at each packet’s frequency.

Multi-Pulse is a series of pulses each filled with a burst. The frequency of the
burst increases across the line. If there is a roll-off in frequency response, the
bottom of the burst cycles will not get down to the baseline. Conversely, if there
is peaking, the burst cycles will extend past the baseline. Multi-pulse also
indicates the presence of group delay by an “S” shape in the bottom of the burst
cycles.
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Pulse and Bar is one short pulse and one long bar on the same video line. Ideally,
the pulse and the bar should be the same amplitude. If they are not the same
amplitude, then it indicates a frequency response error since the pulse has higher
frequency components than the bar. The pulse can also indicate phase distortion
if it has excess ringing, or group delay errors if the ringing is asymmetric around
the pulse.
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The WVR610A & WVR611A provide several methods to monitor audio signals.
You can measure levels, monitor phase, and display phase correlation. You can
specify meter ballistics and scales, set the Test and Peak Program indicator
levels, and specify how phase is displayed.

NOTE. With audio option DA, the waveform rasterizer can monitor AES, analog
and Embedded audio. Option AN can only monitor analog audio and option DG
can only monitor AES and embedded audio.

Selecting the Audio Input

You select the audio input to be monitored from the front-panel AUDIO button
pop-up menu.

NOTE. The Audio display can appear in only one tile at a time.

To select the audio input monitor:
1. Press AUDIO to set the active tile to audio mode.

2. Press and hold the AUDIO button to display the pop-up menu. See
Figure 3-11.
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True Peak Ballistics Aundio Input: Embedded

in phase
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Follows Video
_52

Phase Display On
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Phase Pair 1&2 /..
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Figure 3-11: Audio pop-up menu

3. Select Audio Input.

4. Select the following audio input options: Follows Video, AES A, AES B,
Analog A, Analog B, or Embedded (the available selections depend on the
installed audio option).

NOTE. Selection of Follows Video uses the audio to video mapping in the
Configuration menu.

5. To activate the input selected, press SEL.
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Checking Audio Level

The waveform rasterizer level meters are vertical bar graphs where the height of
the bar indicates the amplitude of the audio program in the corresponding input
channel. You can change the input and turn on and off the Phase display from the
audio pop-up menu. Other meter characteristics such as ballistics, scale units,
and program/test levels are configured through the Configuration menu.

To check audio level:
1. Press the AUDIO button to set the active tile to audio mode.

The level meter bars are displayed. These bars indicate the current audio
levels according to the selected meter ballistics. See Figure 3-12.

True Peak Ballistics Aundio Input: Embedded

A
v

525 59.94 SAT JAN 04 18:13:08
e Tektronix
Y

Ref: Internal

Figure 3-12: Audio level meters

The graphical level meter displays three colors:
B Green- Indicates portions of the level meters below the test level.

®  Yellow- Indicates portions of the level meters between the test and peak
program level.

B Red- Indicates portions of the level meters above the peak program level.
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Checking Audio Phase

The WVR610A & WVR611A, with optional audio, can display phase of one
input pair with a Lissajous pattern display, and it can display relative phase on all
four pairs of inputs with correlation meters.

To check audio phase:

1.
2.

4.

Select the tile where you wish to display the audio phase.
Press the AUDIO button.
Press and hold the AUDIO button to display the pop-up menu.

Select Phase Display. Press SEL or the right-arrow key to turn the phase
display on.

Select the Phase Style and the Phase Pair from the pop-up menu. See
Figure 3-13.

True Peak Ballistics Audio Input: Embedded

SAT JAN 04 18:14:39

Tektronix

Figure 3-13: Audio phase display

Lissajous Display  The Lissajous or phase portion of the audio display is a plot of one channel
against another on an orthogonal pair of axes. You can set the instrument for
either soundstage or X-Y orientation of the Lissajous pattern. See Figure 3-14.
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in phase

A

Lissajous Sound Stage X-Y Orientation

Figure 3-14: Audio phase displays

The Soundstage representation has the two channels plotted at 45 degree angles
with the mono combination appearing on the vertical axis. The soundstage
orientation is more like a left - right image in a studio.

The X-Y orientation plots left channel data along the vertical axis and right
channel data on the horizontal axis, emulating the conventional X-Y display of
an oscilloscope.

Correlation Meters  The Correlation meters display the extent to which two channels move together.
This can be considered their mono compatibility. These meters are located under
the appropriate bars and one is duplicated under the phase display.

See Figure 3-15 on page 3-32.

B When signals are correlated the diamond will be green, and it will move to
the right side.

m  [f the signal is uncorrelated then the indicator will tend to stay in the middle.

®m  Finally if the signals are anti-correlated - that is one goes up when the other
goes down - then the correlation meter indicator will be red and go to the
left end.

The more correlated or uncorrelated the signals are, the farther the indicator will
be from the center.
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True Peak Ballistics Aundio Input: Embedded

Phase correlation meters

Yellow indicates uncorrelated The further to the Green indicates
signals right, the higher the correlated signals
correlation

Figure 3-15: Audio phase display

The response time of the correlation meters can be set from the CONFIG menu.
The choices are shown in Table 3-1.

Table 3- 1: Correlation meter response times

Response aver- Response aver-
Speed setting aging time (s) Speed setting aging time (s)
1 0.0167 1 3.0
2 0.0333 12 35
3 0.0667 13 4.0
4 0.1333 14 4.5
5 0.2667 15 5.0
6 0.5333 16 5.5
7 1.0 17 6.0
8 (default) 15 18 6.5
9 2.0 19 7.0
10 2.5 20 7.5
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Creating Presets

From the Front Panel

From the Remote Interface

A Preset is a saved instrument setting. Using presets saves you time because you
only need to press a single button to change a range of waveform rasterizer
settings to meet a specific measurement need. Presets are created and recalled
using the numbered buttons located under PRESETS on the front panel or using
the web interface.

There are a couple of advantages to saving presets on a PC using the web
interface. One is that the preset is a named file which can make it easier to recall
the purpose of the preset. A second advantage is that the number of presets that
can be saved on a PC is, for practical purposes, unlimited.

You can create Presets either from the front panel of the WVR610A &
WVR611A or from the Remote Interface software.

To create a Preset on a WVR610A & WVR611A:

1. Set up the waveform rasterizer exactly as you wish to have it configured.
This includes setting the contents of each tile and the audio and video
settings.

2. After you have configured the waveform rasterizer, press and hold one of the
numbered buttons located under PRESETS for more than two seconds.

When settings have been assigned to a Preset button, a notification appears
informing you that Preset X has been saved.

The FACTORY Preset settings cannot be changed.

Using the Remote Interface software you can save the Presets on the WVR610A
& WVR611A.

To create a Preset using the Remote Interface software:

1. Set up the waveform rasterizer exactly as you wish to have it configured.
This includes setting the contents of each tile and the audio and video
settings.

2. In the Remote Interface Java applet, select File > Save as Preset. See
Figure 3-16.
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Figure 3-16: Saving a preset using the Remote Interface software

3. To save the preset:
a. On the waveform rasterizer: click one of the Presets and then click OK.

b. From the web interface: click the button next to the text entry box, enter
the filename in the text entry box and then click OK.

Recalling Presets

To recall a Preset from the waveform rasterizer front panel:

CAUTION. Be careful not to hold a Preset button for more than a second or it will
! overwrite the existing Preset with the current instrument settings.

B Press and release the button of the desired Preset.
To recall a Preset using the Remote Interface software:

1. Select File > Restore Settings.... This displays the dialog shown in
Figure 3-17.
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Figure 3-17: Recalling presets using the web interface software

2. To recall the preset, click the button next to the desired Preset and click OK.
if you wish to recall a Preset but you are not sure which one you wish to
recall, you can click Apply. This recalls the selected Preset but keeps the
Restore Settings window displayed so you can recall another Preset more

easily if needed.

Recalling the Factory Defaults

To recall factory default settings:

®  Press and release the FACTORY button.

Pressing the FACTORY button resets the waveform rasterizer to the factory
default settings. For details on default settings, see Specifications on page A-1.
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Contents of a Preset

3-36

All instrument settings except those set in the Utilities and Network Settings
submenus of the CONFIG menu are saved in a Preset. Settings that are not saved
are those such as the clock setting, IP configuration and network address.

The following is an overview of the settings saved in a Preset:

Measurement assigned to each tile
Tile specific settings

Input selection

SDI Input settings

Composite Input settings

Cursor settings

External Reference settings
Analog and Digital Audio Displays settings
Audio Inputs/Outputs settings
Alarm settings

Gamut Thresholds

Display Settings

Readout settings

Graticule settings
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Configuring Alarms and Viewing Status

Alarms allow you to configure the WVR610A & WVR611A to automatically
measure or monitor parameters and report when they exceed limits. The
parameters may be signal related, such as gamut on the video signal or silence on
audio, or they can be instrument related such as a fan failure.

Because the alarms in the waveform rasterizer are so flexible, they must be
configured to meet the needs of most installations. Alarms can be displayed
on-screen as one of the options under the STATUS button.

Alarms can be reported by a variety of methods. Many alarms have thresholds
that can be adjusted to customize the behavior for a given application. Some of
the alarm reporting can be temporarily muted to reduce confusion when multiple
problems exist.

There is an Enable Alarms function that allows all alarms to be disabled.

Enabling and Disabling Alarms

Alarms are configured in the CONFIG > Alarms menu. In the Alarms menu,
you enable and disable alarms, specify which alarms are monitored, and what
action should be taken when an alarm is triggered.

To configure alarms:

1. Press the CONFIG button and select Alarms. See Figure 3-18.

Enable Alarms On

Set all alarms to this mask  Press SEL
SDI Input Press SEL
General Press SEL
General Audio Press SEL

SDI Input

External Ref.

Analog Audio Displays
Audio Inputs/Outputs

Gamut Thresholds

Display Settings
LTC / VITC
Readouts
Graticules
Network Settings
Utilities

Figure 3-18: Alarms menu

2. To change Alarms settings, use the GENERAL knob or right-arrow key to
change the menu focus to the Alarms menu.
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Enabling and Disabling  To enable or disable alarms:
Alarms
1. From the CONFIG menu, select Alarms.
2. From the Alarms menu, select Enable Alarms.

3. Press SEL to select On to enable alarms or Off to disable alarms.

Note that when you disable alarms, Alarms Disabled appears in the Status
bar.

4. Press CONFIG to remove the CONFIG menu.

Alarm Conditions That Can Be Monitored

The waveform rasterizer can monitor up to 27 alarm conditions (depending on
the model and installed options), which are organized into several groups: SDI
Input, Composite Input, General, General Audio, AES and Embedded, and
Embedded Audio Specific. See Table 3-2.

Table 3-2: Alarms

Alarm group Alarms

SDI Input SDI Input Missing
SDI Input Unlocked
EDH Alarm

RGB Gamut
Composite Gamut

Composite Input Input Missing
Input Unlocked

General External Reference Missing
External Reference Unlocked
LTC Invalid

LTC Missing

VITC Invalid

VITC Missing

Hardware Fault

General Audio Audio Clip
Audio Mute
Over Alarm
Silence
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Table 3-2: Alarms (Cont.)

Alarm group Alarms

AES and Embedded Signal Lock
Professional CRC
Validity Bit

Parity

Embedded Audio Specific Audio Stream Missing
Checksum

Buffer Full

Buffer Empty

Parity

SDIInput  SDI alarms indicate problems with SDI input signals. The SDI Input alarms that
can be monitored are:

SDI Input Missing. Indicates that an SDI input signal has not been detected at the
selected input.

SDI Input Unlocked. Indicates that the waveform rasterizer cannot lock to the
selected SDI input signal.

EDH Alarm. Indicates when the EDH has detected an error.

RGB Gamut. Indicates when the input signal contains colors that violate the
currently set limits for RGB gamut, which are specified by the Diamond
Thresholds.

Composite Gamut. Indicates an input signal containing colors that violate the
currently set limits for composite gamut, which are specified by the Arrowhead
Thresholds.

Luma Gamut. Indicates an input signal with Luminance values that exceed the
currently set limits for Luma, which are specified by the Luma Thresholds.

Composite Input Composite input alarms indicate problems with composite input signals. The
alarms that can be monitored are:

Input Missing. Indicates a composite input signal has not been detected at the
selected input.

WVR610A & WVR611A Waveform Rasterizers User Manual 3-39



Configuring Alarms and Viewing Status

Input Unlocked. Indicates that the waveform rasterizer cannot lock to the input
signal on the selected input.

General  General alarms indicate a signal is missing or there has been a hardware failure.
A hardware failure alarm indicates a potential instrument failure. The General
alarms that can be monitored are:

External Reference Missing. Indicates that no external reference signal is being
detected.

External Reference Unlocked. Indicates that the waveform rasterizer cannot lock
to the external reference signal. This is usually due to a wrong or unsupported
standard.

LTC Invalid. Indicates that the LTC was lost for one frame but has reappeared.
LTC Missing. Indicates that the LTC is not being detected.

VITC Invalid. Indicates that the VITC disappeared for one frame but has re-
appeared.

VITC Missing. Indicates that a break or discontinuity in the VITC has occurred.

Hardware Fault. Indicates that there has been a hardware failure. If this alarm
occurs, power down the instrument and contact your local Tektronix service
representative.

General Audio The General Audio alarms that can be monitored are:

Audio Clip. Indicates that an audio clip error has occurred. This occurs when the
audio signal consists of all “ones.”

Audio Mute. Indicates that an audio mute error has occurred. This occurs when
the audio signal consists of all “zeroes.”

Over Alarm. Indicates that the audio level has exceeded that level at which the
signal is considered “over” and the time it has been over has exceeded the
specified Duration for Over setting.
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Silence Alarm. Indicates that the audio level has dropped below the level at which
the signal is considered “silent” and the time it has been silent has exceeded the
time specified by the Duration for Silence setting.

AES and Embedded  The AES and Embedded alarms that can be monitored are:

Signal Lock. Indicates that the waveform rasterizer is not locked to an incoming
signal on the indicated input channel. Data cannot be decoded; all data and all
other errors are ignored. This message appears when no input signal is present.

Professional CRC. If there is a Professional Channel Status CRC error, it will
appear in the Alarm Status Log.

Validity Bit. Indicates that the Validity bit is set high for one or more data
samples. In the AES/EBU standard, a set validity bit indicates that the sample is
not suitable for conversion to audio.

Parity. Indicates that the incoming subframe does not have even parity as
specified by the applicable digital audio standards. The data sample is unreliable
and is ignored.

Embedded Audio Specific =~ The Embedded Audio Specific alarms that can be monitored are:

Audio Stream Missing. Indicates that there is no audio stream detected in the
selected input signal.

Checksum. Indicates that an error occurred in the data which resulted in an
invalid checksum.

Buffer Full. Indicates that the buffers in the de-embedder are full. When this
occurs, audio discontinuities result. This is usually caused by a serial source that
is outside the allowed time base range.

Buffer Empty. Indicates that the buffers in the de-embedder are empty. When this
occurs, audio discontinuities result. This is usually caused by a serial source that
is outside the allowed time base range.

Parity. Indicates that the incoming subframe does not have even parity as
specified by the applicable digital audio standards. The data sample is unreliable
and is ignored.
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Setting Up Alarm Reporting Options

Setting Alarms by Group

Setting Alarms by Mask
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The WVR610A & WVR611A allow you to specify how alarm conditions are
reported. You can specify whether or not an alarm indicator is displayed
on-screen, if an alarm is logged, if an audible beep is sounded, if an SNMP trap
is sent out on the network, if a ground closure is triggered, and if a pop-up
notifier is displayed.

Alarms in each group can be set up using a mask or individually. The reporting
options are the same for all alarms. See Table 3-3 for a description of alarm
reporting options.

To change the alarm reporting options for each alarm group:
1. From the Alarms menu, select the desired alarm group.

2. Press SEL to display the alarm reporting options. See Figure 3-19.

Screen Ground
Text / Icon Logging Closure
SDI Input Missing b4
SDI Input Unlocked
EDH Alarm
RGB Gamut

Composite Gamut

Luma Gamut

Figure 3-19: Setting alarm reporting options

3. Use the arrow keys to highlight the checkbox for the reporting option you
wish to change. Press the right or left-arrow key to move the highlight
horizontally. Press the up/down-arrow keys to move the highlight vertically.

4. After highlighting the checkbox for the reporting option you wish to change,
press SEL to change the setting. A setting is enabled when the box is filled
with an X.

5. When you have completed your changes, move the highlight to Select here
returns to the Config Menu. Press SEL to return to the Alarms menu.

6. After changing the setting, press CONFIG to remove the CONFIG menu.

You can set the alarm reporting options for all alarm groups to be the same by
using the Set all Alarms to this mask menu entry. This enables you to set the
alarm reporting options for all groups by setting the options in just one place.
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To set the alarm reporting options for all alarm groups to the same settings:
1. From the Alarms menu, select Set all Alarms to this mask.

2. Press SEL to display the alarm reporting options. See Figure 3-20.

Screen SNMP Ground
Text / Icon Logging Trap Closure

Makes all alarms equal to these selections

Figure 3-20: Setting alarm reporting options for all alarm groups

3. Use the arrow keys to highlight the checkbox for the reporting option you
wish to change. Press the right or left-arrow key to move the highlight
horizontally. Press the up/down-arrow keys to move the highlight vertically.

4. After highlighting the checkbox for the reporting option you wish to change,
press SEL to change the setting. A setting is enabled when the box is filled
with an X.

5. When you have completed your changes, move the highlight to Select here
returns to the Config Menu. Press SEL to return to the Alarms menu.

6. After changing the setting, press CONFIG to remove the CONFIG menu.

Available Alarm Reporting  Table 3-3 lists the available alarm reporting options.

Options

Table 3- 3: Alarm reporting options

Setting Choices

Screen Text/Icon Selected / Deselected
Logging Selected / Deselected
Beep Selected / Deselected
SNMP Trap Selected / Deselected
Ground Closure Selected / Deselected

Screen Text/lcon  Displays text and an icon on-screen when an alarm has occurred. Alarms are
viewed in the STATUS display. The color of the alarm indicator depends on the
current status of the alarm.
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Logging

Beep

SNMP Trap

Ground Closure

Muting Alarms

Viewing Alarm Status

3-44

Logging stores errors in a file (Error/Alarm log) that includes time stamp, error

name, error signal source and additional info specific to the error. The log file is
not saved on power-down. An indicator is displayed on-screen when logging is

enabled.

Sounds an audio beep when an error/alarm has occurred. The audio beep can be
muted without being turned off, by using the Mute Alarms function in the
STATUS pop-up menu.

The instrument sends an SNMP trap to the SNMP Trap addresses specified in the
CONFIG > Network Settings submenu.

An output that can be used to drive a light or audible alarm. All alarms are
“OR’ed” together so that if any alarm is triggered, the output is driven to ground.

You can turn off several of the alarm reporting methods without disabling the
alarms by using Mute Alarms in the STATUS pop-up menu. When Mute Alarms
is On, the Beep, SNMP Trap, and Ground Closure options are switched off. This
enables you to continue to log errors and see visual alarm indicators without
audible alarms.

Select a tile in which to display the Status screen.
Press and hold the STATUS button to display the STATUS pop-up menu.
Select Mute Alarms from the pop-up menu.

Press SEL to select On.

A O

Press STATUS again to remove the pop-up menu.

When Alarms are muted, the text “Alarms Muted” appears in the Status bar.

To view Alarm Status:
1. Select the tile where you want the Alarm Status displayed.

2. Press the STATUS button. If the Alarm Status page is not displayed, press
and hold the STATUS button to display the STATUS menu. See
Figure 3-21.

3. Select Display Type from the menu.
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4. Press the right-arrow key to change the menu focus to the Display Type
submenu.

5. Select Alarm Status.
6. Press STATUS again to remove the menu.

7. If the status page is longer than a single page (see the upper-right corner of
the display), you can scroll through the alarm listing by using the
GENERAL knob or the up-down arrow keys.

NOTE. The Alarm Status displayed is only for the currently selected video and
audio inputs.

Paused Alarm Status Page 1 of 2

Alarm Status Additional Information

Hardware Fault

SDI Input Missing

SDI Input Signal Lock

External Reference Missing

External Reference Sig Lock

RGB Gamut Exror RrGgBb
Composite Gamut Error

EDH Error

Embedded Audio Missing 1234567890123456
Embedded Audio Chksum

Embedded Audio Buffer Full

Embedded Audio Buffer Empty

Embedded Andio Parity

Audio Signal Loss 12345678
Audio CRC Error

Audioc Valid Bit

Audio Parity Error

Audio Clip

Audio Over Level

Audio Silence

Andin Internal Frror

risabled
Mute Alarms risabled

WED JAN 22 19:45:18 VRGO 2E3138

Tektro: R

Ref: Internal

Figure 3-21: Selecting the alarm status display

Elements of the Display =~ There are three columns in the Alarm Status display: Alarm, Status, and
Additional Information.

The Alarms column lists the alarms that have been triggered. This is a history of
alarms, it includes alarms that occurred in the past as well as alarms currently
being triggered.
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The Status readouts use both text and color to indicate the current state of the
error. Text is used to indicate whether or not an error occurred. Color is used to
indicate the current status of an error.

The Status readout text is either OK or ERROR. If the text is OK, that means
that the alarm is not being triggered or has not occurred within the last five
seconds. ERROR means that an alarm is occurring or has occurred within the
last five seconds.

The meaning of the color for Status readouts is:

®  Yellow: Indicates that the alarm occurred within the last five seconds but has
cleared.

®  Red: Indicates an ongoing error.

The Additional Information column provides explanatory information. For
example, if an Audio Signal Loss alarm is triggered, the text 123--678 may
appear under Additional Information. These numbers indicate the audio channels
mapped to level meter bars 1, 2, 3, 6, 7, and 8 triggered the alarm.

NOTE. Different tiles can be set to display different screens under the Status
button. You can display up to four Status screens at the same time.
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Displaying Errors

You view errors in the Error Log which is displayed in the Status window. See
Figure 3-22.

Error Status Log Page1of 6

Error Status

Log Server State (Running)

Video Input (SDI A)

Ref Input Source (Cmpst A/B)

Ref Video Standard (Auto NTSC)

SDI Video Standard (Auto 525 59.94) 19:35:
19:35:17

Audio Input Source (none)
Audio Input Source (Embedded A)

SDI Video Standard (Awutc

:35:20
19:35:38
19:35:38

e WED JAN 22 19:47:36 ID: WYRG10

SDI Input B . Py PPPP ———
Ref: Internal Tekt I'OI'l"l\

Figure 3-22: Error log display

To view the Error Log:

1.
2.

Select the tile where you want the Error Log displayed.

Press the STATUS button. If the Error Log page is not displayed, press and
hold the STATUS button to display the STATUS menu.

Select Display Type from the menu.

Press the right-arrow key to change the menu focus to the Display Type
submenu.

Select Error Log.
Press STATUS again to remove the menu.

If the log is longer than a single page (see the upper-right corner of the
display), you can scroll through the log by using the GENERAL knob or the
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Elements of the Display
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left-right arrow keys. You can display the first page of the log by pressing
the up-arrow key or the last page of the log by pressing the down-arrow key.

NOTE. The Error Log displayed is only for the currently selected video and audio
inputs.

There are three columns in the Error Log display: Error Status, VITC/LTC, and
Time.

The Error Status column lists the errors that have occurred and changes in the
instrument state. This is a history of errors and settings changes.

Entries for audio errors will include a string of numbers. The numbers indicate
the level meter bar that triggered the error. For example, you might see Audio
Signal Loss (123456--) displayed. This string indicates that the signals mapped
to level meter bars 1-6 are missing. (For information on Input to Bar Maps, see
page 2-61).

Entries in the Error Status column appear in color to indicate the current state of
the entry. The colors of the entries are as follows:

B White: Identifies items that are informational. These represent changes in
the instrument state. For example, you might see Log Server State
(Running) displayed. This entry indicates that error logging was started at
the indicated time.

B Green: Identifies that an error has cleared.
B Red: Identifies that an error is triggered.
The Error Status Log also displays icon next to the entries to provide a quick

indication of the type of entry. See Table 3-4.

Table 3-4: Error status log icons

Icon Description

state, such as a change in the video input source.

Identifies entries that are informational in nature. The entry
does not represent an error, but usually changes in instrument
. A red-colored icon that indicates the start of an ongoing error.
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Table 3- 4: Error status log icons (Cont.)

Icon Description

A red-colored icon that identifies a transient error.

. A green-colored icon that indicates an when error has cleared.

The VITC/LTC column shows the time, according to the VITC or LTC in the
signal, that the error occurred, and in the case of ongoing errors, the VITC/LTC
at which the error first occurred.

The Time column shows the time, according to the internal clock, that the error
occurred.

In the Alarm Log, some events may appear out of sequence within the one
second resolution of the log. For example, when you change input the instrument
may register a few log entries from the previous input after the input change is
registered. Time stamping may also be out of sequence within a one second
interval. If you change from SDI with time code to Composite without a time
code, you may see a few entries with time stamp after the switch because
changes in the instrument state are logged immediately, while changes in the
alarms need time to filter through the detection circuits and code.

Displaying Video Session Status

The waveform rasterizer maintains a history, or log, of video alarms. The Video
Session display type in the STATUS menu shows this history. The Video Session
display contains a number of statistics that show the alarms that have been
triggered since the last time the logging was reset. See Figure 3-23.
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Resetting Video Session
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Statistics

Video Session

Input: SDI A Data Collect:
Signal: Auto 525 59.94 Runtime:
Signal Lock:

EDH: Missing RGB Gamut:
FF Error Seconds: 0 Error fields:
FF Status: Missing % Error fields:
AP Error Seconds: 0
AP Status: Missing Cmpst Gamut:
Error fields: 9750099
0 % Error fields: 99.4537 %

Luma Gamut:

2 AP CRC: Error Fields: 582
% Error fields: 0.0059 %

Changed since reset:

4 SUN JUL 13 13:06:54 ID: WYRG102

525
SDI Input A - 2 Audio Input:
Ref: Internal Tektronix

Figure 3-23: Video session status display for an SDI input

To display the Video Session status:
1. Select the tile where you want the Video Session displayed.

2. Press the STATUS button. If the Video Session page is not displayed, press
and hold the STATUS button to display the STATUS menu.

3. Select Display Type from the menu.

4. Press the right-arrow key to change the menu focus to the Display Type
submenu.

5. Select Video Session.

6. Press STATUS again to remove the menu.

The statistics on the Video Session page continue to accumulate until you
manually restart the data collection or cycle the power on the instrument.

NOTE. The Audio Session and Video Session display are tied to each other. If you
reset the statistics for either one, it resets the statistics for the other also.

To reset the Video Session statistics from the STATUS pop-up menu:

1. Press and hold the STATUS button to display the STATUS menu.
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While the STATUS pop-up menu is displayed, the word Paused appears in
the upper left-hand corner of the tile. While the pop-up menu is displayed,
the statistics in the tile are not updated. Even though the update of the
display is paused, internally the statistics continue to be updated. If you
remove the pop-up without making any change, the displayed statistics will
be updated immediately.

2. Select Sessions Reset.
3. Press SEL to reset the session statistics.

An alternate way to reset the Video Session statistics is to press SEL.

Stopping and Restarting  You can stop the update of the statistics display without clearing the accumulated
Video Session Updating  statistics.

There are two similar modes in the video session screen, Stopped and Frozen.
Stopped is controlled by pressing the front-panel arrow keys. When stopped, the
instrument stops accumulating data into the error statistics such as Runtime and
EDH error seconds. The real time portions of the display continue. Frozen is
controlled using the Freeze front-panel button. When frozen, all fields of the
display stop updating, but the statistics continue to accumulate in the instrument.
When the display is un-frozen, the statistic readouts will jump to the new value.
The stopped mode is useful to prevent logging errors that are anticipated, for
example, errors from switching inputs. The frozen mode is useful for capturing
an event like a state where multiple errors exist or a specific EDH checksum is
present.

To stop the update of Video Session statistics:
1. Press and hold the STATUS button to display the STATUS menu.

While the STATUS pop-up menu is displayed, the word Paused appears in
the upper left-hand corner of the tile. While the pop-up menu is displayed,
the statistics in the tile are not updated. Even though the update of the
display is paused, internally the statistics continue to be updated. If you
remove the pop-up without making any change, the displayed statistics will
be updated immediately.

2. Select Sessions Stop.

3. Press SEL to stop updating the sessions statistics.

To restart the update of Video Session statistics:

1. Press and hold the STATUS button to display the STATUS menu.
2. Select Sessions Start.

3. Press SEL to start updating the sessions statistics.
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An alternate way to stop and start the Video Session statistics is to press one of
the arrow keys.

Video Session Display for SDI Inputs

Miscellaneous Section

3-52

This section describes each of the elements of the Video Session display when
SDI A or B is the selected input.

There are three sections to the display: miscellaneous information, EDH status,
and Gamut status. The miscellaneous information section displays information
about the signal and the session. The EDH status (Error Detection and Handling)
section displays the EDH status, and the Gamut status section displays the gamut
status. See Figure 3-24.

Video Session

Input: SDI A Data Collect: Running B
Signal: Auto 525 59.94 Runtime: 1d, 21:35:25 _Mlsce"a.neous
Signal Lock: information

EDH:
FF Error Seconds: sz
FF Status: Missing % elds:
AP Error Seconds: 0
AP Status: Missing Cmpst Gamut:
Error fields: 9750099
EDH Error Fields: 0 % Error fields: 99.4537 % & Gamut status
EDH Error Fields %: 0.0000 %
F1 AP CRC: 0000 h Luma Gamut:
F2 AP CRC: 0000 h Error Fields: 582
% Error fields: 0.0059 %

Changed since reset: Yes

EDH status

SUN JUL 13 13:06:54

Tektronix

Figure 3-24: Sections of video session display

The following information appears in the Miscellaneous section of the Video
Session display:

Input. Shows the selected input source: SDI A or SDI B.

Signal. Displays the format of the input signal in the following order: number of
lines, scan type and field rate.
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Signal Lock. Indicates whether or not the waveform rasterizer is locked to the
selected input.

Data Collect. Displays the state of error gathering. Possible states are:

B Running - Indicates errors are being gathered and displayed on the status
page.

®m  Stopped - Indicates errors are not being gathered. The status page is not
being updated.

B Resetting - Appears briefly after SEL has been pressed to reset the
statistics.

Runtime. Indicates the time since the last reset occurred. Time is displayed as
“DD, HH:MM:SS”, where DD is the number of days, HH is the number of
hours, MM is the number of minutes, and SS is the number of seconds.

EDH Section  The following information appears in the EDH section of the Video Session
display:

EDH. Displays the current condition of the EDH packet (for full details on EDH,
see SMPTE RP165). The possible values are:

B Valid - Indicates the EDH packet is present and that the embedded CRC
value matches the calculated CRC value.

®  Invalid - Indicates the EDH packet is present but there is no CRC value
embedded or that it is corrupted.

B Missing - Indicates that the EDH packet is missing, which probably means
that the EDH packet was not inserted by the source.

B Error - Indicates that an EDH packet is present, but the embedded CRC
value does not match the calculated CRC value, and thus a transmission
error has occurred. The Error indicator is displayed for one second after an
€ITOr OCCUrS.

FF Error Seconds. Displays the number of seconds containing at least one error
detected in either the active or blanking portion (Full Field) of the video signal.

FF Status. Displays the Full Field status of the video signal. Status can be:

®  Valid - Indicates the embedded CRC value matches the calculated CRC
value.

WVR610A & WVR611A Waveform Rasterizers User Manual 3-53



Configuring Alarms and Viewing Status

3-54

®  Invalid - Indicates the no CRC value was embedded or that it is corrupted.

B Missing - Indicates that the EDH packet is missing, which probably means
that the EDH packet was not inserted by the source.

B Error - Indicates that the embedded CRC value does not match the
calculated CRC value, and thus a transmission error has occurred. The Error
indicator is displayed for one second after an error occurs.

AP Error Seconds. Displays the number of seconds containing at least one error
detected only in the active picture (AP) portion of the video signal.

AP Status. Displays the status of the Active Picture portion of the video signal.
Status can be:

®  Valid - Indicates the embedded CRC value matches the calculated CRC
value.

®  Invalid - Indicates the no CRC value was embedded or that it is corrupted.

B Missing - Indicates that the EDH packet is missing, which probably means
that the EDH packet was not inserted by the source.

®  Error - Indicates that the embedded CRC value does not match the
calculated CRC value, and thus a transmission error has occurred. The Error
indicator is displayed for one second after an error occurs.

EDH Error Fields. The number of fields that contained an EDH error since the last
reset.

EDH Error Fields %. A calculated number listing the percentage of fields that
contained at least one EDH error since the last reset.

F1 AP CRC. A display of the active picture CRC value for field one. (This value
is sampled once a second.)

F2 AP CRC. A display of the active picture CRC value for field two. (This value
is sampled once a second.)

Changed since reset. Indicates if either the F1 or F2 AP CRC values have
changed since the last reset. This useful for detecting errors on static images that
do not have EDH.
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RGB Section  The following information appears in the RGB section of the Video Session
display:

RGB Gamut. The SDI input signal is evaluated against the thresholds set for the
Diamond display in the CONFIG > Gamut Thresholds submenu. RGB Gamut
displays OK if there are currently no gamut errors. If there is an error, a string of
letters or dashes is displayed to indicate which thresholds have been exceeded.
Each of the thresholds is identified by a letter in the string RrGgBb where an
uppercase letter corresponds to the maximum threshold and a lowercase letter
corresponds to the minimum threshold. A dash indicates that the signal is within
the corresponding threshold. Red indicates a current gamut error. Yellow
indicates a gamut error within the last 5 seconds.

Error Fields. The number of fields that contain at least one RGB error since the
last reset.

% Error Fields. The percentage of all fields that contained at least one RGB error
since the last reset. This is a calculated number.

CMPST Section  The following information appears in the Cmpst section of the Video Session
display:

Cmpst Gamut. The SDI input signal is evaluated against the thresholds set for the
Arrowhead display in the CONFIG > Gamut Thresholds submenu. Cmpst Gamut
displays OK if there are currently no gamut errors. If there is an error, a string of
letters or dashes is displayed to indicate which thresholds have been exceeded.
Each of the thresholds is identified by a letter in the string Cc where the
uppercase letter corresponds to the maximum threshold and the lowercase letter
corresponds to the minimum threshold. A dash indicates that the signal is within
the corresponding threshold. Red indicates a current gamut error. Yellow
indicates a gamut error within the last 5 seconds.

Error Fields. The number of fields that contain at least one Cmpst error since the
last reset.

% Error Fields. The percentage of all fields that contained at least one Composite
error since the last reset. This is a calculated number.
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Luma Section

The following information appears in the Luma section of the Video Session
display:

Luma Gamut. The SDI input signal is evaluated against the thresholds set for
Luma in the CONFIG > Gamut Thresholds submenu. Luma Gamut displays OK
if there are currently no gamut errors. If there is an error, a string of letters or
dashes is displayed to indicate which thresholds have been exceeded. Each of the
thresholds is identified by a letter in the string LI where the uppercase letter
corresponds to the maximum threshold and the lowercase letter corresponds to
the minimum threshold. A dash indicates that the signal is within the corre-
sponding threshold. Red indicates a current gamut error. Yellow indicates a
gamut error within the last 5 seconds.

Error Fields. The number of fields that contain at least one Luma error since the
last reset.

% Error Fields. The percentage of all fields that contained at least one Luma error
since the last reset. This is calculated number.

There is one other readout that appears on the display, but it only appears when
you press FREEZE.

Frozen <date> <time>. When you press FREEZE, an image of the display is
captured and stored in memory. You can view the frozen image by pressing
FREEZE to display the pop-up menu and selecting Display Mode > Frozen
Only. This state is useful for looking at EDH (Error Detection and Handling)
CRC (Cyclic Redundancy Check) values on live video. Note that the frozen
image will remain in memory until you delete the image. You cannot freeze
another image if there is already a frozen image in memory.
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Video Session Display for Composite Inputs

This section describes each of the elements of the Video Session display when
CMPST A or B is the selected input. See Figure 3-25.

Frozen Video Session

Input: Cmpst B
Format: Auto PAL
Signal Lock:

Sync AFC Speed: Fast
DC Restore: Fast
NTSC Setup: On

NTSC 59.94 WED JAN 22 19:55:59

Cmpst Input A . =
Ref: Ext PAL Tekt 1'011/])(

Figure 3-25: Video session status display for a CMPST input

Input. The selected input source: CMPST A or CMPST B.

Format. Displays the format of the input signal, either PAL or NTSC.

Signal Lock. Indicates whether the signal is locked or unlocked.

Sync AFC Speed. Displays the Sync AFC Speed setting: Fast or Slow.

DC Restore. Displays the DC Restore setting: Fast, Slow, or Off.

NTSC Setup. Displays the NTSC Setup setting: Off or On.

WVR610A & WVR611A Waveform Rasterizers User Manual 3-57



Configuring Alarms and Viewing Status

Check Audio Status

You can check audio status in three ways, by looking at the Audio Session
display, the Alarm Status display or the Error Log. The three ways provide
different views of the audio status.

Audio Session. The Audio Session display shows which audio alarms that have
been triggered since the last reset of the error log with additional information
about the signal level. See Table 3-5. The Audio Session displays error
information by channel. It displays how many times errors have occurred but not
when they occurred.

Alarm Status. The Alarm Status display provides an instantaneous view of all
enabled alarms, not just audio alarms. The Alarm Status page indicates whether
or not an error or alarm is currently triggered. It does not indicate how many
times an error has occurred or when it occurred.

Error Log. The Error Log display provides a chronological list of all the errors
and alarms that have occurred since the error log was reset. While the error log
displays exactly when an event occurred (using VITC/LTC when present and
clock time) it does not provide a statistical view of the recorded errors or alarms
(that is, the number of times an error has been triggered).

Audio Session Display = The Audio Session display is a historical readout of the audio status. The period
covered by the Audio Session display is the time since the last reset.

To check the history of audio status:
1. Press the STATUS button to set the active tile to the status mode.
2. Press and hold the STATUS button to display the menu.

3. Set the Display Type to Audio Session. See Figure 3-26.
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Audio Session

Aundio Input: Embedded B Data Collect: Running
Signal Loss: Runtime: Error

Audio Output O: pair 1 I: pair 2 2 pair 3

Channel

Clip
Mute
Over

Silence

Peak (db) 13 — 2.98 -20.00  -20.00
High (db) v 3.03 -20.00  -20.00
Active bits: 2 0

Smpl Rate 0

Changed since reset: Yes

SAT JAN ( 12

Tektro ix

Figure 3-26: Audio session display

Elements of the Audio
Session Display

The following paragraphs describe each of the elements of the Audio Session

display.

The center portion of the display shows the alarms that have been triggered by
channel. It also displays additional measurements and data by channel. Table 3-5
details the readouts that appear in the Audio Session display.

Table 3-5: Audio session readouts

Readout Description

Audio Input The audio source.

Data Collect Indicates if logging is running, stopped, or frozen.

Signal Loss Indicates the level meter bars (1-8) that have triggered a signal
loss alarm. Dashes indicate no alarm has been triggered.

Runtime The elapsed time since the last time the session was restarted.

Audio Output Identifies which level meter bar pair has been mapped to which
Analog Output.

Clip The number of CLIPs detected during the session'.

Mute The number of MUTES detected during the session2.

Over The number of OVERs detected during the session.

Silence The number of SILENCEs detected during the session.

Peak (dB) The True Peak signal level measured on the channel.
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Resetting the Audio
Session Statistics

Table 3-5: Audio session readouts (Cont.)

Readout Description

High (dB) The highest signal level measured by the signal level meter.
The level meter response is based on the Ballistics setting. If
ballistics is set to True Peak, this readout will be the same as
the Peak readout.

Active bits The number of active bits in the channel.
Smpl Rate The sample rate of the channel pair.
Changed since reset - Either Yes or No. Indicates whether an error has occurred since

the last reset

1" The number of Audio Clips reported is directly affected by the #Samples for Clip
setting in the CONFIG > Audio Displays submenu. See page 2-52.

2 The number of Audio Mutes reported is directly affected by the #Samples for Mute
setting in the CONFIG > Audio Displays submenu. See page 2-52.

The values for the Clip and Mute readouts appear in color to indicate status. The
colors of the reported values are as follows:

®  Yellow: Indicates that the alarm occurred within the last five seconds but has
cleared.

B Red: Indicates an ongoing error.

The Clip and Mute parameters are only displayed for digital audio feeds. Silence
and Over are available for both digital and analog feeds.

The statistics on the Audio Session page continue to accumulate until you
manually clear and restart the data collection or cycle the power on the instru-
ment.

NOTE. The Audio Session and Video Session display are tied to each other. If you
reset the statistics for either one, it resets the statistics for the other also.

To reset the Audio Session statistics:

1. Press and hold the STATUS button to display the STATUS menu.
2. Select Sessions Reset.

3. Press SEL to reset the sessions statistics.

An alternate way to reset the Audio Session statistics is to press SEL.
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Stopping and Restarting  You can stop the update of the statistics display without clearing the accumulated
Audio Session Updating statistics.

There are two similar modes in the audio session screen, Stopped and Frozen.
Stopped is controlled by pressing the front panel arrow keys. When stopped, the
instrument stops accumulating data into the error statistics such as runtimes. The
real-time portions of the display continue. Frozen is controlled using the Freeze
front-panel button. When frozen, all fields of the display stop updating, but the
statistics continue to accumulate in the instrument. When the display is
un-frozen, the statistic readouts will jump to the new value. The stopped mode is
useful to prevent logging errors that are anticipated, for example, errors from
switching inputs. The frozen mode is useful for capturing an event like a state
where multiple errors exist or a specific EDH checksum is present.

To stop the update of Audio Session statistics:
1. Press and hold the STATUS button to display the STATUS menu.

While the STATUS pop-up menu is displayed, the word Paused appears in
the upper left-hand corner of the tile. While the pop-up menu is displayed,
the statistics in the tile are not updated. Even though the update of the
display is paused, internally the statistics continue to be updated. If you
remove the pop-up without making any change, the displayed statistics will
be updated immediately.

2. Select Sessions Stop.

3. Press SEL to stop updating the sessions statistics.

To restart the update of Audio Session statistics:

1. Press and hold the STATUS button to display the STATUS menu.
2. Select Sessions Start.

3. Press SEL to start updating the sessions statistics.

An alternate way to stop and start the Audio Session statistics is to press one of
the arrow keys.

Embedded Audio Status. The WVR610A & WVR611A with audio option DG or
DA can monitor audio embedded in the serial digital video ancillary data
packets. For any 4-channel pairs, the WVR610A & WVR611A can display bars,
Phase (Lissajous), and check for alarms. On all 8 channel pairs, the WVR610A
& WVR611A can monitor for presence.

When the selected audio input is “Embedded”, a string of characters are
displayed in the right corner of the status bar. The 16-character string denotes the
status of each embedded audio channel. Each character shows the status of a
specific channel. The characters displayed are as shown in Figure 3-27.
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ID: WVRG11_2E3138

PPPP ———— ———m o Embedded status readout
VITC: 08:35:27:06:0

Figure 3-27: Embedded audio status display

Table 3-6 describes the readouts for embedded audio status.

Table 3-6: Embedded audio status bar readouts

Displayed character Description
P Denotes that the channel is present

- Denotes that the channel are not present

For other audio inputs, a readout indicating analog or AES will be present.

Displaying Audio Status  To get a instantaneous view of the audio status, use the Alarm Status display in
the STATUS menu. Note that in addition to audio errors, the Alarm Status
display shows all alarms that have been triggered.

To display audio alarm status:

1. Press the STATUS button to set the active tile to the Status mode.
2. Press and hold the STATUS button to display the pop-up menu.
3. Set the Display Type to Alarm Status. See Figure 3-28.
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Paunsed Alarm Status Pagelof 2
Alarm Status Additional Information

Hardware Fault

SDI Input Missing

SDI Input Signal Lock

External Reference Missing

External Reference Sig Lock

RGB Gamut Error RrGgBb
Composite Gamut Error

EDH Error

Embedded Audio Missing 1234567890123456
Embedded Audio Chksum

Embedded A: Buffer Full

Embedded : > Buffer Empty

Embedded Aundio Parity

Audio Signal Loss

Audio CRC Error

Audio Valid Bit

Audio Parity Error

Audio Clip

Audio Over Level

Audio Mute

Andin Internal Error
lisabled
Mute Alarms lisabled

525 59.94
SDI Input A
Ref: Internal

Tektronix

Figure 3-28: Alarm display showing audio errors

Elements of the Display =~ There are three columns in the Alarm Status display: Alarm, Status, and
Additional Information.

The Alarms column lists the all the types of alarms that can be detected. For
each alarm type, errors will be reported if any reporting method is enabled in
CONFIG > Alarms menu. If no reporting method is enabled, that alarm type will
show “Disabled” on the Alarm Status page.

The Status readout text is either OK or ERROR. If the text is OK, that means
that the alarm is not being triggered or has not been triggered within the last five
seconds. ERROR means that an alarm is occurring or has occurred within the
last five seconds.

The meaning of the color for Status readouts is:

®  Yellow: Indicates that the alarm occurred within the last five seconds but has
cleared.

B Red: Indicates an ongoing error.

The Additional Information column provides explanatory information. For
example, if an Audio Signal Loss alarm is triggered, the text 123--678 may
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appear under Additional Information. These numbers indicate the audio channels
mapped to level meter bars 1, 2, 3, 6, 7, and 8 triggered the alarm.

NOTE. Different tiles can be set to display different screens under the Status
button. You can display up to four Status screens at the same time.

ErrorLog  To see when audio alarms were triggered, use the Error Log display in the
STATUS menu. Note that in addition to audio alarms, the Error Log display
shows all alarms that have been triggered.

To view audio errors on the Error Log display:

1. Press the STATUS button to set the active tile to the Status mode.
2. Press and hold the STATUS button to display the pop-up menu.
3. Set the Display Type to Error Log. See Figure 3-29.

Error Status Log Page 6 of 13

Error Status

SDI Video Standard (Auto 525 59.94)

Video Input (SDI B)

Audio Input Source (Embedded B)

SDI Video Standard (Auto 525 59.94)

SAT JAN 04 1819:39
Tektr(m/ix

Figure 3-29: Error log displaying audio errors
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Elements of the Display =~ There are three columns in the Error Status display: Error Status, VITC/LTC,
and Time.

The Error Status column lists the errors that have occurred and changes in the
instrument state. This is a history of errors and settings changes.

Entries for audio errors will include a string of numbers. The numbers indicate
the level meter bar that triggered the error. For example, you might see Audio
Signal Loss (123456--) displayed. This string indicates that the signals mapped
to level meter bars 1-6 are missing. (For information on Input to Bar Maps, see
page 2-61).

Entries in the Error Status column appear in color to indicate the current state of
the entry. The colors of the entries are as follows:

B White: Identifies items that are informational. These represent changes in
the instrument state. For example, you might see Log Server State
(Running) displayed. This entry indicates that error logging was started at
the indicated time.

m  Red: Identifies errors that are ongoing.

®m  Green: Identifies errors that occurred in the past but are no longer occurring.
For errors entries that appear in green, you can always find a corresponding
preceding error in red.

The Error Status Log also displays icon next to the entries to provide a quick
indication of the type of entry. See Table 3-7.

Table 3- 7: Error status log icons

Icon Description

A white-colored icon that identifies entries that are information-
al in nature. The entry does not represent an error, but usually
changes in instrument state, such as a change in the video
input source.

A red-colored icon that identifies the start of an ongoing
(continuous) error.

A red-colored icon that identifies a transient error.

A green-colored icon that identifies an error that occurred in the
past but has now cleared.

The VITC/LTC column shows the time, according the VITC or LTC in the
signal, that the error occurred. In the case of ongoing errors, the VITC/LTC
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column shows the time at which the error first occurred. In the case of errors that
have cleared, the VITC/LTC column shows the time at which the error cleared.

The Time column show the time, according to the internal clock, that the error
occurred.

Controlling Error Logging

Displaying Pages of the
Error Log

3-66

The waveform rasterizer can log errors to a internal file, providing you with a
history of recorded errors. See Figure 3-30. This file can be downloaded to your
PC for analysis using the web interface. You can turn logging on or off and you
can reset the log file to clear it of all entries. The error log can hold up to 10,000
entries or about 513 “pages” of entries. When the error log fills, entries continue
to be added to the end of the log as entries are deleted from the beginning of the
log.

Error Status Log Page 14 of 15

Error Status

94 SAT JAN 0418 ) ID: WVR611_2F3138
SDI Input B Toktr 2 PPPP
npu Iektronix S >

Ref: Internal

Figure 3-30: Error status log

Because the error log is a history of errors, you will want to page through the
listing of errors to determine when an error first occurred. To change the page of
the error log that is displayed, press the arrow keys.
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Press the up arrow to
display the first page

Press the left arrow to Press the right arrow to
display the previous page display the next page

Press the down arrow to
display the last page

Figure 3-31: Use the arrow keys to navigate the error log

Activating Logging  To activate logging:
1. Press and hold the STATUS button to display the STATUS menu.
2. Select Logging Active. See Figure 3-32.
3. Press SEL or the right-arrow key to select On.
4

Press STATUS again to remove the menu.

Display Type Error Log / ..
Mute Alarms Off

On
Logging Reset Press SEL to Resat

Figure 3-32: Activating logging

Resetting the Log File  To reset or clear the log of all entries:
1. Press and hold the STATUS button to display the STATUS menu.
2. Select Logging Reset. See Figure 3-32.
3. Press SEL to reset the log.
4

Press STATUS again to remove the menu.

NOTE. The error log is lost if power is removed from the waveform rasterizer.
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Appendix A: Specifications

The tables in this appendix list the specifications for the Tektronix WVR610A &
WVR611A Waveform Rasterizers. Items listed in the Performance Requirement
column are generally quantitative, and are either tested by the Performance
Verification procedure in the Service Manual or are guaranteed by design. Items
listed in the Reference Information column are useful operating parameters that
have typical values; information in this column is not guaranteed.

The specifications listed in the Electrical Specifications portion of these tables
apply over an ambient temperature range of +0 °C to +50 °C. The rated

accuracies are valid when the instrument is calibrated in an ambient temperature
range of +20 °C to +30 °C.

Electrical Specifications

Table A-1: SDI Input waveform vertical characteristics

Characteristic

Performance requirement

Reference information

Displayed Vertical Gain Accuracy

At X1, £0.5% Gain of 700 mV full scale
mode

At X5, +0.2% Gain of 700 mV full scale

YPbPr signal from a 4:2:2 digital signal
generator as measure in YPbPr mode.
Limited by display resolution, measured

using Graticules or Cursors. Any one of the

mode three channels.

Variable Gain Range, Typical

0.25X to 10X

Frequency Response
Luminance Channel (Y)

t0 5.75 MHz, +0.5%

RGB monochrome identical to Y channel.

Chrominance Channels (Pb, Pr)

t0 2.75 MHz, +0.5%

Transient Response
Preshoot
Overshoot
Sine-Squared Bars
Ringing
Sine-Squared Bars

< 0.3% peak (2T5 bar)
< 0.3% peak (2T5 bar)
< 0.3% peak (2T5 bar)

= 0.8% peak-peak (2T5 bar)

Pulse-to-bar ration 0.99:1 to 1.01:1 on
appropriate Sine-squared or Blackman 2T
pulse.

Tilt, Typical
Field Rate

<0.1%
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Table A-1: SDI Input waveform vertical characteristics (Cont.)

Characteristic

Performance requirement

Reference information

Line Rate

<0.1%

Off Screen Recovery, Typical

< 0.1% variation in baseline of a 5 MHz
modulated pulse when positioned any-
where on screen

X1, X5 or any variable gain setting

RGB Transcoder Accuracy

+0.1%

Bit Integrity

Accurately shows both 8 and 10-bit signals

Table A-2: Serial digital video (SDI inputs A and B) interface physical layer characteristics

Characteristic Performance requirement Reference information

Formats Supported 270 Mb/s component. Complies with
SMPTE 259M and CCIR 656.

Input Level 800 mV peak-to-peak + 10% Input voltages outside this range may
cause reduced receiver performance.

Input Type Passive loopthrough 75 €2, compensated

Return Loss

= 25 dB from 1 to 270 MHz, power on
= 15 dB from 1 to 270 MHz, power off

Insertion Loss (Loopthrough)

< 1.2dBto 270 MHz

Checked indirectly via return loss and
equalization range

Loopthrough Isolation

= 50 dB to 300 MHz

Serial Receiver Equalization Range

Proper operation with up to 23.0 dB loss at
135 MHz using coaxial cable having a
1/n/F loss characteristics. 800 mV launch
amplitude per SMPTE 259M.

230 meters using Belden 8281 coaxial
cable, typically 300 meters

Input Time Base Range

270 Mbits/s +50ppm

Many functions continue to operate to a
wider range, typically 1000 ppm.

Table A- 3: Composite analog input waveform vertical characteristics

Characteristic

Performance requirement

Reference information

Displayed Vertical Gain Accuracy

+ 1% all Gain settings

Measured using graticules

Variable Gain Range, Typical

0.25X to 10.0X

Frequency Response

flat to 5.75 MHz, +1%
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Table A-3: Composite analog input waveform vertical characteristics (Cont.)

Characteristic

Performance requirement

Reference information

Delay Variation over Frequency

+10nsto5.75 MHz

Transient Response

Pulse-to-Bar Ratio

0.99:1t01.01:1

Measured using Sine-squared 2T4 pulse
and bar

Pre-shoot < 1%

Overshoot < 1%

Ringing = 1%
Tilt, Typical

Field Rate <0.5%

Line Rate <0.5%

Off Screen Recovery, Typical

< 0.5% variation in baseline of a Chroma
modulated pulse when positioned any-
where on screen

X1, X5 or any variable gain setting

Table A-4: Composite analog inputs A and B physical layer characteristics

Characteristic

Performance requirement

Reference information

Formats Supported

NTSC, NTSC no setup, and PAL, |, B, Q,
G. Complies with RS170A and ITU-R
BT.471

Manual or auto detect of input standard

Internal Reference

Proper horizontal and vertical synchroniza-
tion with a composite signal of appropriate
line and field rate.

Input Dynamic Range, typical

+6dB

Video Maximum Operating Amplitude,
typical

-1.8 Vto +2.2 V dc + peak ac (all inputs)

Maximum Absolute Video Input Amplitude -8.5V1to +8.5V dc + peak ac
Input Type Passive loopthrough 75 €2, compensated
DC Input Impedance 20 kQ

Return Loss

= 40 dB to 6 MHz, power on

Typically > 46 dB to 6 MHz, power on,
> 35 dB to 6 MHz, power off for standard
amplitude video

Video Input Cross-talk Between Channels

= 60 dB to 6 MHz

Loopthrough Isolation

= 70 dB to 6 MHz
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Table A-4: Composite analog inputs A and B physical layer characteristics (Cont.)

Characteristic

Performance requirement

Reference information

DC Offset with Restore Off

< 20 mV typical, Measured in full screen
mode at X5 vertical gain

DC Restore Modes Fast, Slow and Off modes Slow has a typical bandwidth of 10 Hz,
Fast has a typical bandwidth of 500 Hz.

DC Restore Offset Error =2mV Registration between back porch and 0 V
graticule

DC Offset Between Inputs =7mV

DC Restore 50 and 60 Hz Attenuation,
typical

Fast Mode >95% attenuation

Slow Mode < 10% attenuation

Off Mode
Blanking Shift with 10 to 90% APL Change < 1IRE (7 mV PAL)
Blanking Shift with Presence and Absence =< 1IRE (7 mV PAL)
of Burst .
Typically 3 mV
Lock Range + 50 ppm Remains locked

Lock in Presence of Hum

+ 1V peak-to-peak

On 0 dB signal, remains locked

Lock in Presence of White Noise

Signal/Noise ratio of 32 dB

5 MHz bandwidth on black burst, remains
locked

Color Framing

Correct color framing detected for signals
having < 45° SCH Phase Error and burst
is present

Error Reporting

Should report CPU-readable error condi-
tions, for example, no input present,
unlocked, etc.

Clamp Range

Can correct signals with backporch within
1V of ground.

Sync AFC Speed

User selectable setting of Fast or Slow
response to line rate variations. Typical
bandwidth of 600 Hz (Fast) and 10 kHz
(Slow)
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Table A-5: External reference characteristics

Characteristic

Performance requirement

Reference information

Formats Supported

NTSC and PAL complies with RS170A and
ITU-R BT.471.

Proper horizontal and vertical synchroniza-
tion with a composite signal of appropriate
line field rate.

Input Dynamic Range, Typical

+ 6dB

Absolute Maximum Input Voltage, Nominal

+ 8.5V DC plus Peak AC

Input Type

Passive loopthrough 75 €, compensated

DC Input Impedance, Nominal

20 k2

Return Loss

= 40 dB to 6 MHz, power on

Typically > 46 dB to 6 MHz, power on,
> 35 dB to 6 MHz, power off for standard
amplitude video

Timing Shift with 10 to 90% APL Change

< 0.5ns

Timing Shift with Hum

< 20 ns with 0 dB hum

Lock Range

+ 50 ppm, remains locked

Lock in Presence of Hum

+1.0 V peak-to-peak, on 0 dB signal,
remains locked

Lock in Presence of White Noise

Signal/Noise ratio of 32 dB, 5 MHz
bandwidth on black burst, remains locked

Color Framing

Correct color framing detected for signals
having <45° SCH Phase Error and burst
is present

Error Reporting

Should report CPU-readable error condi-
tions, for example, no input present,
unlocked, etc.

Zero Timing Offset

For correctly timed input, should see
minimal shift on the WFM display between
internal and external mode.

For vertical timing, conforms to SMPTE168
- 2002. That is, the lines with the start of
the broad pulses are aligned.

For Horizontal timing, zero delay analog
signals have coincident syncs. For digital
signals timing is such that if convert to
analog via a WFM601a then resultant
analog signal is coincident with the
reference.

Sync AFC Speed

User selectable setting of Fast or Slow
response to line rate variations. Typical
bandwidth of 600 Hz (Fast) and 10 kHz
(Slow)
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Table A- 6: Waveform sweep (horizontal) characteristics

Characteristic Performance requirement Reference information

Sweep Timing Accuracy +0.1% All Sweep and Mag modes, limited by
display resolution, measured using
graticules or cursors. Guaranteed by digital
design. Input time base within +10 PPM.

Sweep Linearity +0.1% Guaranteed by digital design.
Sweep Rates, Normal
1 Line 5 us/division Numbers shown for overlay, parade modes
are scaled appropriately.
2 Line 10 ps/division ppropristely.
1 Field 1.5 ms/division for 60 Hz signals, 1 Field displays one full field, including field
! 2 ms/division for 50 Hz signals rate sync. 2 Field displays two full fields
2 Field and the field rate sync between them.

3 ms/division for 60 Hz signals,
4 ms/division for 50 Hz signals

Sweep Rates, Mag

1 Line 0.2 us/division Mag occurs around center of sweep
2 Line 1 us/division 2 line and 2 field Mag modes optimized to
3 Line 1 us/division display blanking intervals.
4 Line 1 us/division
1 Field 75 us/division for 60 Hz signals,
100 us/division for 50 Hz signals
2 Field 150 us/division for 60 Hz signals,

200 us/division for 50 Hz signals

3 Field 75 us/division for 60 Hz signals,
300 us/division for 50 Hz signals

4 Field 150 us/division for 60 Hz signals,
400 ps/division for 50 Hz signals

Horizontal Position Range, Nominal Any portion of the synchronized sweep can
be positioned on screen in all sweep
modes. Any portion of the sweep can be
set to the middle of the screen in non-mag
mode.
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Table A-7: Waveform mode filter characteristics

Characteristic

Performance requirement

Reference information

Low Pass Filter Gain, Component Only

1 +0.1% relative to flat gain

Low Pass Filter Frequency Response,
Component Only

< 3 dB attenuation at 800 kHz
= 32 dB attenuation at 3 MHz

Filter meets STD-205.

Luma Filter Gain, Composite Only

1 +0.1% relative to flat gain at 50 kHz

Luma Filter Response, Composite Only

< 3 dB attenuation at 800 kHz

= 40 dB attenuation at Fg

Same as component low pass filter.
Filter meets STD-205.

Chroma Filter Gain, Composite Only

1 £0.1% relative to flat gain.

Chroma Filter Response, Composite Only

3 dB bandwidth is 1 MHz + 0.2 MHz.

Centered on fg. Implemented digitally.

Chroma Filter Attenuation at 2X Fgg,
Composite Only

= 25dB

Typically 28 dB for NTSC, 53 dB for PAL

Table A-8: Component vector mode

Characteristic

Performance requirement

Reference information

Vector Display

Pg is displayed on horizontal axis and PR is
displayed on vertical axis

Vector Position Behavior

Graticules and waveform move together
with position controls. Range sufficient to
put any bar target in center of screen at all
gains.

Variable Gain Behavior

Variable affect waveform amplitude relative
to graticules.

Displayed Horizontal and Vertical Gain
Accuracy

X1 Gain+0.5%
X5 Gain +0.2%

Limited by display resolution, measured
using graticules.

Display to Graticule Registration

Centered in target, & 0.25 box diameter at
1X gain, £ 0.1 box diameter at 5X gain.

Boxes are 2% targets.

Bandwidth, typical

800 kHz, meets STD-205.
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Table A-9: Composite vector mode characteristics

Characteristic

Performance requirement

Reference information

Displayed Horizontal and Vertical Gain
Accuracy

X1 Gain £1%
X5 Gain £1%

Display to Graticule Registration

Centered in target, + 0.5 box diameter with
the color bar black/white display dot
centered in target.

Boxes are 2% targets.

Vector Display

B-Y is displayed on horizontal axis and
R-Y is displayed on vertical axis

Horizontal to Vertical Bandwidth Matching

< 2° at 500 kHz and 2 MHz

Composite Vector Dot Reference

Shows “true” zero subcarrier reference

R-Y B-Y Axis Orthogonality

0.1°. Implemented digitally.

Bandwidth, typical

500 kHz

Table A-10: Lightning and Diamond modes display

Characteristic

Performance requirement

Reference information

Displayed Horizontal and Vertical Gain
Accuracy

Gain +£0.5%

Limited by display resolution, measured
using graticules.

Diamond

GBR Deflection axis indicated.

Lightning

Y is displayed vertically. Pg is displayed
horizontally on top half of display. Pg is
displayed horizontally on bottom half of
display.

Lightning Timing Marks

As deflected from center, the 1st tic mark is
an error of 20 ns, 2nd tic mark is 40 ns, 3rd
tic mark is 74 ns (1 luma sample) and 4th
tic mark is 148 ns (1 chroma sample).
Deflection calibrated for color bars with
200 ns luma rise time, and 400 ns chroma
rise time.

If the transition bends in toward black, the
color-difference signal is delayed with
respect to luma.

If the transition bends out toward white, the
color-difference signal is leading the luma
signal.
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Table A-11: RGB gamut error indication (Diamond displays)

Characteristic

Performance requirement

Reference information

Detection Level

Adjustable thresholds:
Upper: 650 to 756 mV
Lower: -70 to +35 mV

Default is nominally 103% of legal RGB
Upper: 721 mV

Lower: -21 mV

Detection Level Accuracy

+5mV

Colorimetry

According to CCIR601.

Table A-12: Arrowhead mode (NTSC/PAL composite limit display of component input mode)

Characteristic

Performance requirement

Reference information

Signal to Graticule Accuracy
(PAL values in parenthesis)

+1%, 100 IRE (700 mV) and
131 IRE (900 mV)

Composite Limit Cursor Accuracy
(PAL values in parenthesis)

2% at 100, 110, 120, and 131 IRE (700 and
900 mV)

2% at -24, -33, and -40 IRE (-230 and
-300 mV)

Detection Level

Adjustable thresholds, 1% steps.

Out of limit signals are displayed as Red on
the out-of-limit portion of the Arrowhead
display.

Composite Limit Detection Level Accuracy
(PAL values in parenthesis)

Detection level =7 mV, 90 to 135% in
1% steps

Upper Detection level can be set to 100,
110, 120, or 131 IRE (700 or 950 mV PAL)

Luma Limits

High 90 to 108%
Low +5to -6%
0.5% steps

Default is nominally 103% and -1%.

Luma Limit Detection Level Accuracy

Detection level = +7mV of cursor level
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Table A-13: Program error alarms and “Background Measurement Alarms”

Characteristic

Performance requirement

Reference information

Alarm Coverage

Alarms only reported on active input

Alarm Log Depth

10,000 Alarm entries.
Data is volatile; it is lost on power down.

Alarm Log Time Stamping

Time of day and selectable LTC or VITC.

Alarm Notification

All alarms can be configured to be reported
to any or all of the following: XGA display
icon or text, beeper, SNMP, ground closure
alarm output, web-based user interface,
alarm log.

SDI Alarms
EDH Error Active picture and full field. Field rate Uses CRC system. System is known as
resolution. EDH (Error Detection and Handling) in
industry literature. Complies with SMPTE
RP 165.
Signal Loss Reports absence of video signal for the

currently selected input.

RGB and Composite Gamut Errors

User adjustable thresholds.

Alarm point may also be displayed in
picture mode via bright-up near the location
of the error.

Audio Alarms
Audio Level Alarms

Warns that an audio channel is at mute, clip,
silence, or over after a user-definable period
of time.

Mute and Clip are defined as minimum and
maximum digital codes. Silence and Over
are levels that can be set by the user.

Audio Error Warns that an Audio CRC Error has
occurred.
Does not apply to analog audio inputs.
Audio Unlocked Warns that an Audio AES clock is not
present or out of frequency range.
Composite Video Alarms

Signal Loss Alarm

Reports absence of video signal for the cur-
rently selected input and External Reference
if it is enabled.

LTC and VITC

Warns that a break or discontinuity has
occurred.
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Table A-14: Miscellaneous measurements and displays

Characteristic

Performance requirement

Reference information

Embedded Audio

Identifies the presence and activity of up to
16 channels of embedded digital audio.

Alarms are triggered for lack of presence,
checksum errors, buffer full/empty, or parity
errors on up to 8 channels.

EDH Error Statistics

Displays asynchronous errored seconds.
Active picture and full field statistics are
separately compiled.

SDI Video Format

Indicates whether the signal is 525 lines or
625 lines.

Composite Video Format

Indicates whether the signal is NTSC or
PAL. “Forced Format” mode overrides.

VITC On screen readout of the VITC of the
selected video input. Also displayed in the
error logging information. Complies with
SMPTE 12M.

LTC On screen readout of the LTC on GC

Remote Connector. Also displayed in the
error logging information. Complies with
SMPTE 12M.

Table A-15: Picture display mode

Characteristic

Performance requirement

Reference information

Modes

Color Only, internally referenced with 60 Hz
refresh.

Full-screen Mode

Under scan image with and without
blanking displayed

Close to 1 pixel per input sample but
interpolated as needed to get correct
aspect ratio. Composite picture with
blanking displayed does not show sync and
burst but does show vertical interval signals
such as VITS, teletext and closed caption.
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Table A-16: Measure display

Characteristic

Performance requirement

Reference information

Input Timing Relative to External Reference

Display of Vertical and Horizontal timing
offset.

Timing Display Zero Definition

(When Relative to: is set to Rear Panel.)

For vertical timing conform to SMPTE168 -
2002.

For Horizontal timing, zero delay analog
signals have coincident syncs. For digital
signals, timing is such that if converted to
analog via a WFM601a then the resultant
analog signal is coincident with the
reference.

Timing zero is equivalent to nominal zero
delay on TG700. Also agrees with timing
that has minimal shift on the waveform
display when going from internal to
external.

Vertical timing as per SMPTE168 specifies
that the first lines that contain broad pulses
are aligned.

Table A-17: Other display

Characteristic

Performance requirement

Reference information

LTC Waveform

Displays voltage versus time waveform of
LTC input.

Timing derived from currently selected
video timing. Mutually exclusive to Stair
Step mode.

LTC Waveform Vertical Accuracy, Typical

+5%

LTC Waveform DC Offset, Typical

+100 mV

LTC Waveform Time Base, Typical

3 ms/division for NTSC, 4 ms/div for PAL

Runs in 2-field sweep mode only, triggered
by field one to allow verifying audio to video
synchronization.
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Table A-18: Audio bar displays

Characteristic

Performance requirement

Reference information

Modes

User can configure the response dynamics
(ballistics), reference levels, peak hold,
offset, and scale of the meters to suite the
monitoring needs of their installation or
situation. Each pair has a phase correlation
meter.

8 Channel

Any four channel pairs with phase correla-
tion meters. Only six channels active with
analog audio input.

Surround

Left, Right, Center, Lfe, Left surround,
Right surround meters, and an extra
channel pair. Phase correlation meters
between the two left-right pairs and the
extra pair.

Audio Sources

Monitors the signal levels and stereo phase
of AES/EBU digital audio, digital audio
embedded in serial digital video and analog
audio inputs.

Level Meter Resolution

0.056 dB steps on 30 dB scale, from full
scale to -20 dB FS.

0.20 dB steps on 0 to-70 dB scale, for
signals above -240 dB FS, tiled display.

Correlation Meter Speed

User selectable from 1 to 20. Factory
default set to 8.

Speed 1 averages over 0.0167 s.
Speed 2 averages over 0.0333 s.
Speed 3 averages over 0.0667 s.
Speed 4 averages over 0.133 s.
Speed 5 averages over 0.267 s.
Speed 6 averages over 0.533 s.
Speed 7 averages over 1.0 s.
Speed 8 averages over 1.5s.
Speed 9 averages over 2.0 s.
Speed 10 averages over 2.5 s.
Speed 11 averages over 3.0 s.
Speed 12 averages over 3.5 s.
Speed 13 averages over 4.0 s.
Speed 14 averages over 4.5 s.
Speed 15 averages over 5.0 s.
Speed 16 averages over 5.5 s.
Speed 17 averages over 6.0 s.
Speed 18 averages over 6.5 s.
Speed 19 averages over 7.0 s.
Speed 20 averages over 7.5 s.

Metering Ballistics

Selectable from True Peak, PPM Type 1,
PPM Type 2, and Extended VU.
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Table A-18: Audio bar displays (Cont.)

Characteristic

Performance requirement

Reference information

Peak Program Meter

PPM Type 1 Equivalent to IEC 60268-10 Type |,
DIN 45406, and Nordic N-9
PPM Type 2 Equivalent to IEEE Std. 152-1991 and IEC
60268-10 Type Il
True Peak PPM decay characteristics, no attack delay.
Shows actual signal peaks regardless of
duration.
This is the factory default ballistic.
Extended VU A VU meter as defined in IEEE Std.
152-1991 but an extended dB-linear scale.
Peak Hold Hold adjustable from 1 to 10 seconds, Indicated Peaks held for selected time.

default is 2 seconds.

Clip Indication Delay Count

Consecutive FS samples for Clip indication,
user selectable Off or 1 to 100. Factory
default set to 1.

Mute Indication Delay Count

Consecutive "0” samples for Mute indica-
tion, user selectable Off or 1 to 100.
Factory default set to 10.

Clip/Mute Hold Time

User selectable from 1 to 30 seconds.
Factory default set to 2.

Silence Indication Threshold

Audio level below which the signal is
considered “silent”. Used to trigger
on-screen indication and alarms.

Silence Indication Delay

Off or 1 to 60 seconds selectable. Indica-
tion and alarm will not be asserted until
threshold has been exceeded for the set
number of seconds. Factory default is set
to 10.

Over Indication Threshold

Audio level above which the signal will be
considered “over”. Used to trigger on-
screen indication and alarms.

Over Indication Delay

Off or 1 to 30 seconds selectable. Indica-
tion and alarm will not be asserted until
threshold has been exceeded for the set
number of seconds. Factory default is set
to 10.
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Table A-18: Audio bar displays (Cont.)

Characteristic

Performance requirement

Reference information

Adjustable Peak Program Level (dBFS)

Range: 0 to -30 dB.

Peak program level is the level (relative to
digital full scale) that you choose as the
maximum desired level for monitored
programs. The meter bars change to red
between the Peak program level.

Adjustable Test Level (dBFS)

Range: 0 to -30 dB.

Test level is the level (relative to digital full
scale) that you choose as the test or “line
up” level for your system. The meter bars
change to yellow between the Test and
Peak program levels.

Set 0 dB Mark

Selectable from Top of Scale, Peak
Program Level, or Test Level.

Use this item to number the meter scale
relative to top of scale or to one of the two
user-adjustable levels. When the zero
mark is et to either Peak program or Test
level, the scale units are dBr, relative to the
0 dB level; units above the selected 0 dB
mark are positive, while units below it are
negative.

Table A-19: Audio bar and lissajous displays

Characteristic

Performance requirement

Reference information

Description

In combination with Bar mode can have
Lissajous in one tile.

Automatic Gain Control

Gain control can be on or off.

AGC time constant: 0.5 sec to expand
display after a 0 to -40 level transition, 0.05
sec to reduce gain after a -40 to 0 dB level
transition.

Manual Scaling

When AGC is off, level at perimeter of
display follows Program level on Bar
display.

WVR610A & WVR611A Waveform Rasterizers User Manual



Appendix A: Specifications

Table A-20: Audio text displays

Characteristic Performance requirement Reference information

Session Log (audio and video) List of Significant audio events with time
stamps. Depending on input may include
Clips, mutes, Silence, over.

Table A-21: AES audio inputs

Characteristic Performance requirement Reference information

Inputs 2 sets with 8 channels each, 24-bit. Meets
requirements of AES 3-ID.

Input Connector BNC, terminated, unbalanced.

Input Impedance 75Q

Return Loss > 25 dB relative to 752, from 0.1 to
6 MHz, typically better than 25 dB to
12 MHz.

Input A has passive terms and so are the
same with power on or off. Input B has
active terms that go to a higher impedance
with the power off.

Input Amplitude Range 0.2 Vto 2 V peak-to-peak
Input Sample Rate 32 kHz, 44.1 kHz, 48 kHz, and 96 kHz
Input Lock Range > +5%. This means that exceeding 5%,

the instrument may search again for a new
lock point. Typically stays locked to 12.5%
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Table A-21: AES audio inputs (Cont.)

Characteristic

Performance requirement

Reference information

Level Meter Accuracy over Frequency

0.2 dB from 20 Hz to 20 kHz 0 to -40 dBFS
sine-wave, Peak Ballistic mode. Except for
within 5 Hz of some submultiples of the
sampling frequency for 32, 44.1 and 48 kHz
input. 96 kHz inputs follows the 48 kHz
exceptions since it is not upsampled. For
example:

1/7th of rate -0.25 dB (for 48 kHz this is
6.857 kHz + 5 Hz)

1/6th of rate -0.3 dB (for 48 kHz this is
8 kHz + 5Hz)

1/5th of rate -0.5 dB (for 48 kHz this is
9.6 kHz + 5 Hz)

1/4th of rate -0.7 dB (for 48 kHz this is
12 kHz + 5 Hz)

2/7th of rate -0.25 dB (for 48 kHz this is
13.714 kHz + 5 H2)

1/3rd of rate -1.3 dB (for 48 kHz this is
16 kHz + 5 Hz)

4/10th of rate -0.5 dB (for 48 kHz this is
19.2 kHz + 5 Hz)

Worst case examples are shown, other
rates with minor exceptions exist. Note
that all exceptions are above 6 kHz so on
impact accuracy on harmonics of normal
audio content.

Audio Levels

Bars display signals up to 0 dBFS.

Must not exceed max power specification
on analog outputs. Configure output
attenuation if necessary.

Table A-22: AES audio outputs

Characteristic Performance requirement Reference information

Source From embedded audio only.

Number of Outputs Up to 8 channels

Output Format Stereo Output, 48 kHz, 20 bit, Meets

requirements of SMPTE 276M-1995 (AES
3-ID)

Output Connector

BNC, terminated, unbalanced.

Output Impedance

75Q
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Table A-22: AES audio outputs (Cont.)

Characteristic Performance requirement Reference information

Return Loss > 25 dB relative to 752, from 0.1 to
6 MHz.
Tested in Input mode.

Output Amplitude Range 0.9 Vto 1.1V peak-to-peak into 75Q

Output Sample Rate Locked to embedded sample rate (nominal-
ly 48 kHz).

Output Jitter, Typical 3.5 ns with 700 Hz high pass as per AES
specification
AES3 rev 1997 specification is 4.1 ns for
48 kHz audio.

Rise and Fall Times, Typical 37 ns 10 to 90% as per AES3

Table A-23: Embedded audio extraction and monitoring on status bar

Characteristic Performance requirement Reference information
Embedded Audio Formatting Extract 20-bit audio formatted according to
SMPTE 272M.

24-bit embedded audio is not supported (no
AUX bits are extracted) only the 20 most
significant bits will be extracted. Supports
SMPTE 272M Operation Level B only

(48 kHz audio sampling rate synchronized

with video).

Channel Numbering Channel number per SMPTE 272M (1
through 16) will be correctly shown on all
displays.

ANC Data Extraction Only audio data is extracted, other ANC
data is ignored.

Number of Channels Monitored for 16 channels are monitored for presence.

Presence

Audio Levels Bars display signals up to 0dBFS. Must not exceed max power specification

on analog outputs. Configure output
attenuation if necessary.
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Table A-24: Analog audio inputs

Characteristic

Performance requirement

Reference information

Number of Channels

Provides up to two sets of six channels of
professional, balanced, differential inputs,
12 channels total.

Input Connector

Balanced, unterminated connector on rear
panel.

Use 37 pin, 2 row, DSUB connector.

Level Meter Accuracy over Frequency

0.5 dB from 20 Hz to 20 kHz 0 to -40 dBFS
sine-wave, Peak Ballistic mode. Except for
within 5 Hz of some submultiples of the
sampling frequency for 32, 44.1 and 48 kHz
input. 96 kHz inputs follows the 48 kHz
exceptions since it is not upsampled. For
example:

1/7th of rate -0.75 dB (for 48 kHz this is
6.857 kHz + 5 Hz)

1/6th of rate -0.8 dB (for 48 kHz this is
8 kHz + 5 Hz)

1/5th of rate -1.0 dB (for 48 kHz this is
9.6 kHz + 5 Hz)

1/4th of rate -1.2 dB (for 48 kHz this is
12 kHz + 5 Hz)

2/7th of rate -0.75 dB (for 48 kHz this is
13.714 kHz + 5 H2)

1/3rd of rate -1.8 dB (for 48 kHz this is
16 kHz + 5 Hz)

4/10th of rate -1.0 dB (for 48 kHz this is
19.2 kHz + 5 Hz)

Worst case examples are shown, other
rates with minor exceptions exist. Note
that all exceptions are above 6 kHz so on
impact accuracy on harmonics of normal
audio content.

Cross Talk

<80 dB, typically <100 dB from 20 Hz to
20 kHz.

Defined as the displayed bar level in any
channel that results from a Full scale signal
on a different input pair in that input.

Maximum Input Levels

+24 dBu referenced to level Meter Accura-
cy over Frequency above.

Must not exceed max power specification
on analog outputs. Configure output
attenuation if necessary.

Resolution Sampling, Nominal

24 bits at 48 kHz
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Table A-24: Analog audio inputs (Cont.)

Characteristic Performance requirement Reference information

Maximum Input Levels, Typical 35kQ

Off Isolation <80 dB, from 20 Hz to 20 kHz. Unused
input driven from <600 ohm source
impedance

Defined as the displayed bar level that
results from a Full scale signal on any pair
of the unused input.

Table A-25: Analog audio outputs

Characteristic Performance requirement Reference information

Audio Modes Balanced: Provide a full-scale output of
24 dBu and is intended for professional
balanced applications.

Unbalanced: Intended to drive the unbal-
anced inputs of consumer amplifiers in
which case one side of the line must be
grounded.

Audio Sources The channels routed to the line outputs can
include:

Embedded audio source
AES audio source

Analog audio source

Number of Channels Provides up to 6 channels.

Output Connections Balanced, unterminated connector located
on rear panel.

Use 37 pin, 2 row, DSUB connector.
Ground negative output to support unbal-
anced mode.
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Table A-25: Analog audio outputs (Cont.)

Characteristic

Performance requirement

Reference information

Maximum Output Levels

Balanced: +24 dBu +0.5 dB
Unbalanced: -10 dBV +0.5 dB

When grounding one output to achieve
unbalanced mode, the other output will be
driven to a larger amplitude. You can
reduce the output level by adjusting
attenuation in the Configuration menu. Do
not exceed maximum rated power for either
mode.

Input to Output Gain

0 dBto -120 dB in 0.5 dB steps.

Digital Input to Analog Output Gain
Accuracy Over Frequency

+0.5 dB, 20 Hz to 20 kHz, 0 to -40 dBFS,
20 or 24 bit input.

Analog Input to Analog Output Gain
Accuracy Over Frequency

+1dB, 20 Hz to 20 kHz, 24 dBu to
-16 dBu

Output Impedance, Nominal

5092

Intended to drive 600 €2 load. Drivers are
capable of driving a minimum load
impedance of 300 2 but may overheat. Do
not exceed maximum rated power.

Digital Input to Analog Output Distortion
(THD + N), Typical

<0.02%, From full scale to -30 dBFS,
20 Hz to 20 kHz

Analog Input to Analog Output Distortion
(THD + N), Typical

<0.05%, From full scale to -30 dBFS
20 Hz to 20 kHz

Analog or Digital Input to Analog Output
Crosstalk, Typical

< -82 dB, 20 Hz to 20 kHz 24 dBu or
0 dBFS input

< -100 dB, 20 Hz to 2 kHz 24 dBu or
0 dBFS input

Output Power Capability, Typical

Capable of continuously driving a
-10 dBFS sine wave into 600 €2 or -13 dB
into 300 Q.

This output level is equivalent is 25 mW
RMS in the load per output pair. Live audio
may reach full voltage level as long as the
duty cycle is such that the RMS power is
less than 25 mW averaged over any 10
second period. Exceeding this limit at high
ambient temperature may cause the output
circuit to overheat and damage the
instrument.
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Table A-26: Ground closure Remote/LTC input

Characteristic

Performance requirement

Reference information

LTC Input Connector

Balanced, unterminated via rear panel GC
remote connector.

LTC Input Impedance

>10 kQ

LTC Signal Characteristics

Longitudinal Time Code per IEC Publica-
tion 461.

LTC Signal Amplitude Range

0.2 to 5.0 Vp-p balanced differential or
single-ended

Ground Closure Input Signaling

TTL thresholds, 5 V maximum input, -0.5V
minimum input. Pull low to assert.

Instrument has an internal 10 kQ pull-up
resistor on each input.

Ground Closure Output Characteristics

Open collector output, 30 V maximum,
100 mA maximum, 300 mW maximum.

Table A-27: Ethernet

Characteristic Performance requirement Reference information

SNMP For instrument control and feedback of
status. Complies with SNMP version 2.

IP Address Mode Supports manual and DHCP

Connector RJ-45 LAN connector supporting 10/100

BaseT.

Table A-28: XGA Picture monitor output

Characteristic Performance requirement Reference information

Amplitude Can switch between 1V and 0.7 V.
Resolution 1024 x 768. Timings are typical.
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Table A-29: General

Characteristic

Performance requirement

Reference information

Presets

Five user presets and a factory default
preset.

Real Time Clock

Time settable by user, used for logging time
stamps.

Field Upgradable Software and FPGA

All code except for boot flash can be
upgraded.

Battery Life and Retention Time

5 years worst case, 10 years typical.

Low Light lllumination

“OFF” leds optionally illuminated at user
selectable level from 1 to 10%.

Preset Parameters

All instrument settings except those under
CONFIG > Utilities are saved as part of the
Preset.

System Log

Stores diagnostic messages, accessed via
CONFIG menu.

Line Select Function

Any one tile can be in line select for
waveform, vector, arrowhead, diamond, or
lightning.

Cursor Styles

Cursor style - Voltage, Time or Voltage +
Time. Available in Waveform Display only.

Independent cursors can be in multiple tiles
of WFM display.

Cursor Range

Cursors can be placed on any portion of the
valid Waveform range.

Line Select Bright-up

Selected line appears as a bright line on
picture and in WFM displays set to Field
Sweep. Can be disabled in CONFIG >
Graticules > Picture Line Select Cursor and
Field Sweep Select Cursor.

Line Select Range

Any line in SDI-525 (1 to 525), SDI-625 (1
to 625), NTSC (1 to 1050), PAL (1 to 2500).

Fields greater than 1 display the line
number in the field and the line number in
the frame or color frame.
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Table A-29: General (Cont.)

Characteristic

Performance requirement

Reference information

Acoustic Noise Level, Typical

Front 33 dB(A), Rear 35 dB(A), Side
31 dB(A) for standing location at 25 deg C
ambient

Front 34 dB(A), Rear 36 dB(A), Side
32 dB(A) for sitting location at 25 deg C
ambient

Measured as per ISO7779. Unit placed on
desk, measure in operator location. Fan
speed and noise increase at higher
temperature.

Freeze Mode

Global and Tile by tile freeze modes.

The frozen trace is displayed in a different
color than the live trace. All display modes
can be frozen; Configuration or other
menus cannot be frozen.

Freeze Display Modes

Each tile can be independently set to
display frozen only, live only, or live overlaid
with frozen. Note that the Overlay mode is
not supported for Status displays, the
Timing Display or Audio level bars.

Table A-30: Power supply

Characteristic

Performance requirement

Reference information

Electrical Rating

100 - 240 VAC +10%, 50/60 Hz, 100 W
maximum

Continuous range from 90 - 264 VAC.

Supply Type

Single phase.

Supply Connection

Detachable cord set with lock.

Power Consumption, Typical

<90 VA (50 Watts)

Fuse UL/IEC127 F3.15A H, Not operator replaceable.
250 VAC (5 x 20 mm)
A-24 WVR610A & WVR611A Waveform Rasterizers User Manual



Appendix A: Specifications

Physical Specifications

Table A-31: Physical characteristics

Characteristic Standard
Dimensions

Height 1.72 inches (43.7 millimeters)

Width 19 inches (482.6 millimeters) measured at front trim

Depth 20.25 inches (514.4 millimeters) including rack handles and BNCs
Weight

Net 8.75 pounds (4 kilograms)

Shipping 15.7 pounds (7.2 kilograms) approximate

Table A-32: Environmental performance

Category Standards or description

Temperature Operating: 0 to +50 °C
Non-operating: -40 to +75 °C

Humidity Proper operation from 5% to 93% Relative Humidity.
Do not operate with visible moisture on the circuit boards. Exceeds Mil-PRF-28800F for a class 5
product.

Vibration Tektronix Class 5 Random Vibration Operating Test: For Laboratory / Benchtop Products (instrument

meets brief operational performance checks at these levels):
Power Spectral Density of:
0.00015 g?/Hz from 5 to 350 Hz, -3 dB/octave from 350 to 500 Hz.
0.000105 g%/Hz at 500 Hz.
Overall level of 0.27 GRMS, 10 minutes per axis.
Tektronix Class 5 Random Vibration Non-operating Test: For Laboratory / Benchtop Products:
Power Spectral Density of:
0.0175 g?/Hz from 5 to 100 Hz, -3 dB/octave from 100 to 200 Hz.
0.00875 g?/Hz from 200 to 350 Hz, -3 dB/octave from 350 to 500 Hz..
0.006132 g?/Hz at 500 Hz.
Overall level of 2.28 GRMS, 10 minutes per axis.
Meets Mil-PRF-28800F for a Class 3 product.

Mechanical Shock

Non-operating: 50 g, halfsine, 11 ms duration, 3 shocks per surface (18 total).
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Table A-32: Environmental performance (Cont.)

Category Standards or description

Transportation TEK Std 062-9537-00

Meets International Safe Transit Association Test Procedure 1A, April 1996, Category Il for Vibration,
Impact (24 inch drop), and Compression.

Altitude Operating: Up to 3000 meters (10,061 feet).
Non-operating: Up to 12,192 meters (40,000 feet).
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Certifications and Compliances

Table A-33: Certifications and compliances

Category

Standards or description

EC Declaration of Conformity -
EMC

Meets the intent of Directive 89/336/EEC for Electromagnetic Compatibility. Compliance was demon-
strated to the following specifications as listed in the Official Journal of the European Communities:

EN 55103 Product family standard for audio, video, audio-visual and
entertainment lighting control apparatus for professional use.!
Environment E2 - commercial and light industrial
Part1 Emission
EN 55022 Class B radiated and conducted emissions

EN 55103-1, Annex A
EN 55103-1, Annex B
EN-55103-1, Annex E

Radiated magnetic field emissions
Inrush current; | peak = 4.82 amps
Conducted emissions, signal/control ports

Part2 Immunity
IEC 61000-4-2 Electrostatic discharge immunity
IEC 61000-4-3 RF electromagnetic field immunity
IEC 61000-4-4 Electrical fast transient / burst immunity
IEC 61000-4-5 Power line surge immunity
IEC 61000-4-6 Conducted RF Immunity

IEC 61000-4-11
EN 55103-2, Annex A
EN 55103-2, Annex B

EN 61000-3-2

Voltage dips and interruptions immunity
Radiated magnetic field immunity
Balanced ports common mode immunity

AC power line harmonic emissions

Australia / New Zealand
Declaration of Conformity -
EMC

Complies with EMC provision of Radiocommunications Act per the following standard(s):

AS/NZS 2064.1/2 Industrial, Scientific, and Medical Equipment: 1992

FCC Compliance

Emissions comply with FCC Code of Federal Regulations 47, Part 15, Subpart B, Class A Limits.

EC Declaration of Conformity -
Low Voltage

Compliance was demonstrated to the following specification as listed in the Official Journal of the
European Communities:

Low Voltage Directive 73/23/EEC, amended by 93/68/EEC

EN 61010-1/A2:1995 Safety requirements for electrical equipment for measurement

control and laboratory use.

U.S. Nationally Recognized
Testing Laboratory Listing

UL3111-1 Standard for electrical measuring and test equipment.

Canadian Certification

CAN/CSA C22.2 No. 1010.1  Safety requirements for electrical equipment for measurement,

control, and laboratory use.

1 Use only high-quality shielded cables.
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Table A-33: Certifications and compliances (cont.)

Category

Standards or description

Additional Compliance

IEC61010-1

ISA $82.02.01:1999

Safety requirements for electrical equipment for measurement,
control, and laboratory use.

Safety standard for electrical and electronic test, measuring,
controlling, and related equipment.

Installation (Overvoltage)
Category Descriptions

Terminals on this product may have different installation (overvoltage) category designations. The

installation categories are:

CATN Distribution-level mains (usually permanently connected). Equipment at this level is
typically in a fixed industrial location.

CATII Local-level mains (wall sockets). Equipment at this level includes appliances, portable
tools, and similar products. Equipment is usually cord-connected.

CATI Secondary (signal level) or battery operated circuits of electronic equipment.

Pollution Degree

Pollution Degree 2

Pollution Degree Descriptions

A measure of the contaminates that could occur in the environment around and within a product.
Typically the internal environment inside a product is considered to be the same as the external.
Products should be used only in the environment for which they are rated.

Pollution Degree 1

Pollution Degree 2

Pollution Degree 3

Pollution Degree 4

No pollution or only dry, nonconductive pollution occurs. Products in
this category are generally encapsulated, hermetically sealed, or
located in clean rooms.

Normally only dry, nonconductive pollution occurs. Occasionally a
temporary conductivity that is caused by condensation must be
expected. This location is a typical office/home environment.
Temporary condensation occurs only when the product is out of
service.

Conductive pollution, or dry, nonconductive pollution that becomes
conductive due to condensation. These are sheltered locations
where neither temperature nor humidity is controlled. The area is
protected from direct sunshine, rain, or direct wind.

Pollution that generates persistent conductivity through conductive
dust, rain, or snow. Typical outdoor locations.

Equipment type Test and Measurement
Safety Class Class |
Overvoltage Category CATII
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Appendix B: Using the Remote Interface

Using a Web Browser

The WVR610A & WVR611A can be accessed two ways over an Ethernet
network: using just a Web browser or by running a Java applet. Using only a
Web browser, you can save screen captures, download presets, and download the
error log. If you install Java on your PC, you can use a Java applet to change the
waveform rasterizer settings, display the waveform rasterizer screen, save screen
captures, upload presets, and download the error log. The Java applet provides a
menu bar and a virtual front panel that gives you complete control over
instrument settings from a remote PC.

You can connect to the waveform rasterizer and perform simple operations
without installing any software and using just a Web browser. See Figure B-1.
To use a Web browser to connect to a WVR610A & WVR611A, the waveform
rasterizer must be connected to an IP network via Ethernet. You will need to set
the IP Config Mode, IP Address, Subnet Mask, and possibly the Gateway
Address depending on your network configuration. For information on how to
set these parameters, begin with IP Config Mode on page 2-74. You will also
need to enable web access on the waveform rasterizer.

To connect to the waveform rasterizer using a Web browser:

1. Press CONFIG to display the Configuration menu.

2. Select Network Settings > Web Enable.

3. Press SEL to select On. Press CONFIG to remove the Configuration menu.
4

Start your Web browser and type the network address of the waveform
rasterizer into the URL entry box like this:

http://123.123.123.123/

NOTE. Many web browsers do not correctly interpret IP addresses with leading
zeros. If the IP address shown in the Configuration menu contains leading zeros
as in 124.161.038.151, remove the “0” when entering it into the address line of
the browser. For example, 124.161.038.151 should be entered as
124.161.38.151.

See Figure B-1.
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B-2

2l Tektronix WVR610A/WVR611A Remote Interface - Microsoft Internet Explorer

File Edit View Favorites Tools Help

QBack ~ [*) [ o O search 7 Favorites @ Media & L = (5]

Address | @] http://128.181.221.4f

Links 48] Tektranix VWVRE 10-W/VR6 11 Remote Interface

Launch Applet
See the List of Web Clients

Browse Help Documentation

Get a snapshot of instrument displav (BMP)
Get a snapshot of stams display (BMP)
Get a snapshot of instrument displav (PNG)
Get a snapshot of status display (PNG)

View Event log (text, html)
View Diagnostic log (text, html)

Get Current Settings (binarv)
Get Preset 1 (bmarv
Get Preset 2 (binary
Get Preset 3 (binary
Get Preset 4 (bnarv
Get Preset 5 (binary

Download SNMP MIB files wiin mon.mib , wvr61x.mib

&j Dane

Tektronix WYVR610A/WVR611A Remote Interface

‘} Local intranet

Figure B-1: Accessing the remote interface with a Web browser

The following table describes the function of each of the links displayed in the

‘Web browser window.

Table B-1: Web browser interface functions

Selection

Description

Launch Applet

Starts Java applet

See the List of Web Clients

Displays a list of web clients (by network address)
currently logged into the waveform rasterizer

Browse Help Documentation

Display waveform rasterizer online help

Get a snapshot of instrument display
(BMP)

Create a screen capture of the full display in BMP
format

Get a snapshot of status display (BMP)

Create a screen capture of just the status bar in BMP
format

Get a snapshot of instrument display
(PNG)

Create a screen capture of the full display in PNG
format

Get a snapshot of status display (PNG)

Perform a screen capture of just the status bar in
PNG format
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Using the Java Applet

Browser Requirements

Table B-1: Web browser interface functions (Cont.)

Selection Description

View Event Log Download and display the Error Log as tab-delimited

text or an HTML table.

View Diagnostic Log Download and display the Diagnostic Log as

tab-delimited text or an HTML table

Get Current Settings (binary) Download instrument settings to a file in binary format

Get Preset 1 (binary) Download Preset 1 to a file in binary format

Get Preset 2 (binary) Download Preset 2 to a file in binary format

Get Preset 3 (binary) Download Preset 3 to a file in binary format
Get Preset 4 (binary) Download Preset 4 to a file in binary format
Get Preset 5 (binary) Download Preset 5 to a file in binary format

Download SNMP MIB files
wfm_mon.mib, wvr61x.mib

Download the each of the MIB files in ASCII format.

The Java applet version of the Remote Interface provides menus and a virtual
front panel for the WVR610A & WVR611A. Using the Java applet, you can
change any setting on the waveform rasterizer. You can download and upload
Presets. You can also view waveform rasterizer display and have it refreshed
automatically. Note that the Web interface operation is optimized for screen
resolutions of 1024 x 768 or higher. Operation on computers with lower
resolution has not been verified.

The Java applet is only supported for Microsoft Internet Explorer 5.0 or later
running on a Windows PC. The Java applet window does not resize correctly
when run in Netscape 6.0 (all platforms) or Safari 1.0 on Mac OS X. The web
applet is not supported in Netscape versions prior to version 6.0 and/or any
version of Internet Explorer on Mac OS X because they do not support Java
version 1.4.1.

Alternatively you can use the Java application which is a stand-alone application
that provides all of the features of the Java applet. It can be run on any platform
that supports Java version 1.4.1 or later, including Windows NT/2000/XP, Linux,
Unix, and Mac OS X. The Java application, unlike the Java applet, does not run
within a web browser and, thus, is not subject to the various browser limitations.
You can download the Java application package from the Tektronix web site.
Look for WVR600 Remote Software Package in the download section.
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Installing Java

Launching the Applet

B-4

To use the Remote Interface Java applet, you must install the Java Runtime
Environment.

To run the Remote Interface Java applet, you must have Version 1.41 (or later) of
the Java Run-Time Environment (JRE) from Sun Microsystems installed on your
PC. To download the JRE (Java Run-Time Environment) plug-in from Sun
Microsystems, go to the following URL and download the appropriate code:

http://java.sun.com/j2se/1.4/

Once you download the executable file, launch the installation software and
follow the instructions.

When you launch the Java applet, it is downloaded from the waveform rasterizer
and launched. There is no software installation required to use the applet (other
than the Java Run-Time Environment noted previously).

To launch the Java applet:

1. Launch your Web browser and type the network address of the waveform
rasterizer into the URL entry box like this:

http://123.123.123.123/

NOTE. Many web browsers do not correctly interpret IP addresses with leading
zeros. If the IP address shown in the Configuration menu contains leading zeros
as in 124.161.038.151, remove the “0” when entering it into the address line of
the browser. For example, 124.161.038.151 should be entered as
124.161.38.151.

Once you type the network address of the waveform rasterizer, press Return
to access the Remote Interface.

2. Once the Remote Interface appears, select Launch Applet.

The Java applet will be launched and the screen shown in Figure B-2 will
appear.
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A hitp://128.181.220.16/wvrri.htm - Microsoft Internet Explorer

File vwiew Measure Scaling Input Options  Configuration  Window Help

FEAWVR 61x Control Panel

MEASURE SELECT PRESETS INPUTS: Reference
COWEM O VECT " MEAS . f 3 q 3 2p| CMPET F EXT CUINT
- g Position
T PICT ( AUDIO [ OTHER { 2 5

v 4 Vemcal
" GAMUT © STATUS
MENU 5 Factary Horizontal

Freeze [ Line Select J

Format 1D:
SDI Input A Alarms Disabled Audio Input: AES A
Reference

Figure B-2: Java applet

Controlling the waveform rasterizer from the Java applet is much like using the
actual instrument. To perform a button press on the waveform rasterizer, click on
the same button on the Control Panel. Accessing the Configuration menu is
performed by using menus rather than a front-panel button.

Elements of the Java  The Remote Interface window contains a menu bar and a status bar. See
Applet Interface Figure B-3. The menu bar provides quick access to functions that are not
available from the front panel. The status bar serves the same function as the
status bar on the waveform rasterizer display.
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Menu bar

|»

File View Measure Scaling Input Options 'Conﬂguraﬂon Window Help

SDIA 525 59.94 Int Reference ‘ LTC Mis...

. =

|

Status bar

Figure B- 3: Java applet window

The Java applet window displays two other windows, the Control Panel and the
Waveform Display. The Control Panel is a virtual front panel for the waveform
rasterizer. You make selections on the Control Panel by clicking on buttons or
selecting option buttons. See Figure B-4.

Displaying the Control  To display the Control Panel window:

Panel Window .
Select View > Control Panel.

EJWYR 61x Control Panel =]
TILE MEASURE SELECT GAIN SYWEEP PRESETS INPUTS Reference
‘el . P ~ o = @ EXT O INT
COAWFM o WECT MEAS o 1% o 1 2 Sl |7CMPST

A oA Position

CPICT  AUDIO O OTHER | & 5% r r . .
¥ VAR J 4 4| o
© GAMUT ¢ STATUS r
MENU 5 Factary

I J Freeze.. I” Line Select J

Vertical

B

Horizontal

Figure B- 4: Control panel

The Waveform Display window provides a display of the waveform rasterizer
screen. You do not need to display the Waveform Display window to control the
waveform rasterizer. See Figure B-5.
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Displaying the Waveform  To display the Waveform Display window:
Display Window

Select View > Waveform Display.

128.181.103. 167 fwvrri icrosoft Internet Explorer
File View Measure Scaling Input Options Configuration Window Help
ERWVYR 61x Waveform Displa

Alarm Status ( m MUTED ) Page 1 of 2 Video Session

Alar Status Additional Information Inpu DI A Data C Running
Hardware Fault Signal: Auto 525 59.94 Runtime: 0 d, 00:01

mput Missing

nput Signal Lock
External Reference Missing
External Reference Sig L
RGE Gamut Error RrGgBh e H o 109564
Composite Gamut Error issi o 99.9945 %
EDH Error
Embedded Audio Missing 12345678901 AP Status: Missing Cmpst Gamut: Error
Embedded Audio Chksum Error fields: 4659
Embedded Audio Buffer Full EDH Error Field 0 % Error fi 42521 %
Embedded Audio Buffer Empty 000015
Embedded Audio Parity . -
Audio Signal Loss 12345678 0
Au = or ] 0000 h
Audio Valid Bit
Audio Parity Error Changed since reset:  Yes

Audio Session Error Status Log Page 55 of 55

Audio Input:  Embedded / Data Collect:
Signal Loss: Runtime:

Audio Output  0: pair 1 1: pe 2: pair 3

Channel 1 5
0 D (]
1
1

]
o
Silence(s) 0 0 0 o 0 0 00:00:00
Peak (db) -99.00 -99.
High (db) -99.00 -9
Active bits: 0

Smpl Rate 0

Changed since reset:

9.94 Alarms
SDI Input A
Ref: Internal Muted

'WVR 61x Control Panel

TILE [ MEASURE SELECT [ GAN— EE PRESETS = ]
COWFM  CVECT O MEAS | | 61 & - lline. 2 line 7 2 T (oL

CPIcT € auDi0 C oTHER | ©° 0 1-Field] €2 Field Position
= VAR J : 4 ertioal

€ GAMUT & STATU! mle J |
5 Fatory Horizantal

e . I Lire G2l J

Il >

52559.94 ID: 192_158_032_020
SDI Input A RGB Gamut Error Alarms Muted
Ref: Internal

Figure B-5: Waveform display window

The Waveform Display window is not refreshed continuously. The default
refresh rate is once every 3 minutes (180 seconds). The maximum refresh rate is
constrained by network and internal limits and is typically about seven to ten
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seconds on a fast network. The rate will be slower if multiple users are simulta-
neously connected to the same instrument.

To change the Waveform Display refresh rate:

1. Select View > Refresh Rate. This displays the Refresh Window Display
window.

2. Adjust the refresh rate to the desired period.
3. Click OK to save the new rate.

You can also display the waveform rasterizer online help from the Java Applet.
Select Help > Help... This opens a new browser window and displays the online
help. See Figure B-6.

-2 Help on Tektronix WVR 610/611 Waveform Monitor - Microsoft Internet Explorer EEE
In
U

File Edit View Favorites Tools Help

QBack ~ M B @ Psearch YrFavorites @Mede @ (3- i B - [

Addre: @ http://128. 181.220. 16/help/fus frameset.htm M
v @ Tektronix WVR610-WVR611 Remote Interface

Google - ~| @psearch web  @Sesrchsite | gfnens | FaseRak @oageinfo « [Fyup - =

Operating Basics The WVR610A/WVRE11A are based on a flexible tiled display. This
Video flexibility effectively creates four independent instruments. To allow the
Audio Tasks tiles to be independent, most of the controls only affect one tile at a
Checking Stafus time. The tile that is currentlv being controlled is considered the "active”
Configuring the tle and is indicated by a blue box around that tile and by the kit
WVRG610AWVRE11A DISPLAY SELECT button on the left end of the front panel.
Using Presets
Using Alarms The instrument control is divided into three levels
About the
WVR610AWVRE11A « FEront panel buttons
Index « Pop-up menus
+ CONFIG menu
~

The front panel buttons are used to control the most common functions

such as what measurement appears in each tile.

The pop-up menus are used for less common operational options such

as changing the waveform from RGB to YPbPr mode.
A(SDD)
Activate Alarms (Alarms) Finally the CONFIG menu is used for items needed only occasional
Active Pairs (Audio access such as changing waveform color or setting [P addresses.
Inputs/Outputs. ..}
AES A (Audio Input) Some selections are global - that is they affect all tiles, while other
AES A (Audio options only affect the active tile. Generally, if an item is configured by
Tnputs'Outputs) front-panel buttons or by a pop-up mem, then it is tile specific
AES and Embedded Alarms Conversely, selections in the CONFIG menu are usually global.
AES B (AUDIO > Audio Exceptions are the Input buttons, and all andio features - both of which
Tnput) ; are global.
AES B (Audio Inputs/Outputs)
AES B Quiput (Audio
Inputs/Outputs) v

&) & Local intranet

Figure B-6: Displaying online help

NOTE. The screen captures for the web interface displays can be temporarily
corrupted if you change settings during the capture. This can result in images
that are a mixture of the settings before and after the changes. Subsequent
captures taken when no settings changes are occurring will be correct.
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Elements of the Menu Bar

Table B-2 lists each of the Remote Interface menus and the commands within
the menus.

Table B-2: Remote interface menus

Menu Commands Description
File Restore Settings Upload stored presets to the waveform rasterizer
Save as Preset Save current waveform rasterizer settings in a file
Exit
View Active Tile Changes the active tile
Full Screen Changes display to Full screen mode
Freeze... Captures the current image for most of the possible
displays in the waveform rasterizer .
Control Panel Toggles the display of the Control Panel window on and
off
Waveform Display | Toggles the Waveform Display window on and off
Refresh Updates the Waveform Display
Refresh Rate Specifies how often the Waveform Display should be
automatically updated
Measure Measurement p Sets the contents of the Active Tile and displays the
available settings in this menu.
Measurement set- The settings displayed below Measurement correspond
tings to the pop-up menu settings available for the selected
measurement.
Scaling Vertical Position Displays a window to enable you to adjust the vertical
position
Horizontal Position | Displays a window to enable you to adjust the horizontal
position
Gain Enables you to set the Gain to 1X, 5X, or set the
variable gain
Sweep Enables you to set the sweep mode to One Line, Two
Line, One Field, or Two Field
Mag Magnifies the Active Tile sweep rate
Input SDIA Selects the SDI A input
SDIB Selects the SDI B input
Cmpst A Selects the CMPST A input
Cmpst B Selects the CMPST B input
Ext. Ref. Selects the external reference source for composite
video
Options Enables Line Select | Enables Line Select mode
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Table B-2: Remote interface menus (Cont.)

Menu Commands Description
Line Select... Displays a window to enable you to select a line for
display
Cursors Enable Enables and disables Cursors
Cursors... Displays a window to enable you to adjust the cursors
Configuration | SDI Input Displays the SDI Input Configuration menu window
Composite Input Displays the Composite Input Configuration menu
window
External Reference | Displays the External Reference Configuration menu
window
Audio Displays Displays the Audio Displays Configuration menu
window
Audio Inputs/Outputs | Displays the Audio Inputs/Outputs Configuration menu
window
Alarms Displays the Alarms Configuration menu window
Gamut Thresholds | Displays the Gamut Thresholds Configuration menu
window
Display Settings Displays the Display Settings Configuration menu
window
Graticules Displays the Graticules Configuration menu window
LTCVITC Displays the LTC/VITC Configuration menu window
Readouts Displays the Readouts Configuration menu window
Network Settings Displays the Network Settings Configuration menu
window
Utilities Displays the Utilities Configuration menu window
Window Control Panel Moves the Control Panel window to the front if it is
covered by the Waveform Display
Waveform Display | Moves the Waveform Display window to the front if it is
covered by the Control Panel
Help Help Displays the waveform rasterizer online help
About Displays version information about the Java applet

Adjusting Variable
Settings

There are several variable settings on the waveform rasterizer, such as vertical
and horizontal position or gain. Each of these settings can be adjusted from the

Remote Interface. When you select a variable setting for adjustment, the Remote
Interface displays a small window with a slider that you use to adjust the value.

For example, to adjust the vertical position of a waveform:
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1. Select Scaling > Vertical Position. The Remote Interface displays the
Vertical Position window. See Figure B-7.

g vertical P... |

Yertical Position:

—400

—200

——0

—-200

—_400

= ﬂm'\-"
Defautt

Figure B-7: Adjusting vertical position
2. To adjust the vertical position, slide the indicator to the desired position or
enter a specific voltage offset in the window.

The changed value is sent to the waveform rasterizer as soon as you release
the mouse button.

Displaying Pop-up Menus  Displaying pop-up menus for the MEASURE SELECT buttons is accomplished
by clicking a button rather than pressing and holding a button as it is on the
physical instrument.

To display a pop-up menu for a MEASURE SELECT button:
1. Select the measurement for which you wish to display the pop-up menu.

2. Click the MENU button. See Figure B-8 and Figure B-9.
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EJWVR 61x Control Panel _]
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Figure B-8: Displaying pop-up menus
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Figure B-9: The vector menu pop-up menu
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MIB

The WVR610A & WVR611A provide remote instrument control using SNMP
over a TCP/IP network. The WVR610A & WVR611A utilize two MIBs, one is
specific to the WVR610A & WVRG611A and the second is a “general purpose”
MIB that is shared by several Tektronix video waveform monitors. Both MIBs
can be downloaded from the Tektronix web site: www.tektronix.com or from the
instrument using the Remote Interface (see Appendix B).

This chapter describes the elements of the two MIBs used by the WVR610A &
WVR611A. The two MIBs are:

B wvr6lx.mib is specific to the WVR610A & WVR611A

B wfm_mon.mib is common to Tektronix video waveform monitors.

SNMP Command and Web Interface Interaction

The web interface might not always display the current state of the instrument
under certain conditions. If the web interface is connected to the instrument
through a slow network interface, the process of sending data to the web
waveform display can delay the reporting of instrument state in the web
interface. Turn off or decrease the frequency of the display refresh to improve
performance of the web interface control and reporting. Sustained high rates of
SNMP commands can also cause the web interface to delay reporting instrument
state. The web application will usually recover within a few seconds after a
pause in the SNMP command stream. In extreme circumstances of high-speed
SNMP command sequences, the web application can run out of memory and
lock up. In that event, stop and restart the web application to recover.

wvr61x MIB Definitions
The following imports are included:
Module-Identity, Object-Type, enterprises from SNMPv2-SMI
DisplayString from SNMPv2-TC

Module-Compliance, Object Groups from SNMPv2-Conf
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Object Descriptions  Descriptions for Group and Table are as follows:

tek OBJECT IDENTIFIER ::= { enterprises 128 }
tvt OBJECT IDENTIFIER ::= {tek 5}
tviproducts OBJECT IDENTIFIER ::= {tvt 1}
tvimibs OBJECT IDENTIFIER ::= {tvt2 }

The MIB module tables describe the control statements for the WVR610A &
WVR611A Waveform Rasterizers. The management information base tables
begin with the MIB Definitions

Group Descriptions  Descriptions for Groups are as follows:

comp OBJECT IDENTIFIER ::= {wvr61x 1}
diag OBJECT IDENTIFIER ::= {wvr61x 2 }
readout OBJECT IDENTIFIER ::= {wvr61x 3}
grats OBJECT IDENTIFIER ::= { wvr61x 10 }

NOTE. Some of the Audio SNMP OIDS have a syntax that is tile specific, but they
actually are global and affect all tiles.

Table C-1: Composite calibration group

Object identifier Object type
comp OBJECT IDENTIFIER ::= { wvr61x 1)
compDcRestore
SYNTAX INTEGER {
off (0),
slow (1),
fast (2)
MAX-ACCESS read-write
STATUS current
DESCRIPTION DC restore function of composite input
m={comp1}
compPalVector
SYNTAX INTEGER {
normal(0),
plusV(1),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION PAL vector mode of composite input normal /
plusv
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Table C-1: Composite calibration group (Cont.)

Object identifier Object type
n={comp2}
compNtscSetup
SYNTAX INTEGER {
off(0),
on(1),
MAX-ACCESS read-write
STATUS current
DESCRIPTION NTSC setup of composite input
m={comp 3}
compSyncLockMode
SYNTAX INTEGER {
direct(0),
afe(1),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite input sync lock mode.
Note: direct = fast, afc = slow
m={comp4}
refSyncLockMode
SYNTAX INTEGER {
direct(0),
afc(1),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION External reference sync lock mode
n={comp5}
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Table C-2: wvr61x specific diagnostics group

Object identifier Object type
adjustType
SYNTAX INTEGER (0..1)
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Composite adjustment type (0 - Zero adjust,
1 - white adjust). This is used as an INDEX in
the table.
n={diag 1}
calChannelNum
SYNTAX INTEGER (0..5)
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Audio calibration channel number
n={diag2}
adjustTable
SYNTAX SEQUENCE OF AdjustEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for adjust
n={diag 3}
adjustEntry
SYNTAX AdjustEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the adjust table
INDEX { adjustType }
::={ adjustTable 1}
AdjustEntry
::= SEQUENCE {
?djust INTEGER
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Table C-2: wvr61x specific diagnostics group (Cont.)

Object identifier Object type
adjust
SYNTAX INTEGER {
end(0), To end the adjustment
without saving
start-with-preset(2), To enable the adjustment
of the instrument with a
preset loaded
start-no-preset(3),  To enable the adjustment
of the instrument without
loading a preset
save(4), Save all adjustment data to
persist storage and exit
adjustment mode
load(5) Load all ajustment data
from the persistent storage
and activate
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Instrument adjustment data control
::={ adjustEntry 1}
compAdjZero
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite waveform DC offset adjustment
n={diag4}
compAdjWhiteVal
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite waveform white adjustment value
(values from -9 to 9 are not allowed)
n={diag5}
compAdjFreq
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite frequency peaking adjustment value
n={diag 6}
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Table C-2: wvr61x specific diagnostics group (Cont.)

Object identifier

Object type

audinAdjTable
SYNTAX
MAX-ACCESS
STATUS
DESCRIPTION
n={diag 7}

Sequence of AudInAdjEntry
not-accessible

current

Table for audio input adjustment

audinAdjEntry
SYNTAX
MAX-ACCESS
STATUS
DESCRIPTION
INDEX
::={audInAdjTable 1}

AudInAdjEntry

not-accessible

current

A row in the audio input adjustment table
{ calChannelNum }

AudInAdjEntry

::= SEQUENCE {

audinputAdjAmp INTEGER
}

audinputAdjAmp
SYNTAX

MAX-ACCESS
STATUS
DESCRIPTION

::={ audinAdjEntry 1}

INTEGER {
calibration-failed(-1,)
calibration-unknown(0),
calibration-busy(1),
calibration-done(2)

}

read-write
current
Analog audio meter gain adjustment value

audSelfTest
SYNTAX

MAX-ACCESS
STATUS
DESCRIPTION
= {diag 8 }

INTEGER {
self-test-error(-1),
self-test-ok(0)

}
read-write
current

Audio hardware self-test
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Table C-2: wvr61x specific diagnostics group (Cont.)

Object identifier Object type
audTone
SYNTAX INTEGER {
tone-off(0),
tone-100hz(1),
tone-1khz(2),
tone-18khz(3)
MAX-ACCESS read-write
STATUS current
DESCRIPTION State of the audio tone generator
n={diag9}

Table C-3: wvr61x specific readout configuration group

Object identifier Object type
wfmReadout
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform readouts disable/enable
::={readout 1}
vecReadout
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector readouts disable/enable
::={readout 2 }
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Table C- 3: wvr61x specific readout configuration group (Cont.)

Object identifier Object type
pictReadout
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Picture readouts disable/enable
::={readout 3 }
gamutReadout
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Gamut readouts disable/enable
::={readout 4 }

Table C-4: wvr61x specific Graticules group

Object identifier Object type
sdiVeclgAxis
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION SDI vector IQ Axis disable/enable
n={grats 1}
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Table C-4: wvr61x specific Graticules group (Cont.)

Object identifier Object type
compWfmGratUnits
SYNTAX INTEGER {
auto(0),
mv(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite waveform graticule units
n={grats 2}

Waveform Monitor MIB Definitions
The following imports are included:

Module-Identity, Object-Type, Notification-type, enterprises from
SNMPv2-SMI

DisplayString from SNMPv2-TC

Module-Compliance, Object Groups from SNMPv2-Conf

Object Descriptions  Descriptions for Group and Table are as follows:

tek OBJECT IDENTIFIER ::= { enterprises 128 }
tvt OBJECT IDENTIFIER ::= {tek 5}
tviproducts OBJECT IDENTIFIER ::= {tvt 1}
tvimibs OBJECT IDENTIFIER := {tvt2}

The MIB module tables describe the control statements for the WVR610A &
WVR611A Waveform Rasterizers. The management information base tables
begin with the MIB Definitions

Group Descriptions  Descriptions for Groups are as follows:

gen OBJECT IDENTIFIER ::= { wfm-mon 1}
input OBJECT IDENTIFIER ::= { wim-mon 2 }
print OBJECT IDENTIFIER ::= { wfm-mon 3 }
audioDisp OBJECT IDENTIFIER ::= { wfm-mon 4 }
wfm OBJECT IDENTIFIER ::= { wim-mon 5 }
vec OBJECT IDENTIFIER ::= { wfm-mon 6 }

WVR610A & WVR611A Waveform Rasterizers User Manual C-9



Appendix C: WVR610A & WVR611A Waveform Rasterizers MIB

arr OBJECT IDENTIFIER ::= { wim-mon 7 }

Igt OBJECT IDENTIFIER ::= { wim-mon 8 }

dmd OBJECT IDENTIFIER ::= { wim-mon 9}

pict OBJECT IDENTIFIER ::= { wfm-mon 10 }
sdistat OBJECT IDENTIFIER ::= { wfm-mon 11}
preset OBJECT IDENTIFIER ::= { wim-mon 12 }
gamut OBJECT IDENTIFIER ::= { wim-mon 13 }
eye OBJECT IDENTIFIER ::= { wfm-mon 14 }
jitter OBJECT IDENTIFIER ::= { wfm-mon 15}
logstat OBJECT IDENTIFIER ::= { wfm-mon 16 }
audio OBJECT IDENTIFIER ::= { wfm-mon 17 }
audiolo OBJECT IDENTIFIER ::= { wim-mon 18 }
traps OBJECT IDENTIFIER ::= { wfm-mon 19 }
alarm OBJECT IDENTIFIER ::= { wfm-mon 20 }
ltc OBJECT IDENTIFIER ::= { wfm-mon 21}
timing OBJECT IDENTIFIER ::= { wfim-mon 22 }
audioAnaDisp OBJECT IDENTIFIER ::= { wim-mon 23 }

Table C-5: Wfm-mon General group

Object identifier Object type
ipAddress
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION IP address of the instrument
m={gen1}
subNetMask
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Subnet mask of the instrument
n={gen2}
swVersion
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Software version and creation date
m={gen3}
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Table C-5: Wfm-mon General group (Cont.)

Object identifier Object type
fpgaVersions
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION FPGA versions (Composite FPGA, SDI
Waveform FPGA, SDI CPLD, Raster FPGA)
n={gen4}
fpVersion
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Hardware and Software version of front panel
m={gen5}
instld
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Instrument name
={gen6}
displayModeTable
SYNTAX SEQUENCE OF DisplayModeEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for display modes
m={gen7}
displayModeEntry
SYNTAX DisplayModeEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the displayMode table
INDEX { currTile}
::= { displayModeTable 1}
DisplayModeEntry
::= SEQUENCE {
displayMode INTEGER
}
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Table C-5: Wfm-mon General group (Cont.)

Object identifier Object type

displayMode

SYNTAX INTEGER {
none(0),

wim(1),

vec(2),
lightning(3),
picture(4),
arrowhead(5),
diamond(6),
status-log(7),
audio(8),

Itc(9),
timeref(10),
status-alarm(11),
status-video(12),
status-audio(13)

}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Display mode in selected tile
::= { displayModeEntry 1}
ipConfigMode
SYNTAX INTEGER {
manual(0),
dhep(1)
}
MAX-ACCESS read-only
STATUS current
DESCRIPTION IP address configuration mode of the instrument
(manual/dhcp)
m={gen8}
gatewayAddress
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Gateway address for the instrument
={gen9}
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Table C-5: Wfm-mon General group (Cont.)

Object identifier Object type
macAddress
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Ethernet address for the instrument
m={gen 10}
snmpPublicCommStr
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Public community string required to send SNMP
GET requests to the instrument. This is
write-only.
m={gen11}
snmpPrivateCommStr
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Private community string required to send SNMP
SET/GET requests to the instrument. This is
write-only.
n={gen12}
webAccess
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable/disable web access to the instrument
n={gen 13}
hwFaultCondition
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Returns fault condition string
n={gen 14}
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Table C-6: Wfm-mon Input group

Object identifier Object type
videoln
SYNTAX INTEGER (
sdi-A(0),
sdi-B(1),
cpst-A(2),
cpst-B(3)
none(4)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Current video input source
»={input 1}
sdilnStd
SYNTAX INTEGER (
auto(0),
std-525(1),
std-625(2)
)
MAX-ACCESS read-write
STATUS current
DESCRIPTION SDI input standard
={input 2}
complnStd
SYNTAX INTEGER (
auto(0),
ntsc(1),
ntsc-ns(2)
pal(3)
)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite input standard
={input 3}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
refSrc
SYNTAX INTEGER {
internal (0),
external(1)
MAX-ACCESS read-only
STATUS current
DESCRIPTION Current reference source (Internal/External)
z={input 4}
reflnStd
SYNTAX INTEGER {
auto(0),
ntsc(1),
pal(2),
std-1080i-59-94(3),
std-1080i-60(4),
std-720p-59-94(5),
std-1080p-23-97(6),
std-1080p-24(7)
MAX-ACCESS read-only
STATUS current
DESCRIPTION External reference input standard
m={input 5}
refLocked
SYNTAX INTEGER {
locked(0),
unlocked(1)
MAX-ACCESS read-only
STATUS current
DESCRIPTION Reference input status - locked/unlocked
={input 6}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
currTile
SYNTAX INTEGER {
tile1(0),
tile2(1),
tile3(2),
tile4(3)
}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Currently selected tile. This is used as index in
tables.
z={input 7 }
sdiSetup
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Turn on/off pseudo composite setup and
arrowhead display
::={input 8}
gratintensity
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Graticule intensity
»={input 9}
rdOutIntensity
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Readout intensity
»={input 10}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
gratColor
SYNTAX INTEGER {
gold(0),
blue(1),
red(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Graticule color
={input 11}
rdOutColor
SYNTAX INTEGER {
gold(0),
blue(1),
red(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Readout color
z={input 12}
wfmColor
SYNTAX INTEGER {
green(0),
white(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveformcolor
m={input 13}
wimintensity
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform intensity
={input 14}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
lineSelect
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Select line number
m={input 15}
fieldSelect
SYNTAX INTEGER {
all(0),
f1(1),
f2(2),
f3(3),
f4(4),
f5(5),
f6(6),
f7(7),
18(8),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Select fields for line select (0 means all fields)
»={input 16}
fullScreen
SYNTAX INTEGER {
tile-none(0),
tile-1(1),
tile-2(2),
tile-3(3),
tile-4(4)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Select atile to display it in full-screen mode.
(Select tile-none to display tiles in tile mode)
m={input 17}
timeOfDay
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Time of day value
m={input 18}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
activeTimeCode
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Active time code value
m={input 19}
timeCodeSrc
SYNTAX INTEGER {
none(0),
Ite(1),
vite(2)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Active time code source (NONE, LTC, VITC)
={input 20}
ltcPresent
SYNTAX INTEGER {
false(0),
true(1)
}
MAX-ACCESS read-only
STATUS current
DESCRIPTION LTC source is present or not
z={input 21}
vitcPresent
SYNTAX INTEGER {
false(0),
true(1)
}
MAX-ACCESS read-only
STATUS current
DESCRIPTION VITC source is present or not
= {input 22}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
timeCodePresent
SYNTAX INTEGER {
false(0),
true(1)
MAX-ACCESS read-only
STATUS current
DESCRIPTION Time code is present or not (VITC/LTC)
»={input 23}
lineSelectEnable
SYNTAX INTEGER {
off(0),
tile1(1),
tile2(2),
tile3(3),
tile4(4)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable line select for the specified tile
m={input 24 }
sdiStripEavSav
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION SDI input Strip EAV/SAV/ANC
m={input 25}
sdiChroma
SYNTAX INTEGER {
offset(0),
align(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION SDI Pb & Pr waveform chroma alignment
= {input 26 }
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
pictBrightness
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Picture brightness level
= {input 27 }
vgaOutput
SYNTAX INTEGER {
normal(0),
dim(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION VGA brightness level
= {input 28 }
panelBacklight
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Front panel backlight enable
m={input 29}
panelBklitintensity
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Front panel backlight intensity level (1-10)
={input 30}
pictBrtupRgbGamut
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Picture brightup on RGB gamut error
=={input 31}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
pictBrtupCmpstGamut
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Picture brightup on composite gamut error
»={input 32}
pictRefreshMode
SYNTAX INTEGER {
crt(0),
Icd(1)
interlace(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Picture refresh mode
={input 33}
freezeMode
SYNTAX INTEGER {
global(0),
tile(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Sets Freeze behavior to Freeze all tiles (global 0)
or the specified tile (tile 1)
»={input 34}
freezeTable
SYNTAX Sequence of FreezeEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for freeze display modes
»={input 35}
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
freezeEntry
SYNTAX FreezeEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the freeze table
INDEX { currTile }
::={freezeTable 1}
FreezeEntry
::= SEQUENCE {
freeze INTEGER
freezeDelete INTEGER
freezeDisplayMode INTEGER
}
freeze
SYNTAX INTEGER {
off(0)
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Activate the freeze in respective tiles, this is a

::={ freezeEntry 1}

trigger

freezeDelete
SYNTAX

MAX-ACCESS
STATUS
DESCRIPTION

::={ freezeEntry 2}

INTEGER {
off(0)
on(1)
}

read-write
current

Delete the freeze in respective tiles, this is a
trigger
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Table C-6: Wfm-mon Input group (Cont.)

Object identifier Object type
freezeDisplayMode
SYNTAX INTEGER {
live(0)
frozen(1)
both(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Freeze display mode in selected tile
::={ freezeEntry 3}
pictBrtupLumaGamut
SYNTAX INTEGER {
off(0)
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Picture brightup on luma gamut error
:={input 36 }

Table C-7: Wfm-mon Audio Display group

Object identifier Object type
audCurOutput
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Currently selected analog outputs
::={ audioDisp 1}
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Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
audBallistic
SYNTAX INTEGER {
truePeak(0),
ppm(1),
ppm(2)
vu(3)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Meter ballistic selection for digital audio: True
Peak, PPM, or VU
::= { audioDisp 2 }
audPkHold
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Hold time for digital audio peak level indicator (in
seconds)
::={ audioDisp 3 }
audErrorHoldTm
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION The length of time the Digital Audio in-bar error
messages, clip, and over indicators are displayed
or held after the error has been removed (in
seconds)
::= { audioDisp 4 }
audClipTh
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio clip duration threshold (in samples)
::={ audioDisp 5 }
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Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
audioMuteTh
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio mute duration threshold (in
samples)
::={ audioDisp 6 }
audOverLvl
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio threshold level for over-volume
detection (in dB)
::={ audioDisp 7}
audOverTm
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio Over volume duration threshold (in
seconds)
::={ audioDisp 8 }
audSilenceLvl
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio Silence level (in dB)
::={ audioDisp 9 }
audSilenceTm
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio Silence duration threshold (in
seconds)
::={audioDisp 10}
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Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
audProgLv!
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital Audio Peak program level (in dB). Note:

::= { audioDisp 11}

controls boundary between Yellow and Red on
level meter.

audTestLvl
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital Audio Test level (in dB). Note: controls
boundary between Green and Yellow on level
meter.
::={audDisp 12}
audCorrMtrSpd
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio correlation meter speed
::={ audioDisp 13}
audAesActBits
SYNTAX INTEGER
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Active bits in the audio input stream as reported
in the AES status block
::={ audioDisp 14 }

WVR610A & WVR611A Waveform Rasterizers User Manual

C-27



Appendix C: WVR610A & WVR611A Waveform Rasterizers MIB

Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
audZeroDbMark
SYNTAX INTEGER {
dBFS(0),
peak-level(1),
test-level(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio Zero dB mark at one of the three
settings: dB full scale, peak program level, or test
level
::={ audioDisp 15}
audMeterNum
SYNTAX INTEGER {0..7}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Digital audio level meter number. Table (index
varies from 0 to 7)
::={ audioDisp 16 }
Table {index varies from0to7 }
audLviTable
SYNTAX SEQUENCE OF AudLvIEntry
MAX-ACCESS non-accessible
STATUS current
DESCRIPTION Table for Digital Audio level, clip/mute count,
active bits sample rate, silence/over count OIDs
::= { audioDisp 17 }
audLvIEntry
SYNTAX AudLviEntry
MAX-ACCESS non-accessible
STATUS current
DESCRIPTION A row in the audio level table
INDEX { audMeterNum }

::={audLviTable 1}
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Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
AudLvIEntry ::= SEQUENCE {
audLevel INTEGER
audClipCount INTEGER
audMuteCount INTEGER
audActBits INTEGER
audSampleRt INTEGER
audSilenceCount  INTEGER
audOverCount INTEGER
}
audLevel
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Returns the level of the Digital Audio in dBFS,
divide by 100 to get dBFS
::={audLvlEntry 1}
audClipCount
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Returns the number of Digial Audio Clip
conditions detected in the current session
::={audLvlEntry 2 }
audMuteCount
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Returns the number of Digial Audio Mute
conditions detected in the current session
= {audLvlEntry 3 }
audActBits
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Active bits detected in digital audio input stream
::={audLvlEntry 4}
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Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
audSampleRt
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Sample rate of the AES input stream
::={audLvlEntry 5}
audSilenceCount
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Number of digital Silence conditions detected in
the current session
::={audLvlEntry 6 }
audOverCount
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Number of digital Over conditions detected in the
current session
::={audLvlEntry 7 }
audignoreValidBit
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable/disable detection of valid bit in AES
status block
::={audioDisp 18 }
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Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
audPkHoldSeg
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable for the Peak Hold Segment on the Digital
Level Meters
::={audioDisp 19}
audLviMtrScale
SYNTAX INTEGER {
normal(0),
custom(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio meter scale display mode (in Ul)
::= { audioDisp 20 }
audLviMtrHeight
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio meter scale top when it is in custom

::={ audioDisp 21}

mode (in Ul)

audLvIMtrOffset
SYNTAX
MAX-ACCESS
STATUS
DESCRIPTION

::= { audioDisp 22 }

INTEGER
read-write
current

Digital audio meter scale offset when it is in
custom mode (in Ul)
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Table C-7: Wfm-mon Audio Display group (Cont.)

Object identifier Object type
audLissAGC
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio lissajous AGC enable
::={ audioDisp 23 }
audSessionCirl
SYNTAX INTEGER {
reset(0),
stop(1)
run(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio session control
::={ audioDisp 24 }
audGratStepSize
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital audio meter scale graticule step size
::={audioDisp 25}

Table C-8: Wfm-mon waveform mode group

Object identifier

Object type

wimTable
SYNTAX
MAX-ACCESS
STATUS
DESCRIPTION
s={wfm1}

SEQUENCE OF WfmEntry
not-accessible

current

Table for waveform display mode
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Table C-8: Wfm-mon waveform mode group (Cont.)

Object identifier Object type
wimEntry
SYNTAX WfmEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the waveform table
INDEX { currTile }
::= { wimTable 1}
WfmEntry ::= SEQUENCE {
wfmMode INTEGER,
wimFilterCpst INTEGER,
wfmFilterYcbcer INTEGER,
wimFilterRgb INTEGER,
wimFilterYrgb INTEGER,
wfmColorSpace INTEGER,
wfmChromaOffset INTEGER,
wfmYCbCrChanEnable  DisplayString,
wfmYRGBChanEnable  DisplayString,
wimRGBChanEnable DisplayString,
wimSweepMode INTEGER,
wfmGainMode INTEGER,
wfmVarGainEnable INTEGER,
wfmVarGain DisplayString,
wfmCursorMode INTEGER,
wfmCursorActive INTEGER,
wimCursorH1Pos DisplayString,
wimCursorH2Pos DisplayString,
wfmCursorV1Pos DisplayString,
wfmCursorV2Pos DisplayString,
wfmCursorHDelta DisplayString,
wfmCursorVDelta DisplayString,
wfmHorPos DisplayString,
wimVertPos DisplayString,
wfmHMag INTEGER,
wfmCenter INTEGER
}
wimMode
SYNTAX INTEGER {
parade(0),
overlay(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform display mode
= { wimEntry 1}
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Table C-8: Wfm-mon waveform mode group (Cont.)

Object identifier Object type
wimFilterCpst
SYNTAX INTEGER {
flat(0),
luma(1),
chroma(2),
flat-luma(3)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform filter for Composite (or pseudo-com-
posite) color space
= { wimEntry 2 }
wimFilterYcbcer
SYNTAX INTEGER {
flat(0),
lowpass(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform filter for YCbCr color space
::= { wfmEntry 3}
wimFilterRgb
SYNTAX INTEGER {
flat(0),
lowpass(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform filter for RGB color space
.= { wimEntry 4}
wimPFilterYrgb
SYNTAX INTEGER {
flat(0),
lowpass(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform filter for YRGB color space
= {wimEntry 5}
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Table C-8: Wfm-mon waveform mode group (Cont.)

Object identifier Object type
wfmColorSpace
SYNTAX INTEGER {
none(0),
composite(1)
ycber(2),
rgb(3),
yrgb(4)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform color space: none(0), composite(1),
ycber(2), rgb(3), yrgb(4)
= { wimEntry 6 }
wfmChromaOffset
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform chroma offset enable
= { wimEntry 7}
wfmYCbCrChanEnable
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform components enabled in YCbCr color
space. Possible values - Y, Cb, Cr, YCb, YCr,
CbCr, YCbCr
2= { wimEntry 8 }
wfmYRGBChanEnable
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform components enabled in YRGB color
space. Possible values - Y, R, G, B, YR, YG,
YB, RG, RB, GB, YRG, YRB, YGB, RGB, YRGB
= {wfmEntry 9}
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Table C-8: Wfm-mon waveform mode group (Cont.)

Object identifier Object type
wimRGBChanEnable
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform components enabled in RGB color
space. Possible values - R, G, B, RG, GB, RB,
RGB
::= { wfmEntry 10 }
wimSweepMode
SYNTAX INTEGER {
hi(1),
h2(2),
f1(3),
f2(4)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform sweep mode
= { wimEntry 11}
wfmGainMode
SYNTAX INTEGER {
gain-x1(0),
gain-x5(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform fixed gain value
= { wimEntry 12}
wimVarGainEnable
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable/disable waveform variable gain
= { wfmEntry 13}
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Table C-8: Wfm-mon waveform mode group (Cont.)

Object identifier Object type
wimVarGain
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform variable gain value
= { wimEntry 14}
wfmCursorMode
SYNTAX INTEGER {
volt(0),
time(1)
voltAndTime(2)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Set waveform cursor mode possible values:
volt(0), time(1), and voltAndTime(2)
= { wfimEntry 15}
wfmCursorActive
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable/disable waveform cursors
.= { wfimEntry 16 }
wfmCursorH1Pos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Position of the first horizontal cursor in the
waveform display
= { wimEntry 17 }
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Table C-8: Wfm-mon waveform mode group (Cont.)

Object identifier Object type
wfmCursorH2Pos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Position of the second horizontal cursor in the
waveform display
= { wimEntry 18 }
wfmCursorV1Pos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Position of the first vertical cursor in the
waveform display
= { wfmEntry 19}
wfmCursorV2Pos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Position of the second vertical cursor in the
waveform display
= { wimEntry 20 }
wfmCursorHDelta
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Distance between horizontal cursors
::= { wimEntry 21 }
wfmCursorVDelta
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Distance between vertical cursors
= { wfmEntry 22 }
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Table C-8: Wfm-mon waveform mode group (Cont.)

Object identifier Object type
wimHorPos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform horizontal position
= { wimEntry 23 }
wfmVertPos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform vertical position
::= { wimEntry 24 }
wfmHMag
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Waveform horizontal magnification (Off/On)
= { wimEntry 25}
wimCenter
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Center waveform - write only
2= { wfmEntry 26 }
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Table C-9: Wfm-mon vector mode group

Object identifier Object type
vecPhase
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector Phase, for composite input only (0.0 to
360.0 degrees)
n={vec1}
vecTable
SYNTAX SEQUENCE OF VecEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for vector display mode
n={vec2}
vecEntry
SYNTAX VecEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the vector table
INDEX {currTile }
::={vecTable 1}
VecEntry ::= SEQUENCE {
vecMode INTEGER,
vecHorPos DisplayString,
vecVertPos DisplayString,
vecTargets INTEGER,
vecGain INTEGER,
vecVarGainEnable INTEGER,
vecVarGain DisplayString,
vecCenter INTEGER,
}
vecMode
SYNTAX INTEGER {
normal(0),
rose(1),
sch(2)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector display mode
::={vecEntry 1}
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Table C-9: Wfm-mon vector mode group (Cont.)

Object identifier Object type
vecHorPos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector horizontal position
= {vecEntry 2}
vecVertPos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector vertical position
={vecEntry 3}
vecTargets
SYNTAX INTEGER {
bar-75-percent(0),
;Jar-1 00-percent(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector bar targets (75% or 100%)
::={vecEntry 4}
vecGain
SYNTAX INTEGER {
gain-x1(0),
gain-x5(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector fixed gain: x1, x5
={vecEntry 5}
vecVarGainEnable
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable/disable vector variable gain
={vecEntry 6}
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Table C-9: Wfm-mon vector mode group (Cont.)

Object identifier Object type
vecVarGain
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Vector variable gain
::={vecEntry 7}
vecCenter
SYNTAX INTEGER {
on-black(0)
on-red(1),
on-magenta(2),
on-yellow(3),
on-blue(4),
on-green(5),
on-cyan()
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Center waveform in vector mode
:={vecEntry 8}

Table C-10: Wfm-mon arrowhead group

Object identifier Object type
arrTable
SYNTAX SEQUENCE OF ArrEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for arrowhead display mode
n={arr1}
arrEntry
SYNTAX ArrEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the arrowhead table
INDEX { currTile }

z={arTable 1}
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Table C-10: Wfm-mon arrowhead group (Cont.)

Object identifier Object type
ArrEntry ::= SEQUENCE {
arfMode INTEGER
}
arrMode
SYNTAX INTEGER {
normal(0),
setup(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Arrowhead display mode: normal/setup

m={arEntry 1}

Table C-11: Wfm-mon lightning group

Object identifier Object type
IgtTable
SYNTAX SEQUENCE OF LgtEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for lightning display mode
m={lgt1}
IgtEntry
SYNTAX LgtEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the lightning table
INDEX {currTile }
:={lgtTable 1}
LgtEntry ::= SEQUENCE {
IgtHorPos DisplayString,
IgtVertPos DisplayString,
IgtHorGain INTEGER,
IgtVertGain INTEGER,
IgtVarHGainEnable INTEGER,
IgtVarHorGain DisplayString,
IgtVarVGainEnable INTEGER,
IgtVarVertGain DisplayString
IgtCenter INTEGER
}
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Table C-11: Wfm-mon lightning group (Cont.)

Object identifier Object type
IgtHorPos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lightning horizontal position
={lgtEntry 1}
IgtVertPos
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lightning vertical position
m={lIgtEntry 2}
IgtHorGain
SYNTAX INTEGER {
gain-x1(0),
gain-x5(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lightning fixed horizontal gain
= {lgtEntry 3}
IgtVertGain
SYNTAX INTEGER {
gain-x1(0),
gain-x5(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lightning fixed vertical gain
n={IgtEntry 4}
IgtVarHGainEnable
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable/disable lightning horizontal variable gain
m={lgtEntry 5}
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Table C- 11: Wfm-mon lightning group (Cont.)

Object identifier Object type
IgtVarHorGain
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lightning variable horizontal (chroma) gain
= {lgtEntry 6 }
IgtVarVGainEnable
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable/disable lightning vertical variable gain
=={IgtEntry 7}
IgtVarVertGain
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lightning variable vertical (luma) gain
= {lgtEntry 8 }
IgtCenter
SYNTAX INTEGER
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Center waveform in lightning mode
m={lgtEntry 9}

Table C-12: Wfm-mon diamond group

Object identifier Object type
dmdThrHigh
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Upper threshold (mV)
={dmd1}
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C-46

Table C-12: Wfm-mon diamond group (Cont.)

Object identifier Object type
dmdThrLow
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lower threshold (mV)
m={dmd 2}
dmdThrArea
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Diamond threshold area (%)
m={dmd 3}
dmdTable
SYNTAX SEQUENCE OF DmdEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for diamond display mode
n={dmd 4}
dmdEntry
SYNTAX DmdEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the diamond table
INDEX { currTile }
= {dmdTable 1}
DmdEntry ::= SEQUENCE {
d}mdMode INTEGER
dmdMode
SYNTAX INTEGER {
diamond(0),
split-diamond(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Diamond display mode (Diamond/Split-diamond)

={dmdEntry 1}
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Table C-13: Wfm-mon picture mode group

Object identifier Object type
pictTable
SYNTAX SEQUENCE OF PictEntry
MAX-ACCESS not accessible
STATUS current
DESCRIPTION Table for picture display mode
n={pict1}
pictEntry
SYNTAX PictEntry
MAX-ACCESS not accessible
STATUS current
DESCRIPTION A row in the picture table
INDEX { currTile }
::={ pictTable 1}
PictEntry ::= SEQUENCE {
pictFrame INTEGER
pictCursorLine INTEGER
}
pictFrame
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Picture frame enable
::= { pictEntry 1}
pictCursorLine
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Picture cursor line enable
::={ pictEntry 2}
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Table C-14: Wfm-mon SDI EDH status group

Object identifier Object type
sdiF1Crc
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION SDI Field 1 active picture CRC value
= {sdistat 1}
sdiF2Crc
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION SDI Field 2 active picture CRC value
= {sdistat 2 }
sdiFfEdhErr
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Number of seconds with EDH error in Full Field
= {sdistat 3 }
sdiApEdhErr
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Number of seconds with EDH error in Active
Picture
= {sdistat 4 }
sdiEdhReset
SYNTAX INTEGER {
edh-reset(0),
edh-stop(1),
edh-run(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Reset EDH error count to zero or start/stop EDH
= {sdistat 5}
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Table C-14: Wfm-mon SDI EDH status group (Cont.)

Object identifier Object type
sdiEdhErrField
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Number of fields with EDH errors since last reset
::={ sdistat 6 }

Table C-15: Wfm-mon presets group

Object identifier Object type
presetLoad
SYNTAX INTEGER {
factory-preset(0),
preset1(1),
preset2(2),
preset3(3),
preset4(4),
preset5(5),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Recall a preset (0 - factory default, 1-5 user
presets). This is write-only.
={preset1}
presetSave
SYNTAX INTEGER {
preset1(1),
preset2(2),
preset3(3),
preset4(4),
preset5(5),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Save the current settings as one of the user
presets (1 to 5). This is write-only.
= {preset 2}
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Table C-15: Wfm-mon presets group (Cont.)

Object identifier Object type
presetLoadProgress
SYNTAX INTEGER
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Indicates preset loading process progress (% of
the restoring process completed).
={preset 3}

Table C-16: Wfm-mon gamut group

Object identifier Object type
arrNtscThrHigh
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Upper threshold of NTSC composite signal (IRE
units)
m={gamut 1}
arrPalThrHigh
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Upper threshold of PAL composite signal (mV)
m={gamut 2}
arrPalThrLow
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lower threshold of PAL composite signal (mV)
»={gamut 3}
arrThrArea
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Arrowhead threshold area (%)
m={gamut 4}
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Table C-16: Wfm-mon gamut group (Cont.)

Object identifier Object type
lumaThrHigh
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Upper threshold of Luma
m={gamut5}
lumaThrLow
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lower threshold of Luma
m={gamut 6 }
lumaThrArea
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Luma threshold area (%)
m={gamut 7}
arrNtscThrLow
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Lower threshold of NTSC composite signal (IRE
units)
»={gamut 8 }
resetLumaDefault
SYNTAX INTEGER {
reset(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Reset Luma defaults. This is write-only.
m={gamut 9}
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Table C-16: Wfm-mon gamut group (Cont.)

Object identifier Object type
resetEBU-R103Default
SYNTAX INTEGER {
reset(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Reset EBU-R103 defaults. This is write-only.
={gamut 10 }

Table C-17: Wfm-mon log status group

Object identifier Object type
logClear
SYNTAX INTEGER {
clear(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Clear the status log. This is write-only.
= {logstat 1}
logActive
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable logging of alarms - on/off
:={logstat 2}
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Table C-17: Wfm-mon log status group (Cont.)

Object identifier Object type
logPage
SYNTAX INTEGER {
first(1),
last(2),
prev(3),
next(4)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Go to the specified page of the log. This is
write-only.
::={logstat 3}

Table C-18: Wfm-mon audio group

Object identifier Object type
audTable
SYNTAX SEQUENCE OF AudEntry
MAX-ACCESS not accessible
STATUS current
DESCRIPTION Table for audio mode
={audio 1}
audEntry
SYNTAX AudEntry
MAX-ACCESS not accessible
STATUS current
DESCRIPTION A row in the audio table
INDEX {currTile }
={audTable 1}
AudEntry ::= SEQUENCE {
audPhaseDisplay INTEGER
audPhaseStyle INTEGER
audPhasePair INTEGER
audinput INTEGER
}
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Table C-18: Wfm-mon audio group (Cont.)

Object identifier Object type
audPhaseDisplay
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio phase display - on/off
::={audEntry 1}
audPhaseStyle
SYNTAX INTEGER {
sound-stage(0),
xy(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio phase style -SoundStage Lissajous or
X-Y Lissajous
::={audEntry 2}
audPhasePair
SYNTAX INTEGER {
pair1-2(0),
pair3-4(1),
pair5-6(2),
pair7-8(3),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio channel pair to monitor in phase display
:={audEntry 3}
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Table C-18: Wfm-mon audio group (Cont.)

Object identifier Object type
audinput
SYNTAX INTEGER {
analogA(1),
analogB(2),
aesA(3),
aesB(4),
embedded(5),
follows-video(6)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Current audio input source
::={audEntry 4}

Table C-19: Wfm- mon audio input/output group

Object identifier Object type
audAESportBout
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Set AES port B output active when embedded
audio is the active audio source
::={audiolo 1}
audAna-A-Format
SYNTAX INTEGER {
pairs(0),
surround(1)}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Meter format for Analog Input A
::={audiolo 2}
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audAna-B-Format
SYNTAX INTEGER {
pairs(0),
surround(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Meter format for Analog Input B
::={audiolo 3}
audAES-A-Format
SYNTAX INTEGER {
pairs(0),
surround(1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Meter format for AES Input A
::={audiolo 4 }
audAES-B-Format
SYNTAX INTEGER {
pairs(0),
surround (1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Meter format for AES Input B
::={audiolo 5}
audEmbed-A-Format
SYNTAX INTEGER {
pairs(0),
surround (1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Meter format for Embedded Input A
::={audiolo 6 }
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audEmbed-B-Format
SYNTAX INTEGER {
pairs (0),
surround (1)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Meter format for Embedded Input B
::={ audiolo 7}
levelMeters
SYNTAX INTEGER {
barPair1(0),
barPair2(1),
barPair3(2),
barPair4(3)
}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Level meter pair number. This is used as index in
table.
::={audiolo 8 }
audBarinTable
SYNTAX SEQUENCE OF AudBarInEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for Bar to Audio source input map
::={audiolo 9}
audBarlnEntry
SYNTAX AudBarlnEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the audBarlnTable
INDEX {levelMeters }

::={audBarinTable 1 }

AudBarlnEntry ::= SEQUENCE {

audAES-A-Barlnput
audAES-B-Barlnput

INTEGER,
INTEGER,

audEmbed-A-Barlnput INTEGER,
audEmbed-B-Barlnput INTEGER

}
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audAES-A-Barlnput
SYNTAX INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
pair4(4),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Bar to Audio AES A input map

::={ audBarlnEntry 1}

audAES-B-Barlnput
SYNTAX

MAX-ACCESS
STATUS
DESCRIPTION
::={audBarlnEntry 2 }

INTEGER {
none(0),
pairi(1),
pair2(2),
pair3(3),
pair4(4),
}

read-write
current
Bar to Audio AES B input map

audEmbed-A-Barlnput
SYNTAX

MAX-ACCESS
STATUS
DESCRIPTION

::={ audBarlnEntry 3}

INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
pair4(4),
pair5(5),
pair6(6),
pair7(7),
pair8(8),
}

read-write
current
Bar to Audio Embedded A input map
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audEmbed-B-Barlnput
SYNTAX INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
pair4(4),
pair5(5),
pair6(6),
pair7(7),
pair8(8),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Bar to Audio Embedded B input map
::={ audBarlnEntry 4 }
analogLevelMeters
SYNTAX INTEGER {
barPair1(0),
barPair2(1),
barPair3(2),
}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Level meter pair number for analog. This is used
as index in table.
::={audiolo 10}
analogBarinTable
SYNTAX SEQUENCE OF analogBarlnEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for Bar to Audio Analog source input map
::={audiolo 11 }
analogBarlnEntry
SYNTAX AnalogBarlnEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the analogBarlnTable
INDEX { analogLevelMeters }

::={ analogBarinTable 1}
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
AnalogBarlnEntry
::= SEQUENCE {
audAna-A-Barlnput  INTEGER,
audAna-B-Barlnput  INTEGER
}
audAna-A-Barlnput
SYNTAX INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Bar to Audio Analog A input map

::={analogBarinEntry 1}

audAna-B-Barlnput
SYNTAX

MAX-ACCESS

STATUS

DESCRIPTION

::={ analogBarlnEntry 2 }

INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
}
read-write
current

Bar to Audio Analog B input map

analogOutputs
SYNTAX

MAX-ACCESS
STATUS
DESCRIPTION

::={audiolo 12}

INTEGER {
output1(0),
output2(1),
output3(2),
}

not-accessible
current

Analog output number. This is used as an index
in the table.
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audBarOutTable
SYNTAX SEQUENCE OF AudBarOutEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for Audio output to bar map
::={ audiolo 13}
audBarOutEntry
SYNTAX AudBarOutEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the audBarOutTable
INDEX { analogOutputs }
::= { audBarOutTable 1}
AudBarOutEntry
::= SEQUENCE {
audAES-A-BarOutput INTEGER,
audAES-B-BarOutput INTEGER,
audAna-A-BarOutput INTEGER,
audAna-B-BarQOutput INTEGER,
audEmbed-A-BarOutput  INTEGER,
audEmbed-B-BarOutput  INTEGER
}
audAES-A-BarOutput
SYNTAX INTEGER {
none(0),
pairi(1),
pair2(2),
pair3(3),
pair4(4),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog output to AES A Bar map

::={ audBarOutEntry 1}
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audAES-B-BarOutput
SYNTAX INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
pair4(4),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog output to AES B Bar map
::= { audBarOutEntry 2 }
audAna-A-BarOutput
SYNTAX INTEGER {
none(0),
pairi(1),
pair2(2),
pair3(3),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog output to Analog A Bar map
::={ audBarOutEntry 3}
audAna-B-BarOutput
SYNTAX INTEGER {
none(0),
pairi(1),
pair2(2),
pair3(3),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog output to Analog B Bar map
::= { audBarOutEntry 4 }
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audEmbed-A-BarOutput
SYNTAX INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
pair4(4),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog output to Embedded A Bar map
::={ audBarOutEntry 5}
audEmbed-B-BarOutput
SYNTAX INTEGER {
none(0),
pair1(1),
pair2(2),
pair3(3),
pair4(4),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog output to Embedded B Bar map
::= { audBarOutEntry 6 }
audVidMap-SDI-A
SYNTAX INTEGER {
none(0),
aesA(1),
aesB(2),
analogA(3),
analogB(4),
embedded(5),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Video to Audio Map for SDI A
::={ audiolo 14 }
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audVidMap-SDI-B
SYNTAX INTEGER {
none(0),
aesA(1),
aesB(2),
analogA(3),
analogB(4),
embedded(5),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Video to Audio Map for SDI B
::={audiolo 15}
audVidMap-Cmpst-A
SYNTAX INTEGER {
none(0),
aesA(1),
aesB(2),
analogA(3),
analogB(4),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Video to Audio Map for Composite A
::={ audiolo 16 }
audVidMap-Cmpst-B
SYNTAX INTEGER {
none(0),
aesA(1),
aesB(2),
analogA(3),
analogB(4),
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Video to Audio Map for Composite B
::={audiolo 17 }
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audOutLvl
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Level of analog audio output volume
::= { audiolo 18 }
audAES-A-ActvChannels
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Active channel selections for AES A
::={audiolo 19}
audAES-B-ActvChannels
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Active channel selections for AES B
::={audiolo 20 }
audAna-A-ActvChannels
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Active channel selections for Analog A
::= { audiolo 21 }
audAna-B-ActvChannels
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Active channel selections for Analog B
::= { audiolo 22 }
audEmbed-A-ActvChannels
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Active channel selections for Embedded A
::={ audiolo 23 }
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Table C-19: Wfm- mon audio input/output group (Cont.)

Object identifier Object type
audEmbed-B-ActvChannels
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Active channel selections for Embedded B
::={audiolo 24 }

Table C-20: Wfm-mon traps group

Object identifier Object/Notification type
trapDestNum
SYNTAX INTEGER {0..4}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Trap destination index number
n={traps 1}
Table {index varies from0to 4 }
trapReport
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Disable/Ensable trap reporting
n={traps 2}
trapDestnTable
SYNTAX SEQUENCE OF TrapDestnEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Table for trapDestn Address
n={traps 3}
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Table C-20: Wfm-mon traps group (Cont.)

Object identifier Object/Notification type
trapDestnEntry
SYNTAX TrapDestnEntry
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION A row in the trapDestn address table
INDEX {trapDestnNum }
::={ trapDestnTable 1 }
TrapDestnEntry
::= SEQUENCE {
t;apDestn DisplayString
trapDestn
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Destination IP Address for traps
::={ trapDestnEntry 1 }
traplnfo
SYNTAX DisplayString
MAX-ACCESS accessible-for-notify
STATUS current
DESCRIPTION Information sent along with the trap. (This OID is
not accessible to GET/GETNEXT/SET requests.)
n={traps 4}
alarmType
SYNTAX INTEGER {
alarm(0),
alarmStart(1),
alarmEnd(2)
}
MAX-ACCESS accessible-for-notify
STATUS current
DESCRIPTION Alarm type: single alarm, alarm start, alarm end
n={traps 5}
sdiSigLossTrap
STATUS current
DESCRIPTION Change in the presence of SDI Input Signal

;= {trapPrefix 1}
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Table C-20: Wfm-mon traps group (Cont.)

Object identifier Object/Notification type
sdiEdhTrap
STATUS current
DESCRIPTION EDH Errors
.= { trapPrefix 2 }
sdiFFCrcTrap
STATUS current
DESCRIPTION EDH Errors in Full Field
::= { trapPrefix 3}
sdiAPCrcTrap
STATUS current
DESCRIPTION EDH Errors in Active Picture
::={trapPrefix 4 }
sdiAesChksumTrap
STATUS current
DESCRIPTION AES audio checksum errors
::= { trapPrefix 5 }
sdiAesFullTrap
STATUS current
DESCRIPTION AES audio extraction buffer FULL errors
::= { trapPrefix 6 }
sdiAesEmptyTrap
STATUS current
DESCRIPTION AES audio extraction buffer EMPTY errors
;= { trapPrefix 7 }
sdiAudioMissTrap
STATUS current
DESCRIPTION Embedded audio channel missing errors
.= { trapPrefix 8 }
sdiAudioPrtyTrap
STATUS current
DESCRIPTION Embedded audio channel parity errors
::= { trapPrefix 9 }
cpstSigLossTrap
STATUS current
DESCRIPTION Composite Input Signal missing
::= { trapPrefix 10 }
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Table C-20: Wfm-mon traps group (Cont.)

Object identifier Object/Notification type
refMissTrap
STATUS current
DESCRIPTION Reference Input missing
.= { trapPrefix 11}
audSigLockTrap
STATUS current
DESCRIPTION Change in the presence of a signal on one or
more audio input pairs
.= { trapPrefix 12 }
audCrcTrap
STATUS current
DESCRIPTION CRC errors on one or more AES audio inputs
;= { trapPrefix 13 }
audValidTrap
STATUS current
DESCRIPTION Incorrectly set VALID bit on one or more AES
audio inputs
.= { trapPrefix 14 }
audParityTrap
STATUS current
DESCRIPTION Parity errors on one or more AES audio inputs
::={ trapPrefix 15 }
audSlipTrap
STATUS current
DESCRIPTION Slipped samples on one or more AES audio
inputs
== { trapPrefix 16 }
audClipTrap
STATUS current
DESCRIPTION Signal clipping on one or more of the audio
inputs channels
;= {trapPrefix 17 }
audOverTrap
STATUS current
DESCRIPTION Signals are over the volume threshold for one or
more of the audio inputs channels
::={ trapPrefix 18 }
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C-70

Table C-20: Wfm-mon traps group (Cont.)

Object identifier Object/Notification type
audMuteTrap
STATUS current
DESCRIPTION Digital mutes on one or more of the audio inputs
channels
;= {trapPrefix 19}
audSilenceTrap
STATUS current
DESCRIPTION Extended period of silence on one or more of the
audio input channels
::={trapPrefix 20 }
[tcMissTrap
STATUS current
DESCRIPTION LTC code missing
.= { trapPrefix 21 }
VitcMissTrap
STATUS current
DESCRIPTION VITC code missing
.= { trapPrefix 22 }
compUnlockedTrap
STATUS current
DESCRIPTION Composite input unlocked
.= { trapPrefix 23 }
refUnlockedTrap
STATUS current
DESCRIPTION External reference unlocked
::= { trapPrefix 24 }
hwFaultTrap
STATUS current
DESCRIPTION Hardware fault (fan failures, over temperatures)
::= { trapPrefix 25 }
sdiUnlockedTrap
STATUS current
DESCRIPTION SDI input unlocked
.= { trapPrefix 26 }
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Table C-20: Wfm-mon traps group (Cont.)

Object identifier Object/Notification type
ltcinvalidTrap
STATUS current
DESCRIPTION LTC code invalid
.= { trapPrefix 27 }
vitcInvalidTrap
STATUS current
DESCRIPTION VITC code invalid
::= { trapPrefix 28 }
gamutRgbTrap
STATUS current
DESCRIPTION RGB Gamut error
== { trapPrefix 29 }
gamutCompositeTrap
STATUS current
DESCRIPTION Composite Gamut error
== { trapPrefix 30 }
gamutLumaTrap
STATUS current
DESCRIPTION Luma Gamut error

;= { trapPrefix 31}

Table C-21: Wfm-mon alarms group

Object identifier Object type
alarmMute
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Suspend sending alarms to Beep, SNMP, and
Ground closure
n={alarm 1}
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C-72

Table C-21: Wfm-mon alarms group (Cont.)

Object identifier Object type
alarmEnable
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Disable/Enable all alarms without changing
individual settings
n={alarm 2}
sdiSigLoss
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION SDI input signal loss alarm notification vector
»={alarm 3}
sdiBadEdh
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION SDI EDH error alarm notification vector
n={alarm 4}
gamutRgb
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Gamut RGB alarm notification vector
n={alam 5}
gamutComposite
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Gamut composite alarm notification vector
n={alarm 6}
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Table C-21: Wfm-mon alarms group (Cont.)

Object identifier Object type
compSigLoss
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite input signal loss alarm notification
vector
n={alarm 7}
refMissing
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Ref signal missing alarm notification vector
n={alarm 8}
ItcMissing
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION LTC timecode missing alarm notification vector
n={alarm 9}
vitcMissing
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION VITC timecode missing alarm notification vector
n={alarm 10}
audioClip
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio signal clipping alarm notification vector
m={alarm 11}
audioMute
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Digital mute alarm notification vector
m={alarm 12}
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C-74

Table C-21: Wfm-mon alarms group (Cont.)

Object identifier Object type
audioOver
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Over the volume threshold alarm notification
vector
n={alarm 13}
audioSilence
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio silence alarm notification vector
n={alarm 14}
audSigLock
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio signal lock alarm notification vector
n={alarm 15}
audioCrc
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION CRC errors in AES audio alarm notification
vector
n={alam 16}
audValidBit
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Incorrect VALID bit in AES input alarm notifica-
tion vector
n={alarm 17}
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Table C-21: Wfm-mon alarms group (Cont.)

Object identifier Object type
audParity
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Parity error in AES input alarm notification vector
n={alarm 18}
eAudStreamMissing
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Embedded audio missing alarm notification
vector
n={alarm 19}
eAudStreamChksum
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Embedded audio checksum error alarm
notification vector
m={alarm 20 }
eAudStreamParity
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Embedded audio parity error alarm notification
vector
n={alarm 21}
compUnlocked
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Composite input unlocked alarm notification
vector
m={alarm 22}
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C-76

Table C-21: Wfm-mon alarms group (Cont.)

Object identifier Object type
refUnlocked
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Ref input unlocked alarm notification vector
n={alarm 23}
hwFault
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Hardware fault alarm notification vector
n={alarm 24}
sdiUnlocked
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION SDI input unlocked alarm notification vector
n={alarm 25}
[tcInvalid
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION LTC timecode invalid alarm notification vector
={alarm 26 }
vitclnvalid
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION VITC timecode invalid alarm notification vector
»={alarm 27}
eAudBufferFull
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Embedded audio buffer full alarm notification
vector
m={alarm 28 }
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Table C-21: Wfm-mon alarms group (Cont.)

Object identifier

Object type

eAudBufferEmpty
SYNTAX
MAX-ACCESS
STATUS
DESCRIPTION

n={alarm 29 }

DisplayString
read-write
current

Embedded audio buffer empty alarm notification
vector

alarmStatus
SYNTAX
MAX-ACCESS
STATUS
DESCRIPTION

»={alarm 30 }

INTEGER
read-only
current

Whether alarm condition exists in the instrument
(non-zero — alarm condition)

0x00000001, sdi_alarm_edh

0x00000002, gamut_rgb_alarm
0x00000004, gamut_composite_alarm
0x00000008, input signal loss
0x00000010, input unlock alarm
0x00000020, comp_alarm_ref_loss
0x00000040, comp_alarm_ref_no_lock
0x00000080, sdi_alarm_aes_full
0x00000100, sdi_alarm_aes_empty
0x00000200, timecode_alarm_ltc_missing
0x00000400, timecode_alarm_vitc_missing
0x00000800, timecode_alarm_ltc_invalid
0x00001000, timecode_alarm_vitc_invalid
0x00002000, audio_alarm_clip
0x00004000, audio_alarm_mute
0x00008000, audio_alarm_over
0x00010000, audio_alarm_silence
0x00020000, audio_alarm_signal_loss
0x00040000, audio_alarm_crc
0x00080000, audio_alarm_valid
0x00100000, audio_alarm_parity
0x00200000, sdi_alarm_audio_missing
0x00400000, sdi_alarm_aes_chksum
0x00800000, sdi_alarm_audio_parity
0x01000000, hwserver_alarm_hw_fault
0x02000000, gamut_luma_alarm
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Table C-21: Wfm-mon alarms group (Cont.)

Object identifier Object type
gamutLuma
SYNTAX DisplayString
MAX-ACCESS read-write
STATUS current
DESCRIPTION Luma gamut alarm notification vector
n={alarm 31}

Table C-22: Wfm-mon LTC Mode group

Object identifier Object type
ltcHorPos
SYNTAX DisplayString
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION LTC waveform horizontal position
n={lc1}
ltcVertPos
SYNTAX DisplayString
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION LTC waveform vertical position
n={ltc2}
[tcGain
SYNTAX INTEGER {
gain-x1(0),
gain-x5(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION LTC waveform fixed gain (1X or 5X)
={ltc3}
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Table C-22: Wfm-mon LTC Mode group (Cont.)

Object identifier Object type
ltcVarGainEnable
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Enable/disable LTC variable gain
n={lc4}
ltcVarGain
SYNTAX DisplayString
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION LTC variable gain
n={ltc5}
ltcHMag
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION LTC waveform horizontal magnification (OFF/
ON)
={ltc6}
ltcCenter
SYNTAX INTEGER
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION LTC Center waveform
n={ltc7}
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Table C-23: Wfm-mon Timing group

Object identifier Object type
timingH
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Horizontal position of the timing offset
z={timing 1}
timingV
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Vertical position of the timing offset
= {timing 2}
relativeTo
SYNTAX INTEGER {
rearPanel(0),
;JserOﬁsetU)
MAX-ACCESS read-write
STATUS current
DESCRIPTION Relative to what the offset should be displayed
={timing 3}
saveOffset
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Saves Offset - trigger type (write-only)
= {timing 4}
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Table C-24: Wfm-mon Audio Analog Display group

Object identifier Object type
audAnaCurOutput
SYNTAX DisplayString
MAX-ACCESS read-only
STATUS current
DESCRIPTION Currently selected analog outputs

::= { audioAnaDisp 1}

audAnaBallistic

SYNTAX INTEGER {
truePeak(0),
ppm(1),
pPm(2)
vu(3)
}

MAX-ACCESS read-write

STATUS current

DESCRIPTION Meter Ballistic selection for Analog Audio: True
peak, PPM, or VU

::= { audioAnaDisp 2 }

audAnaPkHold

SYNTAX INTEGER

MAX-ACCESS read-write

STATUS current

DESCRIPTION Hold time for analog audio peak level indicator
(in seconds)

::={audioAnaDisp 3 }

audAnaErrorHoldTm

SYNTAX INTEGER

MAX-ACCESS read-write

STATUS current

DESCRIPTION The length of time the Analog Audio in-bar error
messages and over indicator is displayed or held
after the error has been removed (in seconds)

::= { audioAnaDisp 4 }
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C-82

Table C-24: Wfm-mon Audio Analog Display group (Cont.)

Object identifier Object type
audAnaOverLvl
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog Audio threshold level for over-volume
detection (in dB)
::={ audioAnaDisp 5 }
audAnaOverTm
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio Over volume duration threshold (in
seconds)
::={ audioAnaDisp 6 }
audAnaSilenceLvl
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio Silence level (in dB)
::= { audioAnaDisp 7 }
audAnaSilenceTm
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio Silence duration threshold (in
seconds)
::={ audioAnaDisp 8 }
audAnaProgLvl
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog Audio Peak program level (in dB). Note:
controls boundary between Yellow and Red on
level meter.
::={ audioAnaDisp 9 }
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Table C-24: Wfm-mon Audio Analog Display group (Cont.)

Object identifier Object type
audAnaTestLvl
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog Audio Test level (in dB). Note: controls
boundary between Green and Yellow on level
meter.
::={audAnaDisp 10 }
audAnaCorrMtrSpd
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio correlation meter speed
::= { audioAnaDisp 11 }
audAnaZeroDbMark
SYNTAX INTEGER {
dBu(0),
peak-level(1),
test-level(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio zero dB mark at one of the three
settings: dB full scale, peak program level, or test
level
::={ audioAnaDisp 12 }
audAnaMeterNum
SYNTAX INTEGER {0..7}
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION Analog audio level meter number. Table (index
varies from 0 to 7)
::= { audioAnaDisp 13 }

Table {index varies from0to7 }
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Table C-24: Wfm-mon Audio Analog Display group (Cont.)

Object identifier Object type
audAnalviTable
SYNTAX SEQUENCE OF AudAnaLviEntry
MAX-ACCESS non-accessible
STATUS current
DESCRIPTION Table for Analog Audio level, Silence/Over Count
OIDs
::= { audioAnaDisp 14 }
audAnalviEntry
SYNTAX AudAnaLviEntry
MAX-ACCESS non-accessible
STATUS current
DESCRIPTION A row in the audio level table
INDEX { audAnaMeterNum }
::={audAnaLviTable 1}
AudAnaLvlEntry
::= SEQUENCE {
audAnaLevel INTEGER
audAnaSilenceCount INTEGER
audAnaOverCount INTEGER
}
audAnalevel
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Returns the level of the Analog Audio in dBFS,
divide by 100 to get dBFS
::={audAnalLvlEntry 1}
audAnaSilenceCount
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Number of analog Silence conditions detected
::={audAnalviEntry 2 }

WVR610A & WVR611A Waveform Rasterizers User Manual



Appendix C: WVR610A & WVR611A Waveform Rasterizers MIB

Table C-24: Wfm-mon Audio Analog Display group (Cont.)

Object identifier Object type
audAnaOverCount
SYNTAX INTEGER
MAX-ACCESS read-only
STATUS current
DESCRIPTION Number of analog Over conditions detected
::={audAnalviEntry 3}
audAnaPkHoldSeg
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Enable for the Peak Hold Segment on the Analog
Level Meters
::={ audioAnaDisp 15 }
audAnaLviMtrScale
SYNTAX INTEGER {
normal(0),
custom(1))
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio meter scale display mode (in Ul)
::={audioAnaDisp 16 }
audAnaMeterType
SYNTAX INTEGER {
dbu(0),
din(1)
nordic(2)
vu(3)
ieee(4)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog Audio Meter Preset Modes: dbu(0),
din(1), nordic(2), vu(3), ieee(4)
::= { audioAnaDisp 17 }
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Table C-24: Wfm-mon Audio Analog Display group (Cont.)

Object identifier Object type
audAnaLviMtrHeight
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio meter scale top when it is in custom mode
(in'UI)
::= { audioAnaDisp 18 }
audAnaLviMtrOffset
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Audio meter scale offset when it is in custom
mode (in Ul)
::={audioAnaDisp 19 }
audAnaGratStepSize
SYNTAX INTEGER
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio meter scale graticule step size
::={ audioAnaDisp 20 }
audAnalissAGC
SYNTAX INTEGER {
off(0),
on(1)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio lissajous AGC enable
::= { audioAnaDisp 21 }
audAnaSessionCtrl
SYNTAX INTEGER {
reset(0),
stop(1)
run(2)
}
MAX-ACCESS read-write
STATUS current
DESCRIPTION Analog audio session control
::= { audioAnaDisp 22 }
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Appendix D: Upgrading the Waveform Rasterizer Firmware

System Upgrade (CONFIG> Utilities > System Upgrade) is used to upgrade the
system software of the WVR610A & WVRG611A. The upgrade is performed
across an Ethernet network using a PC to transfer the new software to the
WVR610A & WVR611A.

The firmware upgrade process involves the following steps:

PC System Requirements

Downloading the firmware package ZIP-file from the Tektronix website.
Initiating the update mode on the waveform rasterizer.

Unzipping the firmware package and using the enclosed data-transfer utility
to send the new firmware data to the instrument you are upgrading.

Verifying the operation of the instrument after the firmware upgrade.

Before you download the WVR610A & WVRG611A firmware-upgrade package,
verify that your PC meets these requirements.

The data-transfer utility for upgrading the WVR610A & WVRG611A runs on the
following PC systems:

Windows 98
Windows NT 4.0
Windows 2000
Windows ME systems
Windows XP

Additionally, your PC requires the following minimum system-requirements to
load and operate the data-transfer utility used to upgrade the waveform rasterizer:

Winsock 2.0
Ethernet interface

10 MB of free disk space
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Firmware Package Download

You can download the latest version of the WVR610A & WVR611A firmware
from the Tektronix website at the following URL:

http://www.tek.com/Measurement/video audio

From there, follow the links to Software & Drivers, and then to Video Test to
locate the waveform rasterizer firmware-upgrade package.

When you download the upgrade package, you will receive a self-extracting ZIP
file containing the following files:

m transfer.exe (data-transfer utility program)
B firmware.pkg (waveform rasterizer firmware-upgrade data file)

B readme.txt (release notes)

Preparing for the System Upgrade

Once you have downloaded a system upgrade package, unzip the file. Next,
write down the network address of the waveform rasterizer you plan to upgrade.

NOTE. When using DHCP, there is a small possibility that the waveform
rasterizer will be assigned a different address when the software update mode is
activated. If the unit is not off or disconnected from the network long enough,
then typically the waveform rasterizer will get the same address as it had
previously. This means that you can go to the Config menu and get the current IP
address and use that in the update process. If this does not work the first time
you may need to try again or use the manual IP address mode.

During firmware upgrade mode, the boot monitor might turn on the instrument
FAULT light on the front panel if it detects an error. The boot monitor may
signal a FAULT after an unsuccessful firmware update operation or from an error
in the DHCP software. This FAULT will not be logged into the diagnostic log
since the boot monitor is running, not the main instrument software.

The boot monitor will assert a FAULT after an unsuccessful firmware update
operation. The failure of the firmware update can be caused by a network
communication error, timeout or a corrupt firmware package. When it detects a
firmware update error, the instrument will return to the ready state (tile buttons
flashing). You can then try to resend the firmware data to the instrument. In the
case of repeated failures, check to make sure that you have the correct firmware
release for the instrument.
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In bootrom version 1.5 and later, the boot monitor might also detect errors in the
DHCP software which can result from repeatedly switching between factory and
DHCP network settings. If the FAULT light remains lit and the instrument fails
to obtain an address from a DHCP server, reboot the instrument by pressing one
of the MEASURE SELECT buttons or by removing power from the instrument.
When the instrument reboots, hold down the FULL button to return the
instrument to the firmware update mode.

lit), DO NOT remove power from the instrument. If you remove power while the
instrument is reprogramming flash, the flash image will be corrupted and the
instrument will only boot in the firmware update mode until new firmware has
been loaded into the instrument flash. Use the MEASURE select buttons to abort
a firmware update. Remove power from the instrument only as a last resort.

é CAUTION. Once the instrument has started to erase internal flash (VECT button

NOTE. If you have an instrument with a bootrom version prior to 1.5, set the IP
configuration mode to Manual or DHCP before performing a firmware update.
Older bootrom versions have a bug that prevents them from switching back to
DHCP mode after switching to the factory default network configuration while
in the SW update mode.

In bootrom version 1.5 and later, the instrument will automatically switch to
factory default if DHCP discovery fails. Press the SEL button to restart DHCP
discovery.

Table D-1 describes the appearance of the front-panel buttons as the firmware
upgrade process progresses.

Table D- 1: Button animation sequences

Button indication State Description

Flashing DISPLAY SE- Ready Instrument is ready to receive

LECT buttons firmware data and is waiting for a
connection from the PC host

Flashing arrow buttons DHCP discovery Instrument is negotiating for an IP
address from a DHCP server

SEL button lit Factory IP configuration Instrument is configured with factory
default IP address of 192.168.1.1

Arrow and SEL not lit Manual IP configuration Instrument is configured with manual
IP configuration

Arrow buttons lit, SEL not | DHCP configuration Instrument has received an IP

lit address from a DHCP server
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Table D- 1: Button animation sequences (Cont.)

Button indication State Description

WFM button lit Receiving firmware Instrument is receiving firmware data

VECT button lit Erasing flash memory Instrument is erasing internal flash
memory

MEAS button lit Programming flash Instrument is programming internal

memory flash memory

1X button lit Verifying flash memory Instrument is verifying programming

of internal flash memory

Installing the Firmware

To install new firmware in a waveform rasterizer:
1. On the waveform rasterizer, press CONFIG to display the Config menu.

2. Select Utilities and press the right-arrow key to change the menu focus to the
submenu.

3. Select System Upgrade and press SEL. This displays the System Software
Upgrade window. See Figure D-1.

System Software Upgrade

A good check before starting this process is testing the WEB Interface

Connection between the PC and this instrument.

If you decide to continue, this process will result in new software being

loaded into this instrument.

Cancel B Continue

Figure D-1: Select continue to begin the firmware upgrade process

4. To continue with the upgrade, press the right-arrow key to select Continue
and press SEL.

NOTE. You can also place the waveform rasterizer into the upgrade mode by
pressing the FULL button while applying power to the instrument.
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This places the waveform rasterizer into the upgrade mode. The monitor
display will go to black and the DISPLAY SELECT keys will flash in
sequence. If the instrument is in DHCP mode, the arrow keys will also flash.

NOTE. If the waveform rasterizer is in DHCP mode, wait until the arrow keys
stop flashing before proceeding.

If you don’t recall the IP address of the waveform rasterizer, there are two
ways to proceed. One, you can temporarily set the IP address to the default
value (192.168.1.1) once it is in upgrade mode by pressing SEL. After the
upgrade is completed, the original IP address will be restored. Two, you can
cycle the power and the instrument will exit upgrade mode and return to
normal operation. Then you can check the IP address in the Config >
Network Settings submenu.

5. On the PC, double-click the transfer.exe file to launch the transfer program.
This displays the window shown in Figure D-2.

Please enter DNS name or address of target instrument:

Figure D-2: Transfer utility window

6. Type the network address (for example: 198.181.221.123) or DNS name of
the waveform rasterizer you wish to update, and then press Enter. This starts
the firmware upgrade process.

To stop the firmware update, you can press any MEASURE button on the
front-panel of the waveform rasterizer before the transfer utility begins
erasing the flash ROM. Once the words Erasing Flash... appear in the
transfer utility window, you cannot stop the update.

As the firmware upgrade begins, the buttons on the waveform rasterizer will
stop flashing. Next, buttons on the waveform rasterizer will illuminate to
indicate the progress of the software upgrade.

B As each stage completes, the following buttons illuminate in sequence
WFM, VECT, MEAS, and 1X.
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D-6

B While each stage progresses, the middle row of buttons (PICT, AUDIO,
OTHER, 5X and so forth) illuminates.

B When CONFIG illuminates, the stage in process has completed.

7. The transfer utility displays done when the software upgrade completes. See
Figure D-3.

Please enter DNS name or address of target instrument:
128.181.221.2

Opened TCP connection to 128.181.221.2:77

Reading Firmware Data... done

Erasing Flash... done

Programming Flash... done

Uerifying Flash Programming... done

done.

Please enter DNS name or address of target instrument:

Figure D-3: Done appears when the software upgrade completes

When the software upgrade completes, the waveform rasterizer will reboot.

8. To update another waveform rasterizer, begin at step 1 and skip step 5. If you
won’t be updating another waveform rasterizer, press Enter to exit the
transfer utility.
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Upgrading Multiple Instruments

Verifying the Upgrade

You can upgrade several instruments in in one session, one at a time. To do this,
use the Windows Command Prompt. Enter the following line in a Command
Prompt window (substituting the addresses of your machines):

transfer.exe 192.181.115.1 192.181.115.2 192.181.115.3
Separate the addresses with a space.

Alternatively, you can use file redirection to input the IP addresses to the
transfer.exe utility. To do this, create a text file containing a carriage-return
delimited list of [P addresses or DNS names for the instruments to be updated. If
you created a text file named HOSTS.TXT, you would enter the following
command to update a group of instruments:

transfer.exe < HOSTS.TXT

After you have completed the firmware upgrade, the instrument will reboot and
come up in an operational mode.

NOTE. When you perform a firmware upgrade, the Readme.txt file that is
included with the firmware-upgrade package will document whether all of the
current Configuration menu and instrument-mode settings are preserved.

To verify the functional performance of your instrument, perform the procedures
located in Appendix E: Incoming Inspection.
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Use this procedure to check the basic functionality of a Tektronix WVR610A or
WVR611A waveform rasterizer. The checks are arranged by model and option so
that you can choose the sections that are appropriate for your instrument. The
last two sections are for less critical waveform rasterizer features: the ground
closure and Ethernet ports. You need only test these if you intend to use them. In
general, you should test in the order presented, since later tests may depend upon
items checked in the earlier tests.

List of Tests

Table E-1: Incoming inspection tests

Instrument/Option
Page Description Covered
E-5 Basic Turn On and Self Test All
E-5 Front Panel Test All
E-6 XGA and Extended Diagnostics Test Al
E-7 Fan Test Al
E-7 SDI Input All
E-8 External Reference All
E-9 Composite Input WVR611A
E-9 Analog Audio Input Option AN and DA
E-10 Analog Audio Output Option AN and DA
E-11 Digital Audio Input Option DG and DA
E-12 Digital Audio Output Option DG and DA
E-13 LTC Decode and Waveform Test All
E-14 Ground Closure Remote All
E-15 Ethernet Test All
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WVR610A & WVR611A Waveform Rasterizer Functional Test Record

Instrument Serial Number:

Certificate Number:

Temperature: RH %:
Date of Calibration: Technician:
Functional Test (Incoming Inspection) Incoming Outgoing Comments

Basic Turn On and Self Test

Front Panel LEDs

POST

Front Panel Test

Factory Preset

Buttons and Knobs

XGA and Advanced Diagnostics Test

Color Palette Test

XGA DAC

Advanced Diagnostics

Fan Test

SDI Bit Integrity

External Reference

NTSC Lock

Ref Missing

Composite Input

CMPST A, WFM with NTSC

CMPST A, Vector with NTSC

CMPST A, Picture with NTSC

CMPST B, WFM with NTSC

CMPST B, Vector with NTSC

CMPST B, Picture with NTSC

Analog Audio Input

Analog Audio input A ports 1 -6 display bar

Analog Audio input B ports 1 -6 display bar

Analog Audio Output

Digital Audio Input

AES Audio input A to Display Bar

AES Audio input B to Display Bar

Embedded Audio to Display Bar

Embedded Audio to Lissajous Display
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WVR610A & WVR611A Waveform Rasterizer Functional Test Record (cont.)

Instrument Serial Number: Certificate Number:
Temperature: RH %:
Date of Calibration: Technician:
Functional Test (Incoming Inspection) Incoming Outgoing Comments

Digital Audio Output
AES B 1-2 Audio Output
AES B 3-4 Audio Output
AES B 5-6 Audio Output
AES B 7-8 Audio Output

LTC Decode and Waveform Test
LTC Waveform Presence
LTC Decode

Ground Closure Remote

Remote Input — Activate Preset 1

Remote Output — Ground Closure

Ethernet Functionality
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Required Equipment
Necessary Equipment:
B XGA monitor and cable
B Two 75 Q terminations
®  High quality 75 € BNC cables

B Analog audio breakout cable, Tektronix part number 012-1658-01 or
equivalent (Option AN and DA only)

®  AC power source 100 to 240 volts at 1 amps

®  SDI with embedded audio and composite signal source — Tektronix TG2000
with BG1, AVG1, and DVG1 (AVG1 only needed for WVR611 units,
embedded audio only needed for Audio Option DA and DG)

B AES Audio Signal Generator with 48kHz, 24 bit word length signals.
Examples: Rohde & Schwarz UPL06, Tektronix AM700 and AM70.

B AES Audio Signal Analyzer. Examples: Rohde & Schwarz UPLO6,
Tektronix AM700.

B Analog Audio Signal Generator. Examples: Rohde & Schwarz UPL06,
Tektronix AM700.

B Video Test Signals:
m  SDI 525 10-bit shallow ramp
®  SDI 525 100% sweep
®  NTSC black
m  NTSC SMPTE bars

B 15-pin, 2-row DSUB male connector and cable to mate with the ground
closure port

B Voltmeter — Fluke 87 or equivalent
m  FEthernet cable and Computer to test Ethernet connection

B LTC Generator — Horita TG-50 or equivalent
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Basic Turn On and Self Test

1.

Front Panel Test

Connect a XGA monitor to the connector on the rear of the waveform
rasterizer.

Connect the AC line cord to the rear of the instrument and to a 100 to
240 VAC source. There is no power switch on the waveform rasterizer, so
the instrument will turn on as soon as you apply power.

Look at the front panel immediately after you apply power. All the buttons
should be lit, the text over the three knobs should also be lit, and the Fault
indicator should light up.

After a couple of seconds, the lights in the buttons and text will turn off.
After about 15 seconds the fault light should turn off.

Also after about 15 seconds, the Power on diagnostic page should appear on
the XGA monitor.

Verify that all self tests pass. Any failures will be shown in Red. The results
of the Power on diagnostics are erased from the screen, but you can view
them the results by selecting CONFIG > Utilities > View Diagnostics Log.

After the diagnostics are finished, the instrument state will be restored.
When the progress indicator in the lower-right part of the screen is finished,
the instrument has finished initializing.

Record Pass or Fail for the POST in the test record.

Press FACTORY to restore the factory preset. Wait for the process to
complete as indicated by the progress indicator.

Connect the DVG1 output to the SDI A input. Terminate the SDI loop-
through.

Press FULL to make the active tile be full screen.
Press HELP to display the help screens.
Press all the other buttons.

Each one should flash as you press it. Most buttons should bring up help text
for that button in the right pane of the help screen. Some buttons, such as the
presets, all bring up the same information so you may need to alternate
between preset buttons and another button to see the text change. The HELP
and navigation keys (the four arrow keys and the SEL key) do not bring up
help text since they are used to traverse the help panes and content.
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6. Press the right arrow key until the Help Contents pane in the upper-left
corner is highlighted.

7. Turn the GENERAL knob and verify the selector box moves up and down
the list.

8. Press HELP to exit help.

9. Turn the HORIZONTAL and VERTICAL knobs and verify the waveform
moves appropriately.

10. Record Pass or Fail for Buttons and Knobs in the test record.

XGA and Extended Diagnostics Test
1. Press CONFIG to display the CONFIG menu.
2. Select Utilities and then press SEL.
3. Select CPU Color Palette Test then press SEL.

4. Verify that 16 distinct colors are displayed. This tests the XGA data path
from the CPU.

5. Press the left arrow key to change the menu focus back to the Utilities
submenu.

6. Select Run Advanced Diags and then press SEL.

7. Use the right-arrow key to highlight the Continue box and then press SEL
to run the test.

8. Verify the XGA DAC is working by looking at the White and Red steps at
the top of the screen, and at the Green and Blue ramps at the bottom of the
screen. They should not have steps but should instead have a smooth
transition from dark to light.

9. Record Pass or Fail for XGA DAC in the test record.

10. Verity the following frequencies are within 10 kHz of the nominal value
listed below:

a. SDI Clock = 27.000 MHz
b. VGA clock = 64.000 MHz
c¢. Audio PLL = 12.288 MHz
d. Analog Pix = 27.000 MHz (WVR611A only)
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11.

12.

13.
14.

Fan Test

e. Hsyncrate: Width=19 : 3 us
f. Vsyncrate : Width = 16737 : 64 us

g. Lissajous Frequencies — Liss[0,1] = 19.8 MHz-20.1 MHz (only if audio
option installed)

Verify that all the tests in the middle section of the screen have a green Pass
status.

Verify that the bus bit activity tests (SDI PIX and VGA PIX) at the bottom
of the screen show both a red and a green bar in each bit location. The VGA
PIX line (XGA bus) should show 8 bits from the CPU, a space, then Hsync,
a space, Vsync, a space and then the blank line. It is normal for the V sync
bit to blink occasionally.

Press SEL or cycle the power to re-boot the unit in normal operation.

Record Pass or Fail for Advanced Diagnostics in the test record.

If the fault light in the lower left corner of the front panel is not on (Red), then
the fans are running. You should also be able to hear them and feel air coming
out the back of the instrument. At low temperatures the fans will turn slowly and
be very quiet. Record Pass or Fail for Fan Test in the test record.

SDI Input — Check Bit Integrity

1.

AN

N

Apply a 10-bit 525 shallow ramp to the SDI A port. Install a termination on
the other side of the loop through.

Press FACTORY to restore the factory preset.

Press and hold WFM to bring up the WFM pop-up menu.

Use the arrow keys to select the Pr and Pb waveforms and turn them off.
Press the 5X gain button.

Press the VAR gain button and then use the GENERAL knob to increase the
gain to 10X.

Press FULL to expand the tile to full screen.

Count the steps in the waveform. There should be 11 to 13 even vertical
steps in each major division (10 mV). The steps should always step upward
in a monotonic ramp.
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External Reference

E-8

10.
11.

12.

13.

n

L ®» A

11.

12.

Press VAR to switch variable gain off and press 1X to get back to normal
gain.

Change the input signal to a 100% sweep.

Verify the sine waves are uniform and do not have steps. Also verify the
amplitude is 700 mV.

If desired, move the input and termination to input B, select input B from the
front panel and repeat steps 5 through 11.

Record Pass or Fail for SDI Bit Integrity in the test record.

Press FACTORY to restore the factory preset.

Apply a 525 SDI signal to SDI A from the TG2000 DVG1 module. Install a
termination on the loopthrough.

Apply an NTSC signal to the External Reference Port from the TG2000 BG1
module. Install a termination on the loopthrough.

Select EXT REF on the waveform rasterizer front panel.

The status bar in the lower left-hand corner of the display should display
Ref: Ext NTSC.

Press the display select 4 button, then WFM, then FIELD.
Verify that both WFM tiles are stable.
Record Pass or Fail for NTSC Lock in the test record.

Remove the NTSC signal from the reference input.

. Both WFM tiles should “unlock” and scroll.

The status bar in the lower left-hand corner of the display should display
Ref: Ext. Missing.

Record Pass or Fail for Ref Missing in the test record.
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Composite Input

10.

Analog Audio Input

9.

10.

Press FACTORY to restore the factory preset.

Apply an NTSC SMPTE bar signal from the TG2000 AVG1 module to the
Composite A port. Install a termination on the loop through.

Select the CMPST A input from the front panel.

Observe the WFM in tile 1, the signal should be aligned with the zero
graticule.

Record Pass or Fail in the test record.

Observe the Vector in tile 2, the burst should be aligned with the burst
marker that extends to the left of the vector center.

Record Pass or Fail in the test record.

Observe the picture in tile 3. It should be stable and show the color bar
signal.

Record Pass or Fail in the test record.

If desired, move the input and termination to input B and repeat steps 3 — 8.

Press FACTORY to restore the factory preset.
Set the analog audio generator to output a 1 kHz, 18dBu sine wave.

Press and hold the display select button 4 to display the AUDIO pop-up
menu.

In the Audio Input submenu, select Analog A.

Using the audio breakout cable or equivalent, connect the first Line A input
pair to the analog audio generator and verify that the output level of the
generator is indicated on the audio bars with a —6 dBFS signal.

Repeat step 5 for the second and third line A input pair.
Record Pass or Fail in the test record.

Bring up the AUDIO pop-up menu again and select Analog B in the Audio
Input submenu.

Repeat step 5 for all three Line B input pairs.

Record Pass or Fail in the test record.
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Analog Audio Output

E-10

10.

11.

12.

13.

14.

15.

16.

Press FACTORY to restore the factory preset.

Press and hold the display select button 4 to display the AUDIO pop-up
menu.

In the Audio Input submenu, select Analog A.

Using the audio breakout cable or equivalent, connect the first Line A input
pair to the analog audio generator and verify that the output level of the
generator is indicated on the audio bars with a —6 dBFS signal.

Press CONFIG to display the CONFIG menu.

In the Audio Inputs/OQutputs submenu, set Attenuate Audio Output to
0 dB (press SEL and use the GENERAL knob to adjust the value, then press
SEL again when you have set the value).

While in the Audio Inputs/OQutputs submenu, select Analog A and from
the submenu select Analog Out Map. Press SEL to display the Analog
Output to Analog “A” Bar Map.

Put an X in the first bar pair position for Analog Output 0, Analog Output 1,
and Analog Output 2.

Press CONFIG to exit the CONFIG menu.

Connect the first analog output pair on the breakout cable to the second line
A input pair.

Verify on the level meter bars that the second set of bars is within 1 dB of
the first set of bars.

Connect the second analog output pair on the breakout cable to the second
line A input pair.

Verity on the level meter bars, that the second set of bars is within 1 dB of
the first set of bars.

Connect the third analog output pair on the breakout cable to the second line
A input pair.

Verity on the level meter bars, that the second set of bars is within 1 dB of
the first set of bars.

Record Pass or Fail in the test record.

WVR610A & WVR611A Waveform Rasterizers User Manual



Appendix E: Incoming Inspection

Digital Audio Input

bt

A A A L

11.
12.
13.
14.
15.

Press FACTORY to restore the factory preset.
Set the digital audio generator to output a 1 kHz, -6dBFS sine wave.

Press and hold the display select button 4 to display the AUDIO pop-up
menu.

In the Audio Input submenu, select AES A.

Connect the output of the digital audio generator to the AES A 1-2 input.
Verify that the first set of level meter bars indicates —6 dBFS.

Repeat steps 5 and 6 for AES A 3-4, AES A 5-6, and AES A 7-8.
Record Pass or Fail for AES A in the test record.

Press and hold the display select button 4 to display the AUDIO pop-up
menu.

. In the Audio Input submenu, select AES B (make sure it is configured as an

input in the CONFIG menu).
Connect the output of the digital audio generator to the AES B 1-2 input.
Verify that the first set of level meter bars indicates —6 dBFS.
Record Pass or Fail for AES B in the test record.
Repeat steps 11 and 12 for AES B 3-4, AES B 5-6, and AES B 7-8.
Set the SD signal generator for the following signal output:
a. 525 format color bars
b. Embedded audio: 2 groups starting with group 1
c. Set the audio channels as follows:

i.  Channel 1: 50 Hz, -35 dB

ii. Channel 2: 100 Hz, -30 dB

fii. Channel 3: 150 Hz, -25 dB

iv. Channel 4: 200 Hz, -20 dB

v.  Channel 5: 250 Hz, -15 dB

vi. Channel 6: 300 Hz, -10 dB

vii. Channel 7: 400 Hz, -5 dB
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Digital Audio Output

E-12

16.

17.

18.
19.

20.
21.
22,

23.

g

S AU S e

10.

11.
12.

viii. Channel 8: 500 Hz, 0 dB

Connect the output of the SD signal generator with embedded audio to the
port A SDI input.

Press and hold the display select button 4 to display the AUDIO pop-up
menu.

In the Audio Input submenu, select Embedded.

Verify that the level meter bars have a stair step pattern from —35 dB on
channel 1 to 0 dB on channel 8.

Record Pass or Fail for Embedded Display in the test record.
Bring up the audio tile pop-up and set the phase pair to 1 & 2.

Go through the other phase pairs 3 & 4, 5 & 6, 7 & 8) and verify that the
phase display changes in each one.

Record Pass or Fail for Embedded to Lissajous in the test record.

Press FACTORY to restore the factory preset.

If you have just finished testing the Digital Audio Inputs, proceed to step 3,
otherwise do steps 15-19 of the Digital Audio Input test.

Press CONFIG to display the CONFIG menu.

Select Audio Inputs/Outputs.

Under the AES B submenu, configure the port as an Output.
Press CONFIG to close the menu.

Connect the AES B 1-2 output to the Audio Signal Analyzer input.

Verify on the analyzer that the signal levels are at —35 dB for the left channel
and —30 dB for the right.

Connect the AES B 3-4 output to the Audio Signal Analyzer input.

Verify on the analyzer that the signal levels are at —25 dB for the left channel
and —20 dB for the right.

Connect the AES B 5-6 output to the Audio Signal Analyzer input.

Verify on the analyzer that the signal levels are at —15 dB for the left channel
and —10 dB for the right.
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13.
14.

15.

Connect the AES B 7-8 output to the Audio Signal Analyzer input.

Verify on the analyzer that the signal levels are at —5 dB for the left channel
and 0 dB for the right.

Record Pass or Fail for each output in the test record.

LTC Decode and Waveform Test

1.
2.

$» ® A D

11.
12.

13.

Press FACTORY to restore the factory preset.

Connect the LTC generator to pins 7 and 8 of the remote connector. This will
require making a custom cable assembly.

Connect the TG2000 DVG1 SDI output to the SDI A input. Terminate the
loopthrough.

Connect the TG2000 composite output to the video input of the Timecode
generator.

Select any NTSC signal for the AVGL.

Select any 525 signal for the DVGI.

Press CONFIG and select LTC/VITC.

Use the navigation keys to set the timecode source to be LTC.

Press Other to display the LTC waveform.

. The LTC waveform should be displayed in the active tile. The amplitude will

depend on the source. The sync packet should remain at a constant horizontal
location on the sweep.

Record Pass or Fail for the LTC waveform in the test record.

In the lower-right corner of the screen, the time from the LTC input should
be shown.

Record Pass or Fail for LTC Decode in the test record.
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Ground Closure Remote

E-14

2w b

10.
11.
12.
13.

14.

15.
16.
17.
18.

Connect an SDI signal to SDI input A and terminate the loopthrough.
Press FACTORY to restore the factory preset.
Press PICT to display a picture in tile 1.

Press and hold the PRESET 1 button until the message Preset #1 was saved
is displayed in the active tile. You will need to hold the button for 1 to 2
seconds.

Press FACTORY again.

On a 15-pin DSUB connector, solder wires or strip back insulation to gain
access to pins 2, 5, and 9.

Connect the DSUB connector to the ground closure remote connector on the
waveform rasterizer.

Short pins 2 and 5 together on the remote cable.

Preset 1 should be restored so that a picture is displayed in tilel.

Record Pass or Fail for Activate Preset in the test record.

Connect the voltmeter to pins 2 and 9 of the DSUB connector.

Verify the voltage is about 4.7 V. This indicates the output is not asserted.

Press CONFIG to display the CONFIG menu. Select Alarms and then
select SDI Input.

Use the arrow keys to get to the top right corner of the SDI Input error check
box, and press SEL to put an “X” in the box for the Ground Closure
column and the SDI Input Missing row. This instructs the waveform
rasterizer to assert the ground closure if the SDI input is not present.

The voltmeter should still read about 4.7 V on pin 9.
Remove the input signal from SDI A connector on the rear panel.
The voltmeter should now read a low voltage, below 0.5 V.

Record Pass or Fail for Ground Closure in the test record.
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Ethernet Test

Connect an Ethernet cable from the rear of the unit to a computer with a Web
browser.

Press FACTORY to restore the factory preset.
Press CONFIG to display the Configuration menu.

Select Network Settings and press the right-arrow key to change the menu
focus to the submenu.

Verity the IP Config Mode is set to Manual.

Select IP Address and press the right-arrow key to change the menu focus to
the submenu.

Use the left/right arrow keys to move the highlight to each box in the
address. Use the up/down arrow keys to change the number in each box as
required. Configure the IP Config Mode and IP Address to be compatible
with the computer.

To accept your changes, move the highlight to the Accept box and press
SEL.

From the computer, enter the IP address of the waveform rasterizer into the
Web browser address line (for example, http://192.182.256.23).

You should see a Web page that lists several options for accessing the
waveform rasterizer from the PC. If this happens, then the Ethernet function
is working.

10. Record Pass or Fail for Ethernet in the test record.
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Appendix F: User Maintenance

Cleaning

General Care

VAN

/N

This appendix contains procedures for cleaning the instrument and performing
preventive maintenance on the waveform rasterizer.

Protect the instrument from adverse weather conditions. The instrument is not
waterproof.

CAUTION. To avoid damage to the instrument, do not expose it to sprays, liquids,
or solvents.

Do not use chemical cleaning agents; they may damage the instrument. Avoid
chemicals that contain acetone, benzene, toluene, xylene, or similar solvents,
because they may damage the plastic.

WARNING. To avoid personal injury, remove the power cord before cleaning the
instrument.

Cleaning the Exterior

/N

Remove the power cord before cleaning the instrument. Clean the exterior
surfaces of the instrument with a dry, lint-free cloth or a soft-bristle brush. If dirt
remains, use a cloth or swab dampened with a 75% isopropyl alcohol solution. A
swab is useful for cleaning in narrow spaces around the controls and connectors.
Do not use abrasive compounds on any part of the instrument.

CAUTION. Do not allow moisture inside the instrument. During exterior cleaning,
use only enough solution to dampen the cloth or swab.

Preventive Maintenance

Preventive maintenance mainly consists of periodic cleaning. Periodic cleaning
reduces instrument breakdown and increases reliability. Clean the instrument as
needed, based on the operating environment. Dirty conditions may require more
frequent cleaning than computer-room conditions.
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Glossary

Accuracy
The closeness of the indicated value to the true value.

Ancillary Data
Data supporting the video signal or program. Time multiplexed into the
video signal during the horizontal and/or vertical blanking intervals.
Ancillary data may be sent between the EAV and SAV packets in horizontal
blanking and in larger blocks during vertical blanking. Ancillary data may
include checksums, multi-channel digital audio, and other data.

Ballistics
The response characteristics of a meter. In other words, how quickly does a

meter respond to a change in signal level. In the waveform rasterizer you can
set the audio display ballistics to True Peak, PPM, and VU.

Bandwidth
The range of frequencies over which signal amplitude remains constant
(within some limit) as it is passed through a system.

Baseband
Refers to a signal that is not yet modulated on a carrier.

Brightup
A change in the display that occurs on specified conditions. For example,
you can set the picture display to “brightup” on an RGB gamut error. Areas
that are outside the acceptable gamut are displayed as a crosshatch pattern.

Color Difference Signals
Signals used by color television systems to convey color information in such
a way that the signals go to zero when there is no color in the picture. R-Y,
B-Y, I, and Q are all color difference signals for the NTSC system; U and V
are color difference signals for the PAL system. The component system color
difference signal are Y, P, PR as specified by SMPTE and CCIR standards.

Color Gamut
The area between minimum and maximum reproducible limits for elements
of the color difference or RGB signals.

Component Video
Video which exists in the form of three separate signals, all of which are
required in order to completely specify the color picture. For example, R, G,
and B; or Y, R-Y, and B-Y.

Composite Video
A single video signal containing all of the necessary information to
reproduce a color picture. Composite video is created by adding quadrature
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amplitude modulated R-Y and B-Y to the luminance signal for NTSC
systems or U and V to the luminance signal for PAL systems.

DC Restorer
A circuit that automatically adjusts the level of the video signal to keep a
selected point on the signal at a fixed DC level.

CRC
Cyclic Redundancy Check. A CRC calculation is performed on a data set
and the result is compared to a checksum. If there is a difference, then an
error occurred.

dB (Decibel)
A logarithmic unit used to describe signal ratios. For voltages, dB = 20

Logio (V1/V2).

dBFS
A signal ratio referenced to Full Scale. Full scale refers to the maximum
level possible without clipping.

DHCP
Acronym for Dynamic Host Configuration Protocol. A network management
protocol for dynamically assigning Internet Protocol (IP) network addresses
to a machine from a central server. DHCP is based on the less advanced
Bootstrap protocol.

Diamond Display
An X-Y display for RGB signals that defines the valid gamut limits in the
form of two diamonds.

Distortion
See harmonic distortion.

EAV
Acronym for End of Active Video in component digital systems. One of two
(EAV and SAV) timing reference packets.

EDH
Error detection and handling. Supports the standard SMPTE RP-165, which
defines a technique for recognizing inaccuracies in the serial digital signal.

Frame
Contains all the information required for a complete picture. For interlaced
scan systems, there are two fields in a frame.
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Gamma
A measure that compares the contrast in the original and reproduced
television picture. Since CRT picture monitors have a nonlinear relationship
between the input voltage and brightness, the signal must be correspondingly
enhanced to nullify the nonlinear distortion. Gamma correction is always
done at the source (camera) in television systems: the R, G, and B signals are
converted to R1/y, G1/y, and Bl/y. Values of about 2.2 are typically used for
gamma.

Gamut
See Color Gamut.

GBR
See RGB.

Graticule
The scale used to quantify the displayed signal on a waveform monitor or
vectorscope.

Harmonic Distortion
Signal distortion caused by non-linearities in a system. System non-lineari-
ties produce multiples of a single frequency signal applied to the the system.
Harmonic distortion is evident when a pure sine wave applied to a system
produces harmonic content at multiples of the sine wave frequency at the
output.

Hue
The property of color that allows us to distinguish between colors such as
red, yellow, purple, etc.

Lightning Display
A display, for use with SMPTE specified color difference signals (Y, P,
PRr), that plots the two color difference signals against luminance to create a
display similar in appearance to a lightning bolt.

Linear Distortion
Refers to distortions that are independent of signal amplitude.

Lissajous figure
An X-Y plot in which the signals applied to both axes are sinusoidal
functions. For a stable display the signals must be harmonics. Lissajous
figures are useful for determining phase and harmonic relationships.

LSB
Least Significant Bit. The lowest weighted bit or signal line.

LTC
Acronym for Longitudinal Time Code. A time code recorded on a videotape
in the form of an audio signal. See also VITC.
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Luminance
The signal (Y) which represents brightness or the amount of light in the
picture. Luminance is the only signal required for black and white pictures.
For color systems, it is obtained as a weighted sum of the R, G, and B
signals.

MIB
Acronym for Management Information Base. A database used by an SNMP
agent.

MSB
Most Significant Bit. The highest weighted bit or signal line.

Nonlinear Distortion
Refers to distortions that are amplitude-dependent.

NTSC
National Television System Committee. The organization that developed the
television standard currently in use in the United States, Canada, and Japan.
Now generally used to refer to that standard.

NTSC Setup
In NTSC systems, video black is typically 7.5 IRE above the blanking level.
This is 7.5 IRE level is referred to as the black setup level or simply setup or
NTSC setup.

PAL
Phase Alternate Line. Refers to one of the television systems used in Europe
and many other parts of the world. The phase of one of the color difference
signals alternates from line to line to help cancel out phase errors.

Pb
A color difference signal used in component video systems. It is derived by
subtracting the B (blue) signal from Y.

Pr
A color difference signal used in component video systems. It is derived by
subtracting the R (red) signal from Y.

PPM
PPM is an acronym for Peak Program Meter.

Receiver Equalization
Refers to recovering the data signal after cable loss. The signal is boosted to
its original standard amplitude. Gain at high frequencies is boosted to regain
a flat response.
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RF
Radio Frequency. In television applications, RF generally refers to the
television signal after the picture carrier modulation process.

RGB
Red, Green, and Blue. Also referred to as GBR in SMPTE specifications.
The three primary colors used in color television’s additive color reproduc-
tion system. These are the three color signals generated by the camera and
used by the picture monitor to produce a picture.

R-Y
One of the color difference signals obtained by subtracting luminance (Y)
from the red camera signal.

Saturation
The property of color which relates to the amount of white light in the color.
Highly saturated colors are vivid, while less saturated colors have more
white mixed in and, therefore, appear pastel. For example, red is highly
saturated, while pink is the same hue, but less saturated.

In signal terms, saturation is determined by the ratio between luminance
level and chrominance amplitude. A vectorscope does not display saturation;
the length of the vectors represents chrominance amplitude. In order to verify
that the saturation of the colors in a color bar signal is correct, you must
check luminance amplitudes with a waveform monitor in addition to
observing the vectors.

SAV
Acronym for Start of Active Video in component digital systems. One of two
(EAV and SAV) timing reference packets.

SCH
SCH (SubCarrier to Horizontal) Phase refers to the timing relationship
between the 50% point of the leading edge of sync and the zero crossings of
the reference subcarrier. Errors are expressed in degrees.

SNMP
Acronym for Simple Network Management Protocol. A network manage-
ment system that is used for remote instrument control.

Termination
In order to accurately send a signal through a transmission line, there must
be an impedance at the end which matches the impedance of the source and
of the line itself. Without termination, amplitude errors and reflections will
result. Video is a 75 Q system, so a 75  termination must be put at the end
of the signal path.

True Peak
Audio display ballistic.
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U
The B-Y signal after a weighting factor of 0.493 has been applied. The
weighting is necessary to reduce peak modulation in the composite signal.
A\
The R-Y signal after a weighting factor of 0.877 has been applied. The
weighting is necessary to reduce peak modulation in the composite signal.
VITC
Acronym for Vertical Interval Time Code. A method of recording a time
code on a video tape. See also LTC.
\48
Acronym for Volume Unit.
Vectorscope

A specialized oscilloscope which demodulates the video signal and presents
a display of R-Y versus B-Y in NTSC systems (or V versus U in PAL
systems). The angle and magnitude of the displayed vectors are respectively
related to hue and saturation.

Vertical Interval
The synchronizing information that appears between fields and signals the
picture monitor to return to the top of the screen to begin another vertical
scan.

Y
See Luminance.

Glossary-6 WVR610A & WVR611A Waveform Rasterizers User Manual



Index






Index

Numbers

1X button, 2-5
5X button, 2-5

A

A button, 2-7
Accessories, standard, 1-3
Accuracy, Glossary-1
Active Bits, Audio Session display, 3-60
active tile, 2-1, 2-32
selecting, 2-33
Address, Tektronix, xvii
AES A/B, Audio Inputs/Outputs, 2-61
AES and Embedded Alarms
Parity, 3-41
Professional CRC, 3-41
Signal Lock, 3-41
Validity Bit, 3-41
AES connectors, 2-42
alarm reporting options, 3-42
Alarm Status, Status pop-up menu, 2-30
Alarm Status, 3-44
check audio status, 3-58
display, 3-62
Alarms menu, 3-37
Analog A/B, Audio Inputs/Outputs, 2-61
analog audio, connecting, 2-44

Analog Audio Displays, Configuration menu, 2-52

Analog I/O connector, 2-42

Analog Out Map, Audio Inputs/Outputs, 2-63
AP EDH Status, Video Session Status, 3-54
AP Error Seconds, Video Session display, 3-54
arrow keys, 2-7

Arrowhead, Gamut pop-up menu, 2-28
Arrowhead Area, Gamut Thresholds, 2-68

Arrowhead Display, NTSC and PAL graticules, 3-22

Arrowhead display, 3-18

composite gamut, 3-21
Arrowhead NTSC Max, Gamut Thresholds, 2-68
Arrowhead NTSC Min, Gamut Thresholds, 2-68
Arrowhead PAL Max, Gamut Thresholds, 2-68
Arrowhead PAL Min, Gamut Thresholds, 2-68
Attenuate Audio Output, 2-65
AUDIO button, 2-5
audio display, elements of, 2-21
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Audio Input

Audio pop-up menu, 2-24

Audio Session display, 3-59
audio input, selecting, 3-27
Audio Inputs/Outputs, Configuration menu, 2-60
audio level, checking, 3-29
Audio Clip alarm, 3-40
Audio Mute alarm, 3-40
audio options, 1-2
Audio Output, Audio Session display, 3-59
audio phase, checking, 3-30
Audio pop-up menu, 2-24
Audio Session

check audio status, 3-58

Status pop-up menu, 2-30
Audio Session display, 3-58

Active Bits, 3-60

Audio Input, 3-59

Data Collect, 3-59

Audio Output, 3-59

Changed since reset, 3-60

Clip, 3-59

elements of the display, 3-59

High (dB), 3-60

Mute, 3-59

Over, 3-59

Peak (dB), 3-59

reset statistics, 3-60

Runtime, 3-59

Signal Loss, 3-59

Silence, 3-59

Smpl Rate, 3-60

stopping and starting updates, 3-61
audio status, checking, 3-58
Audio Stream Missing, 3-41

B button, 2-7
balancing a camera, 3-10
Ballistics
Analog Audio Displays, 2-53, 2-54
Digital Audio Displays, 2-57, 2-58
Bar Format, Audio Inputs/Outputs, 2-62
Input to Bar Map, Audio Inputs/Outputs, 2-62
Bar Targets, Vector pop-up menu, 2-17
Beep, alarm reporting options, 3-44
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black level, checking, 3-2, 3-8 CURSOR button, 2-7
blanking width, checking, 3-9 CURSOR pop-up menu, 2-40
Buffer Empty, 3-41 cursors

Buffer Full, 3-41 active, 2-39

burst amplitude, checking, 3-8 displaying, 2-38

buttons, 1-5, 3-33, 3-34 inactive, 2-39

removing, 2-38

C

Calibration, Utilities, 2-83, 2-85

D

Center Waveform Data Collect, Audio Session display, 3-59
Other pop-up menu, 2-26 DC Restore
Vector pop-up menu, 2-17 Cmpst Input, 2-51
Waveform pop-up menu, 2-15 Video Session display, 3-57
Certifications and compliances, A-27 Delete Frozen Image, FREEZE pop-up menu, 2-35
Changed since reset, Audio Session display, 3-60 Diag Log Mode, 2-89
Checksum, 3-41 Utilities, 2-83
Chroma Diamond, Gamut pop-up menu, 2-28
SDI Input, 2-50 Diamond Area, Gamut Thresholds, 2-68
Waveform pop-up menu, 2-15 Diamond Display, construction of the diamond
Cleaning, F-1 graticule, 3-19
Clip, Audio Session display, 3-59 Diamond display, 3-18
closed captioning, checking, 3-17 checking RGB Gamut, 3-19
Cmpst Gamut, Video Session display, 3-55 RGB gamut, 3-18
Cmpst Input shading a camera, 3-11
DC Restore, 2-51 Diamond High, Gamut Thresholds, 2-67
Input Format, 2-50 Diamond Low, Gamut Thresholds, 2-68
NTSC Setup, 2-51 Digital Audio Displays, Configuration menu, 2-56
PAL Vector, 2-51 Digital Silence Level, Audio Displays, 2-57
Sync AFC Speed, 2-51 disabling alarms, 3-38
Cmpst Waveform Graticule Units, Graticules, 2-73 display connector. See XGA output connector
Component video, Glossary-1 DISPLAY SELECT buttons, 2-1
Composite gamut Display Settings, Configuration menu, 2-69
checking, 3-23 Duration for Over
Diamond display, 3-21 Analog Audio Displays, 2-53, 2-56
Composite Gamut alarm, 3-39 Digital Audio Displays, 2-57, 2-59
Composite Input Alarms Duration for Silence
Input Missing, 3-39 Analog Audio Displays, 2-53, 2-55
Input Unlocked, 3-40 Digital Audio Displays, 2-57, 2-59

composite input connectors, 2-41
Composite video, Glossary-1
CONFIG button, 2-7 E

Conflgu‘ratlon menu, 2-10 EDH, Video Session display, 3-53
connecting a display, 1-10
Connector, compatibility, 1-13 EDH Alarm, 3-39
Contactin ’ Tekt?onix xi]/’ii EDH Error Fields, Video Session display, 3-54
ne ’ EDH Error Fields %, Video Session display, 3-54

Correlation Meter Speed . o

Analog Audio Displays, 2-54, 2-56 Electrical spemﬁcatpns, A-1

Dicital Audio Displa s’2-58,2-6() Embedded A/B, Audio Inputs/Outputs, 2-61

& Pays, ’ Embedded Audio Specific Alarms

correlation meters, 3-31 . D
P Audio Stream Missing, 3-41
CPU Color Palette, Utilities, 2-84 Buffer Empty, 3-41

CPU Color Palette Check, Utilities, 2-83
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Buffer Full, 3-41
Checksum, 3-41
Parity, 3-41
embedded audio status, 3-61
Enable Alarms, 3-38
Environmental performance, Specifications, A-25
Erase, Diagnostics Log screen, 2-89
ERROR, Alarm Status display, 3-46, 3-63
Error Fields, Video Session display, 3-55, 3-56
% Error Fields, Video Session display, 3-55, 3-56
Error Hold Time
Analog Audio Displays, 2-53, 2-56
Digital Audio Displays, 2-57, 2-59
Error Log
check audio status, 3-58, 3-64
elements of, 3-65
icons, 3-65
Status pop-up menu, 2-30
error log
activating, 3-66
size, 3-66
Error Log display, 3-47
icons, 3-48
Ethernet connector, 2-47
EXT button, 2-7
External Ref, Sync AFC Speed, 2-52
External Ref., Lock to Standard, 2-52
External Reference Missing alarm, 3-40
External Reference Unlocked alarm, 3-40

F

F1 AP CRC, Video Session display, 3-54

F2 AP CRC, Video Session display, 3-54
FACTORY button, 2-6, 3-35

factory defaults, recalling, 3-35

FF EDH Status, Video Session display, 3-53
FF Error Seconds, Video Session display, 3-53
FIELD button, 2-6

field number, 3-4

Field Sweep Line Select Cursor, Graticules, 2-73
Filter, Waveform pop-up menu, 2-14

Flat, Waveform pop-up menu, 2-15

Flat + Luma, Waveform pop-up menu, 2-15
Follows video, Audio pop-up menu, 2-24
Format, Video Session display, 3-57

Freeze, Video Session display, 3-56

Freeze Affects, Display Settings, 2-72
FREEZE button, 2-7, 2-35

Freeze pop-up menu, 2-35

frequency response, checking, 3-24
front-panel controls, 2-4

Frozen Only, Freeze pop-up menu, 2-36
full-screen mode, 2-33

G

gain, frequency response, 3-24
Gain Setting, 2-13
Gamut, Readouts, 2-73
gamut
Arrowhead display, 3-21
checking, 3-18
Diamond display, 3-18
GAMUT button, 2-5
Gamut display
checking RGB gamut, 3-19
composite Arrowhead display, 3-21
Gamut pop-up menu, 2-28
Gamut Thresholds, Configuration menu, 2-66
Gateway Address
Network Settings, 2-77
Utilities, 2-74
General alarms
External Reference Missing, 3-40
External Reference Unlocked, 3-40
Hardware Fault, 3-40
LTC Invalid, 3-40
LTC Missing, 3-40
VITC Invalid, 3-40
VITC Missing, 3-40
General Audio alarms
Audio Clip, 3-40
Audio Mute, 3-40
Over Alarm, 3-40
Silence Alarm, 3-41
GENERAL knob, 2-8
Graticule, Arrowhead NTSC and PAL, 3-22
Graticule Color, Display Settings, 2-70
Graticule Intensity, Display Settings, 2-70
Graticules, Configuration menu, 2-73
Ground Closure, alarm reporting options, 3-44
ground closure connector, 2-46

H

Hardware Fault alarm, 3-40

Hardware installation, 1-5-1-9
Harmonic distortion, Glossary-3

HELP button, 2-7

High (dB), Audio Session display, 3-60
HORIZONTAL knob, 2-8

Horizontal Offset, Timing display, 2-18
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| Line Select mode, 3-3
line up level, 2-55, 2-59
icons Lissajous AGC
Error Log, 3-65 Analog Audio Displays, 2-54, 2-56
Error Log display, 3-48 Digital Audio Displays, 2-58, 2-60
status bar, 2-12 Lissajous display, 3-30
Ignore Validity Bit, Digital Audio Displays, 2-60 Lissajous Snd Stage, Audio pop-up menu, 2-25
Input, Video Session display, 3-57 Lissajous Sound Stage, Phase Style, 3-31
Input Format Live + Frozen Only, Freeze pop-up menu, 2-36
Cmpst Input, 2-50 Live Only, Freeze pop-up menu, 2-36
SDI Input, 2-49 Lock to Standard, External Ref., 2-52
Input Missing alarm, 3-39 Logging, alarm reporting options, 3-44
Input Unlocked alarm, 3-40 Logging Active, 3-67
Installation, 1-5 Logging Reset, 3-67
BNC connector compatibility, 1-13 LTC/ VITC, Configuration menu, 2-72
connecting power, 1-10 LTC Invalid alarm, 3-40
hardware, 1-5 LTC Missing alarm, 3-40
in a serial video system, 1-11 Luma, Waveform pop-up menu, 2-15
line termination, 1-12 luma amplitude, checking, 3-7
rackmount, 1-5 Luma Area, Gamut Thresholds, 2-68
Instrument dimensions, A-25 Luma Gamut, Video Session display, 3-56
Instrument Name, Utilities, 2-74, 2-77 Luma Gamut alarm, 3-39
Instrument options, 1-2 Luma Max, Gamut Thresholds, 2-68
Instrument weight, A-25 Luma Min, Gamut Thresholds, 2-68
IP Address Luminance, Glossary-4

Network Settings, 2-75
Utilities, 2-74

IP Config Mode M
Network Settings, 2-74
Utilitios, 2.74 MAG button, 2-6
’ Maintenance, F-1
matching sources, 3-9
J MEAS button, 2-5, 2-18
Measure pop-up menu, 2-18
Java applet, accessing remote interface, B-3 Relative to:, 2-19
Save Offset, 2-19
Mechanical installation, 1-5
K Meter Scaling
Analog Audio Displays, 2-53, 2-55
knobs, 2-8 Digital Audio Displays, 2-57, 2-59
MIB table, C-1
L MIB Tables, SNMP, C-2, C-9
monitoring a waveform, 3-1
level meter colors, 3-29 Mute, Audio Session display, 3-59
Lightning, Vector pop-up menu, 2-15 Mute Alarms, STATUS pop-up menu, 3-44

Lightning Display, Glossary-3

limits, gamut, 3-18

limits, ensuring, 3-6 N

]ITINE button, 2-6 NTSC, Arrowhead Gamut graticule, 3-22
ine number, 3-4
LINE SEL, 3-15
LINE SEL button, 2-7
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NTSC Setup
SDI Input, 2-50
Video Session display, 3-57

o)

OK, Alarm Status display, 3-46, 3-63
online help, 2-37
displaying, 2-38
navigating, 2-38
Options
audio, 1-2
Option AN, 1-2
Option DA, 1-2
Option DG, 1-2
power cords, 1-3
warranty, 1-2
options, service, 1-2
OTHER button, 2-5
Other pop-up menu, 2-26
Over, Audio Session display, 3-59
Over Alarm, 3-40
Over Level
Analog Audio Displays, 2-53, 2-56
Digital Audio Displays, 2-57, 2-59
Overlay, Waveform pop-up menu, 2-14

P

Pairs, Audio Inputs/Outputs, 2-62
PAL, Arrowhead Gamut graticule, 3-22
PAL Vector, Cmpst Input, 2-51

Panel Backlight, Display Settings, 2-70, 2-71
Panel Backlight Intensity, Display Settings, 2-70, 2-72

Parade, Waveform pop-up menu, 2-14
Parity, 3-41
Part numbers
Service Manual, 1-4
User Manual, 1-3
Paused, Audio Session, 3-51, 3-61
Peak (dB), Audio Session display, 3-59
peak amplitude, checking, 3-7
Peak Hold Segment
Analog Audio Displays, 2-53, 2-54
Digital Audio Displays, 2-57, 2-58
Peak Hold Time
Analog Audio Displays, 2-53, 2-54
Digital Audio Displays, 2-57, 2-58
Peak Program Level
Analog Audio Displays, 2-53, 2-55
Digital Audio Displays, 2-57, 2-59

Phase Display, Audio pop-up menu, 2-24

Phase Pair, Audio pop-up menu, 2-25
Phase Style, Audio pop-up menu, 2-25
Phone number, Tektronix, xvii
Physical specifications, A-25

PICT button, 2-5

Picture, Readouts, 2-73

Picture Brightness, Display Settings, 2-70

Picture Brightup on Cmpst Gamut Error, Display

Settings, 2-70, 2-71

Picture Brightup on Luma Error, Display Settings, 2-70
Picture Brightup on Luma Gamut Error, Display

Settings, 2-71

Picture Brightup on RGB Gamut Error, Display

Settings, 2-70, 2-71
Picture Frame, 2-20
Picture pop-up menu, 2-20

Picture Line Select Cursor, Graticules, 2-73

Picture pop-up menu, 2-20

Picture Refresh Mode, Display Settings, 2-70

pop-up menus, 2-8

Audio, 2-24

Cursors, 2-40

Freeze, 2-35

Gamut, 2-28

MEAS, 2-18

Other, 2-26

Picture, 2-20

Status, 2-29

Vector, 2-16

Waveform, 2-13
Power, AC requirements, 1-10
power connector, 2-41
Power cord options, 1-3
Power, connecting, 1-10
PPM Type 1, Ballistics, 2-54, 2-58
PPM Type 2, Ballistics, 2-54, 2-58
Presets

contents, 3-36

creating, 3-33

recalling, 3-34
presets, creating, 3-33
PRESETS buttons, 2-6
Preventive maintenance, F-1
Product description, 1-1
product description, 1-1

Product support, contact information, xvii

Professional CRC, 3-41

R

Rackmount installation, 1-5

Readout Color, Display Settings, 2-69, 2-70
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Readout Intensity, Display Settings, 2-69, 2-70
Readouts, Configuration menu, 2-72
Rear Panel, Measure pop-up menu, 2-19
recalling
factory defaults, 3-35
Presets, 3-34
green text, Error Log display, 3-48
red text
Alarm Status display, 3-46, 3-63
Error Log display, 3-48
Audio Session display, 3-60
white text, Error Log display, 3-48
regulatory compliance, ensuring, 3-6
Relative to:, Measure pop-up menu, 2-19
REMOTE connector, 2-46
Remote Interface, B-1
Reset Arrowhead NTSC Defaults, Gamut Thesholds,
2-68
Reset Arrowhead PAL Defaults, Gamut Thresholds,
2-68
Reset Diamond Defaults, Gamut Thresholds, 2-68
Reset Luma Defaults, Gamut Thesholds, 2-68
reset statistics
Audio Session display, 3-60
Video Session display, 3-50
Reset to EBU-R103 Defaults, Gamut Thesholds, 2-69
RGB, Waveform pop-up menu, 2-14
RGB Gamut, Video Session display, 3-55
RGB gamut, Diamond display, 3-18
RGB Gamut alarm, 3-39
rise time, measuring, 3-5
Run Advanced Diags, Utilities, 2-83, 2-86
Run Power Up Diags, Utilities, 2-83, 2-85
Runtime
Audio Session display, 3-59
Video Session display, 3-53

S

#Samples for Clip, Digital Audio Displays, 2-57, 2-59
#Samples for Mute, Digital Audio Displays, 2-57, 2-59
Save Offset, Measure pop-up menu, 2-19
Screen Text/Icon, alarm reporting options, 3-43
SDI -> Composite, Waveform pop-up menu, 2-14
SDI linput Missing alarm, 3-39
SDI Input

Chroma, 2-50

Input Format, 2-49

NTSC Setup, 2-50

Strip EAV/SAV/ANC, 2-49
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SDI Input Alarms
Composite Gamut, 3-39
Luma Gamut, 3-39
SDI Input alarms
EDH Alarm, 3-39
RGB Gamut, 3-39
SDI linput Missing, 3-39
SDI Input Unlocked, 3-39
SDI input connectors, 2-41
SDI Input Unlocked alarm, 3-39
SDI Vector I/Q Axis, Graticules, 2-73
SEL button, 2-7
select a line, 3-3
selecting a measurement, 2-34
selecting audio input, 3-27
Service support, contact information, xvii
Sessions Reset, Audio Session, 3-51, 3-60
Sessions Start, Audio Session, 3-51, 3-61
Sessions Stop, Audio Sessions, 3-51, 3-61
Set 0dB Mark To:
Analog Audio Displays, 2-53, 2-54
Digital Audio Displays, 2-57, 2-58
Set all alarms to this mask, 3-42
Set Clock, Utilities, 2-83
Set Meter Type to:, Analog Audio Displays, 2-53, 2-55
shading a camera, 3-10
Signal Lock, 3-41
Video Session display, 3-57
Signal Loss, Audio Session display, 3-59
Silence, Audio Session display, 3-59
Silence Alarm, 3-41
Silence Level
Analog Audio Displays, 2-53, 2-55
Digital Audio Displays, 2-59
Smpl Rate, Audio Session display, 3-60
SNMP, C-1
SNMP Enable, Network Settings, 2-78
SNMP Private Community, Network Settings, 2-80
SNMP Public Community, Network Settings, 2-79
SNMP Trap, alarm reporting options, 3-44
SNMP Trap Address, Network Settings, 2-81
SNMP Trap Enable, Network Settings, 2-81
sources, matching, 3-9
Specifications
electrical , A-1
physical, A-25
Split Diamond, Gamut pop-up menu, 2-28
Split Diamond display, 3-18
Standard (NTSC/PAL), Glossary-4
Standard accessories, 1-3
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start error logging, 3-67

starting and stopping updates, Audio Session display,

3-61

status bar

elements of, 2-10

icons, 2-12
STATUS button, 2-5
Status pop-up menu, 2-29
stopping and starting, Video Session display, 3-51
Strip EAV/SAV/ANC, SDI Input, 2-49
Subnet Mask

Network Settings, 2-76

Utilities, 2-74
Surround, Audio Inputs/Outputs, 2-62
Sync AFC Speed

Cmpst Input, 2-51

External Ref, 2-52

Video Session display, 3-57
sync amplitude, checking, 3-7
sync to luma amplitude ratio, checking, 3-8
sync width, checking, 3-8
System Upgrade, Utilities, 2-83, 2-85, D-1

T

Technical support, contact information, xvii
Tektronix, contacting, xvii
Termination, line discussion, 1-12
Test Level
Analog Audio Displays, 2-53, 2-55
Digital Audio Displays, 2-57, 2-59
Time, Cursor pop-up menu, 2-40
timing a studio, 3-11
Timing display, 2-18, 3-12
True Peak, Ballistics, 2-54, 2-58

U

URL, Tektronix, xvii
User service, F-1
Utilities, Configuration menu, 2-82

'

Validity Bit, 3-41

VAR button, 2-5

VECT button, 2-5

Vector
Readouts, 2-72, 2-73
Vector pop-up menu, 2-15
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Vector pop-up menu, 2-16

Bar Targets, 2-17

Center Waveform, 2-17
VERTICAL knob, 2-8
Vertical Offset, Timing display, 2-18
VGA Output, Display Settings, 2-70, 2-71
video input connectors, 2-41
Video Session, Status pop-up menu, 2-30
Video Session display, 3-49

reset statistics, 3-50

stopping and starting, 3-51

SDI Inputs, 3-52
Video to Audio Mapping, 2-64

Audio Inputs/Outputs, 2-61, 2-63
View Diagnostic Log, Utilities, 2-83
View HW/SW Version, Utilities, 2-83
View MAC Address

Network Settings, 2-77

Utilities, 2-74
View the Diagnostic Log, Utilities, 2-87
VITC Invalid alarm, 3-40
VITC Missing alarm, 3-40
VITS, checking, 3-16
Voltage, Cursor pop-up menu, 2-40
Voltage + Time, Cursor pop-up menu, 2-40
VU, Ballistics, 2-54, 2-58

w

Warranty options, 1-2
Waveform, Readouts, 2-72, 2-73
Waveform Color, Display Settings, 2-69, 2-70
Waveform Intensity, Display Settings, 2-69, 2-70
Waveform pop-up menu, 2-13
Center Waveform, 2-15
Filter, 2-14
Chroma, 2-15
Flat, 2-15
Flat + Luma, 2-15
Low Pass, 2-15
Luma, 2-15
Overlay, 2-14
Parade, 2-14
RGB, 2-14
SDI -> Composite, 2-14
YPbPr, 2-14
YRGB, 2-14
web browser, accessing remote interface, B-1
Web Enable, Network Settings, 2-82
Web site address, Tektronix, xvii
WFM button, 2-5
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X Y

X-Y yellow text
Audio pop-up menu, 2-25 Alarm Status display, 3-46, 3-63
Phase Style, 3-31 Audio Session display, 3-60

XGA output connector, 2-45 YPbPr, Waveform pop-up menu, 2-14

YRGB, Waveform pop-up menu, 2-14
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